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注释： 在运行系统之前，请仔细阅读本指南的所有部分。

本部分包含与安全相关的一般信息，并介绍了法规遵从性信息。此外，还描述了系统的潜在危
险和相关警告，以及为尽量减少危害而应当采取的预防措施。

除此部分外，请参阅符号词汇表，了解与实验室环境、系统和此文档中所用符号和惯例相关的
信息。请参阅《场地规划指南》了解场地要求，包括交流电源、离子源排气、通风、压缩空气、
氮气和低真空泵要求。

一般安全信息

为避免人身伤害或系统损坏，请阅读、了解并遵守本文件、制造商化学品安全数据表 (SDS) 以
及产品标签信息中的所有安全预防措施和警告。这些标签使用国际公认的符号表示。如果未能
注意这些警告可能会导致严重的伤害。

此安全信息的目的是补充联邦、州、省和当地的环境健康和安全 (EHS) 法规。所提供的信息包
括适用于系统操作的系统相关安全信息。它不包括应实行的各项安全程序。因此，用户和组织
有责任遵守联邦、州、省和当地的环境健康和安全法规，维护安全的实验室环境。

请参阅相应的实验室参考材料和标准操作程序。

法规遵从性

本系统符合本节所列法规和标准。请参阅包含在系统和单个系统组件中的《符合性声明》了解
最新的参考文件。已将适用标签粘贴到该系统上。

加拿大

• 电磁干扰 (EMI)：CAN/CSA CISPR11。本 ISM 设备符合加拿大 ICES-001。请参阅电磁干扰。

• 安全性：

• CAN/CSA C22.2 No.61010-1

• CAN/CSA C22.2 No 61010-2-061

• CAN/CSA C22.2 No.61010-2-101

欧洲

• 体外诊断设备 (IVD)：体外诊断指令 98/79/EC
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• 电磁兼容性 (EMC)：如在以下这些标准中执行的电磁兼容性 (EMC) 指令 2014/30/EU：

• EN 61326-1

• EN 61326-2-6

• EN 55011（A 类）

请参阅电磁兼容性。

• 安全性：低电压指令 2014/35/EU，在这些标准中实行：

• EN 61010-1

• EN 61010-2-061

• EN 61010-2-101

• 废旧电子电气设备 (WEEE)：如在 EN 40519 中实施的废旧电子电气设备 2012/96/EEC请参
阅废弃电子电气设备。

• 包装与包装废弃物 (PPW)：包装与包装废弃物指令 94/62/EC

• 关于限制在电子电器设备中使用某些有害成分的指令 (RoHS)： RoHS 指令 2011/65/EU

美国

• 无线电发射干扰条例：47 CFR 15，在 FCC Part 15 (A 类) 标准中实行

• 安全性：职业安全和健康条例－29 CFR 1910，在这些标准中实行：

• UL 61010-1

• IEC 61010-2-061

• IEC 61010-2-101

国际

• 电磁兼容性 (EMC)：

• IEC 61326-1

• IEC CISPR 11（A 类）

• IEC 61000-3-2

• IEC 61000-3-3

请参阅电磁兼容性。

• 安全性：

• IEC 61010-1

• IEC 61010-2-061

• IEC 61010-2-101
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电气注意事项

警告！ 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故
障。进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，
请与 SCIEX 现场服务工程师 (FSE) 联系。

• 遵循所要求的电气安全工作实践。

• 按照电缆管理实践控制电气电缆。这将会降低绊倒危险发生的可能性。

有关系统电气规格的信息，请参阅性能特征与规格或《场地规划指南》。

交流电源

按照本指南的说明将系统连接到兼容的交流电源。

警告！ 触电危险。所有电气线路和固定装置只能由专业人员负责安装，并确保
所有安装均遵循当地法规和安全标准。

警告！ 触电危险。确保在紧急情况下可将系统与电源插座断开。不要挡住电源
插座。

警告！ 触电危险。仅使用随系统提供的电源电缆。请勿使用未为本系统运行而
进行适当评级的电源电缆。

质谱仪、可选工作台或低真空泵无需外部变压器。

保护接地导体

电源必须包括正确安装的保护接地导体。在连接本系统前，必须由合格的电气技师安装或检查
保护接地导体。

警告！ 触电危险。不要故意断开接地保护导体。任一保护接地导体断开都将造
成触电危险。

警告！ 触电危险。确保在样本环和离子源上的适当接地点之间连接保护接地
（接地电缆）。该补充接地将强化 SCIEX 规定的安全配置。

液相色谱串联质谱检测系统系统用户指南
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化学品注意事项

警告！ 电离辐射危害、生物危害或有毒化学品危害。在清洁或维护质谱仪之
前，确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，
在清洁或维护之前客户必须先消除系统污染。

警告！ 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵循
当地法规。

警告！ 生物危害、有毒化学品危险。将排液管恰当地连接到质谱液和离子源排
气瓶，防止泄漏发生。

• 在维修和定期维护前，确定系统中已经使用了哪些化学品。有关使用化学品时必须遵循的健
康和安全预防措施，请参阅《安全数据表》。SCIEX《安全数据表》可在 sciex.com/
tech-regulatory 上找到。

• 一定要穿戴指定的个人防护设备，包括无粉氯丁橡胶或丁腈手套、防护眼镜和实验室外套。

• 当工作中用到易燃材料，如异丙醇、甲醇和其他易燃溶剂时，请避免火源。

• 要小心地使用和处置任何化学品。如果不遵循处理和处置化学品的适当程序，就会存在人身
伤害的潜在风险。

• 清洗过程中应避免皮肤接触化学品，使用后洗手。

• 请确保所有排气软管均正确连接，且所有连接和功能均按设计进行。

• 收集所有废液并将其按有害废弃物处置。

• 请遵守关于生物危害性、有毒或放射性物质的存储、处理和处置的所有当地法规。

• （建议）使用低真空泵下面的二次防护托盘、溶剂瓶和废弃物收集容器收集可能的化学溢出
物。

系统安全液体

可以在系统中安全使用以下液体。请参阅必需材料 获取关于安全清洗液的信息。

小心： 可能导致系统损坏。在收到 SCIEX 确认液体不会造成危害的通知之前，不得使用任
何其他液体。这不是一份详尽的清单。
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• 有机溶剂

• MS 级乙腈；高达 100%

• MS 级甲醇；高达 100%

• 异丙醇；高达 100%

• HPLC 级或更高等级水；高达 100%

• 缓冲液

• 乙酸铵；低于 1%

• 甲酸铵；低于 1%

• 酸和碱

• 甲酸；低于 1%

• 乙酸；低于 1%

• 三氟乙酸 (TFA)；低于 1%

• 七氟丁酸 (HFBA)；低于 1%

• 氨/氢氧化铵；低于 1%

通风注意事项

烟气排放和废物处置必须遵守所有联邦、州、省和当地的健康和安全法规。客户应确保按照当
地健康和安全法规的要求保持空气质量。

质谱仪离子源废气排放系统和低真空泵必须连接到专门的实验室通风橱或外部排气系统。

警告！ 火灾危险。确保离子源排气系统已连接和正在运行，以防止易燃蒸汽在离子源
中积聚。

警告！ 电离辐射危害、生物危害或有毒化学品危害。请小心将废气排至专门的
实验室通风橱或排气系统，并确保通风管道已用夹子固定牢靠。确保实验室具
有适合所执行工作的适当换气措施。

警告！ 电离辐射危害、生物危害或有毒化学品危害。如果离子源排气和低真
空泵排气软管未正确连接到实验室通风系统，请勿运行质谱仪。对排气管道进
行定期检查，以确保没有泄漏。在系统通风不足的情况下使用质谱仪可能会危
害健康，或导致严重人身伤害。

液相色谱串联质谱检测系统系统用户指南
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警告！ 电离辐射危害、生物危害或有毒化学品危害。只有在充分了解与离子源
一起使用的有毒或有害材料的妥善利用、防护和疏散方面的知识，并接受了相
关培训后，才能使用离子源。

警告！ 刺伤危险、电离辐射危害、生物危害或有毒化学品危害。如果离子源窗
口有裂痕或破损，请停止使用离子源，并与 SCIEX 现场服务工程师联系。设备
中引入的任何有毒或有害材料均会存在于离子源排气输出中。请按照既定实验
室安全程序处置锐器。

物理注意事项

警告！ 高温表面危害。在开始任何维护程序前，先让离子源和真空接口冷却至
少 30 分钟。离子源和真空接口的某些表面在工作过程中会发烫。

警告！ 升降危险。使用机械升降装置来抬升和移动质谱仪。如果质谱仪必须手动移
动，则使其安全移动需要至少六人。请遵照既定安全升降操作规程。关于系统组件的
重量，请参阅《场地规划指南》。

环境注意事项

安排合格的人员安装主电源、加热、通风和上下水管线及固定装置。确保所有的安装均符合当
地规章和生物危害法规。有关该系统所需环境条件的信息，请参阅《场地规划指南》。

设置系统时可以在设备周围预留接入空间。

危险！ 爆炸危险。请勿在含有爆炸性气体的环境中运行该系统。该系统不适合在易爆
环境中运行。

警告！ 生物危害。使用生物危害性物质，一定要遵守危害评估、管控和处理方面的地
方法规。本系统或其任何部分不得作为生物屏障使用。

警告！ 环境危害。遵照既定程序处置生物危害性、有毒、放射性和电子废弃
物。客户负责按照当地法律和法规处置有害物质，包括化学品、废油和电气部
件。
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小心： 潜在的质量位移。保持稳定的环境温度。如果温度变化超过 2 °C/小时，分辨率和
质量校正可能会受到影响。

小心： 潜在的系统污染。使用气体发生器时，请参阅气体发生器随附的文档，获取由制造商
提供的有关如何使用配备压缩机的气体发生器的信息。例如，如果环境中存在烃类，那么使
用配备压缩机的气体发生器就可能致使烃类进入质谱仪。

电磁环境

电磁兼容性

基本电磁环境：具有直接从公共电网低压供电特征的地点所存在的环境。

性能标准 A（标准 A）：设备按预期运行，在测试期间或之后性能未退化，功能未损失。

性能标准 B（标准 B）：测试期间，设备可能发生（一项或多项）功能损失，但在测试后按预
期运行，性能出现部分退化，功能自动恢复。

性能标准 C（标准 C）：测试期间，设备可能发生（一项或多项）功能损失，但在测试后按预
期行动，性能出现部分退化，功能可由操作员恢复。

本设备拟用于基本电磁环境。

在电磁抗扰情形下的预期性能损失总离子计数 (TIC) 变化小于 20%。

小心： 潜在的错误结果。不得在靠近强电磁辐射源（例如非屏蔽故意射频源）处使用此设
备，因为电磁辐射可能会干扰正常运行，并导致错误的结果。

确保可为设备维持可兼容的电磁环境，使该设备按预期运行。如果电源线具有较高电气噪声，
则安装电涌保护器。

电磁干扰

A 类设备：适用于除住宅及直接与为住宅供电所用低压电源网络相连的所有设施的设备。[摘自
CISPR 11:2009, 5.3] A 类设备应遵守 A 类限制。

根据 FCC（美国联邦通信委员会）合规规则第 15 部分的规定，本设备已经进行了测试，证明
符合 A 类数字设备的限制。

这些限制旨在提供合理的保护，防止本设备在商业环境中运行时受到有害干扰。本设备会产生、
使用并可能辐射无线频率能量，如果未按照操作手册要求安装和使用，可能会对无线通信造成
有害干扰。

在住宅区使用本设备可能会造成有害干扰，在这种情况下，消除此类干扰的费用需自行承担。
未得到制造商明确批准的变更或修改可能会使您操作本设备的权限失效。
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拆除和处置

警告！ 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵循
当地法规。

拆除前，请按当地法规对整套系统进行去污处理。

弃用系统后，根据国家和当地环境法规条例分离和回收不同材料。请参阅质谱仪存储和处理。

注释： SCIEX 不会接受未完成《净化表》的任何系统回收。请联系现场服务工程师获得一份
净化表。

不要将系统组件或部件（包括计算机部件）作为未分类的城市废弃物进行处理。

废弃电子电气设备

遵循当地城市废物法规条例中的合适处理规定，减少废弃电子电气设备 (WEEE) 对环境的影响。
为了安全地处理设备，请联系当地的客户服务部进行免费的仪器上门回收。

实验室条件

工作条件

系统设计为可在以下条件下安全工作：

• 室内

• 海拔高度：最高 2 000 m（6 560 英尺）

• 环境温度：5 °C (41 °F) 到 40 °C (104 °F)

• 相对湿度：温度不超过 31 °C (88 °F) 时为 80%，40 °C (104 °F) 时线性下降到 50%

• 电源电压波动：标称电压的 ± 10%

• 瞬态过电压：最高可达到过电压类别 II 的级别

• 电源暂时过电压

• 污染度：污染度 2

性能规范

系统设计为在以下条件下符合规范：

• 环境温度为 15 °C 至 30 °C（59 °F 至 86 °F）。
温度随时间的变化必须保持在 4 °C (7.2 °F) 范围内，温度的变化率为每小时不超过
2 °C (3.6 °F)。若环境温度波动超出限制，可能会造成谱图质量偏移。

• 相对湿度为 20% 至 80%，无凝结
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预期用途

4500MD 系列系统是液相色谱 - 串联质谱 (LC-MS/MS) 系统，旨在通过电离所研究的化合物并
利用电场基于质量对所得离子进行分离，以此鉴定人体标本中的无机或有机化合物。供体外诊
断使用。

使用限制

4500MD 系列仪器仅供合格实验室人员在临床实验室环境中专业性使用。

描述

4500MD系统包括以下组件：

• SCIEX Triple QuadTM4500MD质谱仪或 QTRAP®4500MD质谱仪（配备的 Turbo VTM 离子源使用
TurboIonSpray®探针或大气压化学电离 (APCI) 探针、低真空泵以及压缩空气和氮气源）。

• SCIEX 提供的计算机和显示器，带有 Analyst® MD软件，用于进行仪器优化、采集方法开发
和数据采集，还带有 MultiQuantTM MD 软件，用于进行处理。

合格人员

只有合格的 SCIEX 员工才能安装、检查和维修本设备。安装完系统后，现场服务工程师 (FSE)
会使用 Customer Familiarization Checklist（客户熟悉系统检查清单）指导客户熟悉系统操
作、清洁和基本维护。

只能由制造商认定的合格人员维护设备。可在安装过程中使实验室指定人员熟悉合格维护人员
(QMP) 程序。QMP 是对维护实验室设备相关的电气和化学风险有相应认识的人员。

质量控制指导准则

预计使用 4500MD系列系统的临床实验室会使用涵盖但不限于操作者培训、分析开发和验证以及
实验室分析性能的外部审核等问题的程序。

液相色谱串联质谱检测系统系统用户指南
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实验室流程

在这些方法投入报告结果 2 的临床使用之前，对其进行验证。此外，为分析方法建立标准操作
程序 (SOP)，以确保分析前、分析和分析后过程不会违背它们的预期用途3。例如，对于以下各
项，最低限度的 SOP 必须到位：3,4

• 样本采集方法

• 样本制备方法

• 液相色谱设置和初始条件

• 质谱仪设置和校正初始条件

• 液相色谱和质谱维护

• 质谱仪采集方法

• 样本批次清单制备方法

• 数据分析方法

• 数据审核

• 在分析数据之后发布方案

我们建议用户手动审核所有的积分结果，以确保原始数据的质量，以及由软件执行的峰值积分
的正确性。Analyst® MD 软件来处理数据。色谱峰的审查必须由经过培训的专业人员进行。如
果 Analyst® MD 软件未对色谱峰进行正确积分（可能是由于存在密集的洗脱峰、裂峰、噪声数
据或高背景信号），则应根据实验室制定的分析方法的标准操作程序 (SOP) 校正峰值积分。

质量控制样本

质量控制 (QC) 样本提供分析方法效果反馈，同时可评估在运行内分析的未知样本的完整性和
有效性2。应每日监测质量控制样本数据。在将质量控制样本纳入分析运行时，应遵循适当的指
导。

质量控制样本可凭借相关文件从商业来源获得，或者从具有良好表征的患者样本池中获得2。我
们建议患者样本的每一分析运行包含至少两个质量控制样本1,2。使用数据审核过程来确认质量
控制样本在分析方法的预定义范围内。质量控制样本超出了预定义范围时，此分析运行中采集
到的数据可能是无效的2。请参阅实验室 SOP。

内标

内标是指结构类似的分析物或同位素标记的稳定分析物，将它们以已知且恒定的浓度添加到所
有样本类型（即标准物、空白样本、质量控制样本和未知样本）中以便进行定量3。通过分析运
行可监测内标信号强度，以确认分析方法的完整性和单份样本的有效性。

标准操作程序应包括内标分析物和质量控制样本的评估标准。超出标准的样本可能表示方法、
系统或样本的性能存在问题2,5。对于涉及关键决策的测量，请使用内标（同位素标记的分析
物）。提早发现这些问题可便于实验室人员进行调查、纠正，并可重复分析（如有必要）2,5。
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设备使用和修改

警告！ 人身伤害危险。如果产品需要安装、调试或重新安置，请联系 SCIEX 代表。

警告！ 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故
障。进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，
请与 SCIEX 现场服务工程师 (FSE) 联系。

警告！ 人身伤害危险。只能使用 SCIEX 推荐的部件。使用非 SCIEX 推荐使用的部件
或者将部件用于任何非设计用途，可能会对用户造成伤害，或对系统性能带来不利影
响。

警告！ 升降危险。确保至少有四个人或一台升降装置可以抬升 LC 系统。请遵照既定
安全升降操作规程。关于系统组件的重量，请参阅《场地规划指南》。

警告！ 压碎危险。移动重物时请穿戴防护鞋。

请在符合《场地规划指南》建议环境条件的实验室室内使用质谱仪和离子源。

如果质谱仪和离子源的使用环境或使用方式不符合制造商规定，那么设备提供的保护可能会受
到影响。

对质谱仪和离子源进行未经授权的修改或操作可能会导致人身伤害和设备损坏，且可能会导致
保修失效。在高于或低于建议环境条件下或在未经授权的修改后运行质谱仪和离子源，可能会
生成错误数据。有关系统的维修信息，请联系现场服务工程师。

质量保证条款见 sciex.com/warranty 页面。4500MD 系列仪器的预计使用寿命为出厂日期后
7 年。如果严格按期保养，该使用寿命可以更长。
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联系我们

SCIEX 支持

• sciex.com/about-us/contact-us

• sciex.com/request-support

客户培训

• 北美地区： NA.CustomerTraining@sciex.com

• 欧洲： Europe.CustomerTraining@sciex.com

• 欧盟与北美之外地区请访问 sciex.com/education 获取联系信息。

在线学习中心

• SCIEXUniversity

网络安全

有关 SCIEX 产品网络安全的最新指南，请访问 sciex.com/productsecurity。

技术支持

SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题或
可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com/diagnostics。

相关文档

要查找软件产品文档，请参阅软件随附的发行说明或软件安装指南。硬件产品的文档可在系统
或组件随附的客户参考 DVD 中找到。

文档标志和惯例

本指南采用了以下标志和惯例。

危险！ 危险表示会导致重伤或死亡的行为。

系统用户指南液相色谱串联质谱检测系统
IVD-IDV-05-6996-ZH-B20 / 267

用途和功能

https://sciex.com/about-us/contact-us
https://sciex.com/support/request-support
mailto:NA.CustomerTraining@sciex.com
mailto:Europe.CustomerTraining@sciex.com
https://sciex.com/education
https://training.sciex.com
https://sciex.com/Documents/brochures/win7-SecurityGuidance.pdf
https://sciex.com/diagnostics


警告！ 警告表示如不遵守注意事项可能会导致人身伤害的行为。

小心： 表示如不遵守注意事项可能会导致系统受损或数据破坏或丢失的操作。

注释： 注释一词突出强调了程序或说明中的重要信息。

提示！ 提示在文中针对特定需求提供有助于应用技术和程序的有用信息，以及提供捷径，但
对于程序的完成而言并非必不可少。

液相色谱串联质谱检测系统系统用户指南
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由 SCIEX 现场服务工程师 (FSE) 安装和配置系统。

本部分包含连接和配置系统硬件及软件的程序。如果必须移动、重新调整或重新配置系统，请
参阅这些程序。

警告！ 触电危险。确保在紧急情况下可将系统与电源插座断开。不要挡住电源
插座。

有关安装 Analyst® MD 软件的信息，请参阅《软件安装指南》。

调整集成注射泵位置

警告！ 刺伤危险。注射器要轻拿轻放。注射器的尖端特别锋利。

警告！ 刺伤危险。确保注射器在注射泵内正确就位，并适当调节注射泵的自动
停止设置，以免损坏或打破玻璃注射器。如果注射器破裂，遵循既定安全程序
处置锐器。

1. 按下注射泵右侧的 Release 按钮以降低基部，然后插入注射器。请参阅图 3-1。
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图 3-1 降低注射器

描述项目

注射器柱塞1

Release 按钮。按下此按钮可升高或降低基部。2

2. 请确保注射器末端与基部平齐，并且注射器的轴安置在保险装置处。

3. 调整标杆，以便其在注射器柱塞撞击玻璃注射器底部之前触发注射器自动停止。请参阅图
3-2。

液相色谱串联质谱检测系统系统用户指南
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图 3-2 注射器自动停止

描述项目

注射器自动停止。在标杆触发注射器自动停止之后，注射泵停止。1

标杆。调整高度，以防止在样本输注过程中注射器柱塞撞击注射器。2

标杆锁紧螺钉。调整标杆高度之后，拧紧螺钉。3

4. 转动 图 3-3 中所示侧面螺钉来固定注射器。
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图 3-3 注射泵螺钉

5. 确保质谱仪和集成注射泵已在软件中激活。

注释： 在质谱仪上，按下注射泵右侧的按钮开始流动，以供随后手动使用。请参阅图
3-4。当注射泵在使用中时，按钮旁边的 LED 灯会闪烁。也可以通过 Analyst® MD 软件自
动控制注射泵流量。

图 3-4 注射泵 LED 灯

液相色谱串联质谱检测系统系统用户指南
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描述项目

注射泵的开启和关闭按钮1

注射泵状态 LED 灯2

6. 在 Analyst® MD 软件的导航栏上，双击 Manual Tuning。

7. 单击 Start Syringe。

8. 若要停止注射泵，请单击 Stop Syringe。

接通分流阀

集成分流阀位于离子源旁边，可以接入进样模式或分流模式。要配置该阀，进入 Configuration
选项卡，然后确保 Use integrated injector/diverter valve 复选框已选中。请参阅添加设
备至硬件配置文件。

小心： 潜在的错误结果。在运行中请勿按下分流阀按钮。否则，可能会导致错误数据。

将分流阀垂直调节至进样模式

当阀门置于 A 位时，样本会流经外部回路。当阀门转换到 B 位时，样本被注入。

• 垂直调节阀门以转为进样模式。

图 3-5 分流阀 - 进样模式 A 位
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图 3-6 分流阀 - 进样模式 B 位

描述项目

样本进入1

废弃物排出2

样本回路（端口 3 和 6）3

流动相进入4

至色谱柱（或者至质谱仪 [若未安装色谱柱]）5

将分流阀垂直调节至分流模式

当分流阀位于 A 位时，液流进入废弃物容器。当阀门转换到 B 位时，液流进入质谱仪。

• 垂直调节阀以转为分流模式。

液相色谱串联质谱检测系统系统用户指南
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图 3-7 分流阀－分流模式 A 位

图 3-8 分流阀－分流模式 B 位
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描述项目

至质谱仪1

从色谱柱2

废弃物排出3

离子源安装

警告！ 触电危险。最后一步是将离子源安装在质谱仪上。安装离子源时会出
现高电压情况。

离子源与真空接口连接，并有两个离子源插锁固定。离子源的内部可通过离子源侧面和正面的
窗口观察。

离子源安装完毕后，软件会识别离子源，并显示离子源标识。

小心： 可能导致系统损坏。不要单手抬起或携带离子源。离子源设计为使用离子源两侧的模
塑把手抬起或携带。

所需材料

• 离子源

• TurboIonSpray®探针或 APCI 探针

• 红色 PEEK 管线（0.005 英寸孔深）

安装准备工作

警告！ 刺伤危险。喷针要轻拿轻放。喷针的尖端特别锋利。

提示！ 请勿随意丢弃空包装物。在不使用空包装物时，可用它来保存离子源。

• 调整探针上的喷针调节螺母，将喷针尖端移至喷针管内。

为了达到理想的稳定性和性能，喷针尖端应伸出探针端部 0.5 mm 至 1.0 mm。请参阅 优化
TurboIonSpray®探针位置或优化 APCI 探针位置。
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安装探针

必要程序

• 取下离子源

警告！ 触电危险。进行下一步操作前，离子源与质谱仪一定要完全断开。

警告！ 刺伤危险。喷针要轻拿轻放。喷针的尖端特别锋利。

小心： 可能导致系统损坏。不要让凸出的喷针尖端或电晕放电针触碰离子源外壳的任何部
分，以免损坏探针。

小心： 可能导致系统损坏。如果正在使用 TurboIonSpray® 探针，确保电晕放电针尖背离小
孔方向。

离子源中未预先安装探针。交换探针前，务必先从质谱仪上拆除离子源。

注释： 如果在离子源中未正确安装探针，质谱仪和离子源废气排放系统的高压电源会关闭。
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图 3-9 离子源组件

描述项目

样本导管1

喷针调节螺母2

固定环3

探针塔座4

电晕放电针调螺钉5

用来在水平轴线上对探针进行定位的千分尺，以调节离子源的灵敏度6

窗口7

离子源的两个插锁中有一个是用来将离子源固定在质谱仪上的。8

接地接头。位于离子源盖板下方。9

用来在垂直轴线上对探针进行定位的千分尺，以调节离子源的灵敏度10

1. 请确保电晕放电针尖指向远离气帘板小孔的方向。请参阅调整电晕放电针的位置。
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2. 将探针插入尖塔状罩壳。将探针上的孔洞与离子源顶部电晕放电针的调节螺钉对齐。请参阅
离子源组件。

3. 向下轻推探针，直至其接触到塔座并卡紧。

4. 将固定环圈在探针上，接着向下按压固定环，使固定环的螺纹与塔座上的螺纹互相啮合，然
后用手指拧紧固定环。

5. 只使用 APCI 探针时，应确保电晕放电针尖指向气帘板小孔。请参阅调整电晕放电针的位
置。

连接离子源导管

警告！ 触电危险。不要绕过接地接头。接地接头可为质谱仪与进样装置之间
提供接地保护。

警告！ 电离辐射危害、生物危害或有毒化学品危害。在操作本设备之前，应
确保样本管路上的螺母已妥善拧紧。

请参阅 离子源组件。

1. 将 30 cm 长的红色 PEEK 导管插入样本导管固定螺母中。

2. 将样本导管螺母装入探针上方的端口中，然后将样本导管拧紧，直至用手无法拧动。

3. 将导管的另一端接至离子源上的接地接头。
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将离子源安装到质谱仪上

前提条件

• 确保所有 O 形密封圈都在真空接口上。

图 3-10 真空接口上的 O 形密封圈

描述项目

气帘板1

O 形密封圈2

警告！ 触电危险。在离子源中安装探针，然后将离子源安装在质谱仪上。

警告！ 压碎危险。当安装离子源时，注意不要把手指夹在离子源与真空接口之间。

小心： 可能导致系统损坏。不要让凸出的喷针尖端或电晕放电针触碰离子源外壳的任何部
分，以免损坏探针。

注释： 如果在离子源中未正确安装探针，质谱仪和离子源废气排放系统的高压电源会关闭。

1. 确保离子源任何一侧的离子源插锁在 12 点钟位置朝上。请参阅 离子源组件。
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2. 将离子源对准真空接口，离子源上的导向销一定要与真空接口的插座对位。

3. 将离子源轻轻推向真空接口，然后向下旋转离子源插锁将离子源锁定到位。

质谱仪识别出离子源，然后在 Analyst® MD 软件中显示离子源标识。

4. 将红色 PEEK 导管从样本供应装置接至离子源上的接地接头的另一侧。
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4500MD 系列仪器旨在确定人体样本中的无机或有机化合物。

该系统主要用于分析生物样本中的小分子。在提取溶液中的分析物之前，制备样本中可能含有
各类提取物和过滤物，具体取决于分析物的特性或初始样本的复杂性。样本是采用液相色谱分
离的。分离后的部分而后被引入到质谱仪中，并根据化合物的分子量进行进一步分离。

关于计算机和软件的信息，请参阅 Analyst® MD 软件的《软件安装指南》。

警告！ 升降危险。不要移动系统。有人身伤害或系统损坏风险。如果必须移动
系统，请联系现场人员。

系统概述

警告！ 升降危险。使用机械升降装置来抬升和移动质谱仪。如果质谱仪必须手动移
动，则使其安全移动需要至少六人。请遵照既定安全升降操作规程。关于系统组件的
重量，请参阅《场地规划指南》。

4500MD 系列仪器包含以下组件：

• SCIEX Triple QuadTM 4500MD 或 QTRAP® 4500MD 质谱仪（配有低真空泵以及一个压缩空气
和氮气源）

• Turbo VTM 离子源，使用 TurboIonSpray® 探针或大气压化学电离 (APCI) 探针。

• SCIEX 提供的带有 Analyst® MD软件的计算机和显示器用于进行仪器优化，采集方法的开
发、处理以及数据采集。具体的计算机规格和要求，请参阅《Analyst® MD 软件安装指南》。
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质谱仪概述

图 4-1 正面图

请参阅...主要材料描述项目

面板符号。塑料面板符号1

调整集成注射泵位置钢（泵体）表面的油漆、
不锈钢（横杆）、黄铜、
Cu、Sn、Pb（轴承）

注射泵2

离子源概述不适用离子源3

接通分流阀。不锈钢分流阀4

面板符号

表 4-1 描述了质谱仪状态 LED 灯。

表 4-1 面板符号

描述名称颜色LED

当系统通电启动时 LED 灯亮。电源绿色

达到正确的 LED 灯亮。真空度不正确时
LED 灯闪烁（抽气和排气过程中）。

真空绿色

当系统处于就绪状态时，LED 灯亮。系统
必须处于就绪状态才能运行。

准备就绪绿色
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表 4-1 面板符号 （续）

描述名称颜色LED

当系统采集数据时，LED 灯闪烁。扫描蓝色

当系统遭遇系统错误时，LED 灯亮。故障红色

在系统开启后，所有 LED 灯均亮起。电源 LED 灯保持亮起状态。其他 LED 灯闪烁两秒钟，然
后关闭。真空 LED 灯开始闪烁。在达到正确的真空度后，该 LED 灯保持常亮。

连接点

图 4-2显示了质谱仪各连接点的位置，包括 RESET 和 VENT 按钮和质谱仪便捷开关。

警告！ 人身伤害危险：使用高压气体罐时请谨慎操作。否则可能会导致人身伤害。

图 4-2 背面和侧面图
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欲了解更多信息……主要材料描述项目

请联系现场服务工程师。
用户不得对此连接点进行
维修。

铝（软管管件），镀锌钢
板（软管卡箍）

低真空泵连接点1

请参阅《场地规划指
南》。

塑料气体供应点（气体 1/气
体 2）

2

请参阅离子源废气排放系
统和《场地规划指南》。

塑料离子源废气排放气源3

请联系现场服务工程师。铝离子源通信连接点4

请参阅重置质谱仪。塑料RESET 按钮5

请参阅启动系统或关闭并
对系统进行排气。

铝/塑料电源连接点6

请参阅启动系统或关闭并
对系统进行排气。

塑料质谱仪便捷开关

（Up = On；Down =
Off）

7

请参阅外围设备设置指
南。

金属片（镀锌）辅助 I/O 连接点8

请联系现场服务工程师。金属片（镀锌）以太网连接带点（连接质
谱仪和计算机）

9

请参阅启动系统或关闭并
对系统进行排气。

塑料VENT 按钮10

请参阅《场地规划指
南》。

不锈钢离子源排废（至废物瓶）11

请参阅《场地规划指
南》。

不锈钢氮气供应（Curtain GasTM

供应装置，CAD 气体）
12

离子源概述

Turbo VTM离子源 可用于电喷雾电离 (ESI) 或大气压化学电离 (APCI)。

TurboIonSpray®探针适用于 ESI 模式操作。 APCI 探针适用于 APCI 模式操作。
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离子源组件

图 4-3 离子源组件

主要材料描述项目

红色 PEEK 管线样本供应设备的样本导管1

不锈钢喷针调节螺母2

不锈钢固定环3

不锈钢探针塔座4

PEEK 管线电晕放电针调螺钉5

玻璃用来在水平轴线上对探针进行定位
的千分尺，以调节离子源的灵敏度

6

不锈钢窗口7

不锈钢离子源的两个插锁中有一个是用来
将离子源固定在质谱仪上的。

8
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主要材料描述项目

不锈钢接地接头。位于离子源盖板下方。9

铝青铜用来在垂直轴线上对探针进行定位
的千分尺，以调节离子源的灵敏度

10

探针

TurboIonSpray®和 APCI 探针提供了一系列样本检测功能。选择最适用于样本中化合物的探针
和方法。

表 4-2 离子源规格

APCI 探针TurboIonSpray® 探针规格

从 50 °C 到 750 °C，具体
取决于液体流速

从环境温度到 750 °C，具体
取决于液体流速

温度范围

200 µL/min - 2000 µL/min40 µL/min - 1000 µL/min液流进口

请参阅质谱仪的《场地规划指南》。气体 1/气体 2

质谱仪所用软件确定已安装的探针，并启用相应的用户控制。用离子源采集的所有数据均以缩
写标记，它代表用来采集数据的探针（TIS 表示 TurboIonSpray®探针；HN 表示 APCI 探针）。

TurboIonSpray®探针

TurboIonSpray®探针由外径 (o.d.) 为 0.012 英寸的不锈钢管构成。它位于两台涡轮加热器中
央，与每一侧呈 45 度角放置。经 TurboIonSpray®探针引入的样本在导管内电离（在高电压
（IonSprayTM电压）的作用下）。而后，样本由来自涡轮加热器的高温、干燥和超高纯度 (UHP)
的氮气射流雾化，形成细小、高度带电的液滴。IonSprayTM流出液体和经过涡轮喷雾器加热的
干燥气体合在一起，以 90 度角喷入离子路径。请参阅 工作原理 — 离子源。

图 4-4 TurboIonSpray®探针
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描述项目

喷针调整螺母（黑色套口），用于调节喷针尖端的伸缩1

固定环，用来将探针固定在离子源罩壳上的探针塔座处2

喷针尖端，样本经由这里喷入离子源的样本进口区3

APCI 探针

APCI 探针由内径 (i.d.) 为 100 μm （0.004 英寸）的不锈钢管构成，有雾化器气流环绕管
周（气体 1）。样本液流经喷射器泵入，并在一根含有加热器的陶瓷导管中雾化。陶瓷管内壁
温度可维持在 100 °C 至 750 °C 范围之间，并由加热器中内置的传感器监控。

雾化气的高速喷射气流分布在喷针尖端周围，从而将样本以雾状细微颗粒的型式分散。它经陶
瓷汽化加热器进入离子源的反应区，然后通过电晕放电针，样本分子在经过离子源罩壳到达这
里的时候被电离。请参阅 工作原理 — 离子源。

图 4-5 APCI 探针部件

描述项目

喷针调整螺母（黑色套口），用于调节喷针尖端的伸缩1

固定环，用于将探针固定在探针塔座上2

喷针尖端，样本经由这里喷入离子源的样本进口区3

气路与电路连接

气体和低高压电路连接位于接口前板，并通过离子源罩壳进行内部连接。离子源安装到设备上
之后，所有电路和气路连接均已完成。

离子源感应线路

在下列情况下，离子源感应电路将禁用质谱仪的高压电源和离子源废气排放系统：

• 离子源罩壳未安装或安装不当。

• 未安装探针。

• 质谱仪感应到有气体故障。

液相色谱串联质谱检测系统系统用户指南
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• 涡轮加热器发生故障。

• 离子源过热。

离子源废气排放系统

警告！ 电离辐射危害、生物危害或有毒化学品危害。确保离子源排气系统已
连接并正在运行，从而安全除去排放到实验室环境中的样本蒸汽。设备的排气
必须排放到一般建筑排气系统中，不得排放到实验室的工作区。对于离子源排
气系统的要求，请参阅《场地规划指南》。

警告！ 电离辐射危害、生物危害或有毒化学品危害。将离子源排气系统与专
用实验室通风橱或者外部通风系统相接，以防止有害蒸气释放到实验室环境。

警告！ 电离辐射危害、生物危害或有毒化学品危害。如果 LC 系统配合质谱仪
使用，且离子源废气排放系统工作不能正常，请关闭 LC 系统，直至离子源废
气排放系统的功能恢复正常。

警告！ 火灾危险。将易燃溶剂注入离子源的流速不要超过 3 mL/min。虽然 LC 组件
提供的流速可高达 5 mL/min，但是超过最大流速会造成溶剂在离子源中积聚。当离子
源与探针安装正确时，如离子源排气系统无法启动和运行，请勿使用离子源。

注释： 确保牢固连接所有废气排放管线，以减小设备废气排入室内的可能性。

离子源会产生样本和溶剂蒸汽。这些蒸汽对于实验室环境有潜在危害。离子源废气排放系统旨
在安全地去除样本和溶剂蒸汽，并能够对其进行妥善处理。离子源安装好之后，在废气排放系
统工作前，质谱仪不会进入工作状态。

离子源废气排放感应电路中安装的真空开关会测量离子源中的真空度。如果离子源中的真空度
升到设定点以上，并且已经安装了探针，系统就会进入排气故障 (Not Ready) 状态。

正常工作的废气排放系统会将离子源废气（各种气体，溶剂、样本蒸汽）经排放端口去除，且
不会产生化学噪声。排放端口通过一个排放容腔和一个离子源废气排放泵连接至排放瓶，并由
此连接至客户自配的废气通风系统。有关离子源废气排放系统通风要求方面的信息，请参阅《场
地规划指南》。

注释： 应定期检查排气系统情况，以确保排气管路完好无损，且废气未漏入室内。
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Analyst® MD 软件视图

Analyst® MD 软件与质谱仪和高效液相色谱法 (LC) 系统和相关联的固件配合使用，以控制系
统和数据采集。在系统运行期间，所获数据被发送至 Analyst® MD 软件，此软件可通过完整质
谱、单离子或多离子强度－时间或总离子流－时间形式显示这些数据。

不同数据视图

下图举例说明了两种数据视图：总离子色谱图 (TIC) 和提取的离子色谱图 (XIC)。

TIC：通过将总离子流作为时间的函数而绘得的图形。

图 4-6 TIC 示例

XIC：通过从一系列质谱扫描中在单个、不连续的质量数或一个质量范围内提取产生的强度数值
而创建的离子色谱图。它表示一个给定的质量数或质量范围随时间变化的行为。
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图 4-7 XIC 示例

参数

工作参数是当前正在使用的一系列质谱仪参数。

该方法会存储化合物参数以及离子源和气体参数。分辨率和检测器参数取决于仪器，并存储为
仪器数据。如果使用了调谐模式创建方法，则可以使用工作参数对其进行优化，以获得最佳性
能。或者，在循环实验的过程中，逐个斜升各参数。

• 离子源和气体参数：这些参数可以根据所使用的离子源发生变化。

• 化合物参数：这些参数主要是由离子路径电压组成。化合物依赖型参数的最佳值因正在分析
的化合物不同而有所变化。

• 分辨率参数：这些参数会影响分辨率和校正。

• 检测器参数：这些参数会影响检测器。

下图显示了参数在离子光学路径中的位置。
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图 4-8 离子光学路径和参数

扫描类型用途参数类型参数位置

全部IS 参数控制施加到 TurboIonSpray® 探
针内喷针的电压（在离子源中使样本电
离）。此参数依赖于极性，会影响喷雾
稳定性和灵敏度。此参数可能是化合物
相关参数，应必须为每一种化合物进行
优化。

离子源和气
体

IonSpray
Voltage
(IS)

1

全部NC 参数控制流经 APCI 探针（用于
Turbo VTM 离子源）内电晕放电针的电
流。放电会电离溶剂分子，而这反过来
会使样本分子电离。

离子源和气
体

Nebulizer
Current
(NC)

1

全部GS1 参数可同时控制用于
TurboIonSpray® 和 APCI 探针的雾化
气。

离子源和气
体

Ion Source
Gas 1 (GS1)

1

全部GS2 参数可控制用于 TurboIonSpray®

探针的加热气。
离子源和气
体

Ion Source
Gas 2 (GS2)

1

全部TEM 参数控制 TurboIonSpray® 探针加
热气的温度或 APCI 探针的温度。

离子源和气
体

Temperature
(TEM)

1

全部CUR 参数控制 Curtain GasTM 接口的气
体流量。Curtain GasTM 接口位于气帘
板和小孔之间。它可以防止离子光学系
统的污染。

离子源和气
体

Curtain Gas
(CUR)

1
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扫描类型用途参数类型参数位置

全部去簇电压参数会控制孔上的电压，此电
压会控制孔与 QJet® 离子导向器之间的
离子去簇能力。它用于尽量减少在样本
离子进入真空腔后仍残留在其上的溶剂
簇，必要时用于产生碎片离子。电压越
高，传递给离子的能量越高。如果 DP
参数过高，则可能会出现不需要的碎
片。

使用预设值，并根据化合物进行优化。

化合物Declustering
Potential
(DP)

1

全部入口电势参数控制 Q0 和接地装置之间
的电势差。入口电势引导并聚焦离子使
其通过 Q0 区域的高压。

使用预设值。

化合物Entrance
Potential
(EP)

2

EMS、EPI、
ER 和 MS/
MS/MS

Q0 捕获参数控制 Q0 区域中离子的储
存。通过将离子储存在 Q0 区域，而后
以质量选择性方式从线性离子阱中射出
离子，来提高灵敏度和工作周期。将固
定填充时间与此参数结合使用。

根据实验要求选择或清除此功能。

我们建议使用固定填充时间 20 ms 或
以上。

化合物Q0 Trapping2

Q3 MI、Q3
MS、MRM、
Prec、NL、
EMS、ER、
EPI 和 MS/
MS/MS

CAD 气体参数控制 Q3、MS/MS 和 LIT
扫描期间碰撞池中 CAD 气体的压力。
对于 Q3 扫描，碰撞气体有助于在离子
穿过 Q2 碰撞池时聚集离子。CAD 参数
的预设值呈固定模式。对于串联质谱扫
描类型，CAD 气体有助于使前体离子碎
裂。当前体离子与碰撞气体发生碰撞
时，它们离解形成产物离子。对于线性
离子阱扫描类型，碰撞气体有助于在线
性离子阱中聚集和捕获离子。

使用预设值，并根据化合物进行优化。

离子源和气
体

CAD Gas3

EPI、MS/MS/
MS、MRM、
MS2、Prec、
NL和 LIT

碰撞能量参数控制 Q0 区域与 Q2 碰撞
池之间的电势差。它仅用于串联质谱扫
描类型。此参数是前体离子在加速进入
Q2 碰撞池（在此池中，它们与气体分
子碰撞并发生碎裂）时接受的能量大
小。

使用预设值，并根据化合物进行优化。

化合物Collision
Energy (CE)

3
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扫描类型用途参数类型参数位置

EPI 和 MS/
MS/MS

当使用碰撞能量散布时，碰撞能量散布
参数连同碰撞能量参数一起确定哪三种
离散碰撞能量会在增强型产物离子扫描
(EPI) 或 MS/MS/MS (MS3) 扫描中施加
到前体离子质量。当输入碰撞能量散布
值时，碰撞能量散布会自动开启。

使用预设值，并根据化合物进行优化。

化合物Collision
Energy
Spread
(CES)

3

Q3、MRM、
MS2、Prec、
NL

CXP 参数仅用于 Q3 和 MS/MS 扫描类
型。此参数会将离子传输到 Q3 四极杆
中。

使用预设值，并根据化合物进行优化。

化合物Collision
Cell Exit
Potential
(CXP)

3

EMS、EPI、
ER 和 MS/
MS/MS

Q3 进入屏障参数可用于将离子从 Q2
碰撞池传输至线性离子阱中。

使用预设值。

化合物Q3 Entry
Barrier

4

MS/MS/MSMS/MS/MS 碎裂时间参数控制施加激发
能量的时长。它与激发能量一起使被分
离的第二前体离子发生碎裂。

使用预设值。

化合物MS/MS/MS
Fragmen-
tation
Excitation
Time

5

EMS，EPI，
ER 和 MS/
MS/MS

固定线性离子阱填充时间参数控制使用
离子填充线性离子阱的时长。

使用预设值，并基于样本浓度进行调
整，以获得所需的信号响应。

化合物Fixed LIT
Fill Time

5

EMS，EPI，
ER 和 MS/
MS/MS

DFT 参数可基于传入的离子信号，动态
计算在线性离子阱中收集离子的时长。
当 DFT 开启时，信号会得到优化，以
便增加灵敏度或尽量减少空间放电现
象。

根据实验选择或清除功能。

在 Tools > Settings > Method
Options 对话框中，对默认扫描速度的
DFT 设置进行优化。这些设置也适用于
其他线性离子阱扫描速度。

化合物Dynamic
Fill Time
(DFT)

5

全部CEM 参数控制施加到检测器上的电压。
此电压会控制检测器的响应。

检测器CEM6
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工作原理—硬件

质谱可测量离子质荷比，以鉴定未知化合物，量化已知化合物，以及提供关于分子的结构和化
学特性的信息。

质谱仪具有一系列根据其质荷（M/Z）比传输离子的四极过滤器。本系列的第一个四极杆是
QJet®离子导向器。QJet®离子导向器不过滤离子，而是在离子进入 Q0 区域之前对其进行聚集。
通过对由宽孔口产生的较大离子流进行预聚焦，QJet®离子导向器提高了系统灵敏度，增大了信
噪比。在 Q0 区域，离子在进入 Q1 四极杆之前再次聚集。

图 4-9 离子轨道

描述项目

锥孔板1

QJet 离子导向器2

Q0 区域3

Q1 四极杆4

Q2 碰撞池5

Q3 四极杆6

检测器7

Q1 四极杆是一种过滤四极杆，可在离子进入 Q2 碰撞池之前对其进行分类。在 Q2 碰撞池，通
过碰撞，气体分子到达某点，分子键断裂，产生产物离子，离子的内部能量增加。此技术允许
用户设计测量产物离子 m/z 以确定母离子组成的实验。

通过 Q2 碰撞池后，离子进入 Q3 四极杆进行额外过滤，然后进入检测器。在检测器中，离子
产生电流，转换成电压脉冲。离开检测器的电压脉冲与进入该检测器的离子数量成正比。系统
监测这些电压脉冲，然后将信息转换成信号。此信号代表具有特定 m/z 值的离子强度，系统以
质谱显示此信息。
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线性离子阱 (LIT) 功能提供了数种增强型操作模式。这些增强型模式的一个共同要素是离子被
捕获于四极杆 Q3 区域，然后经扫描输出产生完整的质谱数据。许多质谱都是在短时间内快速
采集到的，比类似的标准四极杆操作模式中采集到的质谱要明显更密集。

在采集阶段，离子穿过 Q2 碰撞池，在此处 CAD 气体将离子集中到 Q3 区域。四极杆 Q3 是在
只应用主射频电压的情况下运作。阻止离子通过 Q3 四极杆装置，并通过输出透镜反射回来（采
用直流势垒电压）。在填充时间结束之后（由用户定义填充时间或者由动态填充时间功能
(Dynamic Fill Time feature) 确定），直流势垒电压应用于 Q3 输入透镜 (IQ3)。这会将采
集到的离子限制在 Q3 区域，并阻止更多的离子进入。输入和输出透镜直流电压势垒和施加到
四极杆上的射频电压可将离子限制在 Q3 区域内。

在扫描输出阶段，输出透镜电压和辅助射频电压与主射频电压同时变化，从而相对于四极杆扫
描模式而言，分辨率和灵敏度均出现提高。四极杆 Q3 采用了辅助交流频率。主射频电压振幅
由低数值斜升至高数值，从而依次使各离子与辅助交流频率发生共振。当离子与交流频率发生
共振后，它们获得了足够的轴向速度，从而可以克服输出透镜势垒，轴向排向质谱仪离子检测
器。通过快速扫描主射频电压，可以获得采集到 Q3 中离子的完整质谱数据。

ESI 模式

ESI 会对流经针头的样本排放物施加高电压，从而在样本中生成分析物的气相离子。借助加热
气流，ESI 可以在一个相对温和的条件下生成单电荷及多电荷离子，因此它适用于多种化合物，
包括小分子（比如药物或杀虫剂）和大分子（比如多肽、蛋白质和其他生物高聚物）。灵敏度
取决于分析物的化学性质、气体流速、温度、电压和流动相组成。

ESI 技术条件温和，足以用于不稳定化合物，比如多肽、蛋白质和热敏药品。它运行时的流速
从 5 μL/min 至 3000 μL/min 不等，它能使 100% 水溶液至 100% 有机溶剂汽化。

请参阅 电喷雾电离模式。

APCI 模式

APCI 模式适用于：

• 未能在溶液中顺利形成离子的化合物电离。这些通常是非极性化合物。

• 为 LC-MS/MS 试验创建简单的 APCI 光谱。

• 复杂和污染样本的高通过量分析。它对离子抑制效应的灵敏度不高。

• 在使用或不使用 LC 色谱柱的情况下，通过流量注入迅速引入样本。

APCI 技术可用于热分解极小的挥发性和不稳定化合物。液滴和夹带分析物的快速去溶剂化和汽
化能够最大限度地减少热分解，并保持分子特性不变，以便通过电晕放电针电离。没有明显污
染的离子源能很好地耐受缓冲液，而且喷射流出物的闪蒸允许使用高达 100% 水。探针可接受
全部流出物，无需分流，流速从 200 μL/min 至 3000 μL/min 不等（通过一个宽孔柱）。

请参阅 APCI 模式。

数据处理

Analyst® MD 软件需要一台运行 Windows 7（32 位或 64 位）操作系统或 Windows 10（64
位）操作系统的计算机。计算机及相关系统与系统控制器和相关固件一起控制系统和数据采集。
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在系统运行期间，所采集的数据会被发送至 Analyst® MD 软件，此软件可通过完整质谱、单离
子或多离子强度随时间变化曲线或总离子流随时间变化曲线的形式显示这些数据。

Reporter 软件

Analyst® MD 软件负责数据采集和处理，不作任何临床决定。Reporter 软件扩展了 Analyst®

MD 软件中提供的报告功能。Reporter 软件可用于创建自定义报告。

MultiQuantTM MD 软件

MultiQuantTM MD 软件是一种定量数据处理软件，能够同时处理多种分析物和样本。它是随
Analyst® MD 软件一起安装的。MultiQuantTM MD 软件不作任何临床决定。MultiQuantTM MD 软
件提供了报告功能，此功能可用于创建自定义报告。

Cliquid® MD 软件

Cliquid® MD 软件为用户提供了易于使用的质谱工作流程，需配合 Analyst® MD 软件使用。
Cliquid® MD 软件不能控制质谱仪，也不直接处理数据。它的作用是与 Analyst MD 软件直接
互动，并在数据采集过程中与质谱仪互动，处理采集的数据，并进行色谱峰检查。Cliquid® MD
不作任何临床决定。

工作原理—Analyst® MD 软件

Analyst® MD 软件窗口

图 4-10 Analyst® MD 软件窗口
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描述项目

导航栏：使用导航栏可访问各种软件模式。用户可以根据他们的偏好自定
义导航栏的某些元素。例如，用户可以重新调整其大小，移动或将其固定
在位。若要隐藏导航栏，单击右上角的 x。若要查看导航栏，单击 View
> Navigation Bar。

导航树的顶层具有代表每种软件模式的图标。双击特定模式的图标可展开
或折叠树。这会显示或隐藏选定模式内可用功能的图标。

1

菜单栏：根据模式变化。某些选项（如剪切、复制和粘贴）在每个模式中
都一样。其他选项专用于特定模式，在其他模式中不可用。

2

模式列表：单击可更改模式。不同模式具有不同的可用工具栏图标。3

项目列表：单击可更改保存数据的项目。4

仪器和外围设备状态：该状态栏包含关于当前激活的信息。它通过颜色描
绘仪器的状态：绿色（就绪）、黄色（警告）、红色（错误）或白色（无
本地仪器工作站）。有一个图标会指示远程仪器的状态。双击该图标可打
开设备状态窗口。

5

Companion Software：从该软件打开的任何已安装的配套软件都会显示在
此部分。

6

Analyst® MD 软件模式

本软件被划分为各种模式，即独立的功能区，用户可以用这些模式来执行某个主要任务的一系
列相关活动。用户可以通过导航栏或工具栏中的 Mode 列表来访问这些模式，也可以从一种模
式切换到另一种，而且不会丢失任何工作。

表 4-3 Analyst® MD 软件中的模式

描述名称

Configure 模式用于配置设备和系统设置。设置软件的各种选项和参数，包括
硬件配置和报告模板设置。

Configure

Tune and Calibrate 模式用于设置仪器调谐选项以确保最佳结果。在 Tune
and Calibrate 模式下，用户可以：

• 执行仪器优化。

• 执行手动调谐。

• 更改图形视图的外观、查找显示的文件信息，以及设置链接选项和其他外观
选项。

• 更改处理选项。

Tune and
Calibrate
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表 4-3 Analyst® MD 软件中的模式 （续）

描述名称

Acquire 模式用于设置确定样本采集方式的选项。在 Acquire 模式下，用户
可以：

• 使用 Method Wizard 创建采集方法。

• 使用 Acquisition Method Editor 创建采集方法。

• 使用 Batch Editor 创建批次。

• 使用 Queue Manager 查看队列。

• 监控采集状态。

Acquire

Explore 模式用于对样本执行定性分析。在 Explore 模式下，用户可以：

• 查看图形。

• 查看色谱图。

• 查看质谱。

• 在批次采集过程中实时显示数据。

Explore

Quantitate 模式用于分析所采集的数据并建立定性方法来生成结果表。使用
结果表可以手动检查批次内每个分析物和内标物的所有峰，并可以查看校正曲
线、样本统计数据和度量图表。

Quantitate

定量

LC-MS/MS 定量的目的是准确测定未知样本中某化合物的浓度。MRM 扫描类型主要用于在三重四
极杆或 QTRAP® 离子阱质谱仪 仪中进行定量分析。在 MRM 扫描中，此技术可确定前体离子和
特征性产物离子，从而创建具有高度特异性的分析物离子对。在液相色谱检测期间，MRM 离子
对与分析物相关保留时间结合起来，可达到定量所需的特异性。

定量工作可通过使用经过验证的 MRM LC-MS/MS 采集方法、采集校正标准曲线以及随后对目标
化合物相关峰进行积分来实现。信号响应与浓度之间的校正曲线关系用于确定未知样本中特定
分析物的含量。

积分

在 LC-MS/MS 数据中，积分指的是获取与特定化合物有关的峰曲线下的面积。通过开发可指定
跃迁、预期保留时间、内标物、积分和回归参数的方法，该软件可自动求取给定样本集的峰积
分。

关于结果表

结果表总结每个未知样本中的分析物基于校正曲线计算出的浓度。结果表还包括校正曲线及统
计结果。用户可以自定义结果表，以及在布局表中查看结果表。
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结果表中的数据可以以 .txt 文件形式导出，以便用于其他应用程序，如 Microsoft Excel。
用户也可以导出表中数据，或只是可见列中的数据。

我们建议用户在创建结果表之后不要重命名数据文件。

校正曲线

校正曲线（也被称为标准浓度曲线）是一种通过将未知样本与一套已知浓度的标准物样本进行
比较，来确定未知样本中物质浓度的方法。校正曲线是一种仪器（的分析信号）如何响应分析
物（待测量的物质）浓度变化的图表。用户可以准备一系列标准物，其浓度范围接近未知样本
中分析物的预计浓度。

校准标准品用于建立校正曲线。有些校准样本的错误读数或缺失的读数可能会指出分析运行中
存在的问题。遵循文献和监管机构指南中找到的可接受方法来创建校正曲线。制作校正曲线时
的良好做法示例包括：

• 在要测量分析物的空白基质中制备校准标准物。

• 为每个要测量的分析物生成校正曲线。

• 确保涵盖预期分析物浓度范围，包括典型和非典型标本。

• 使用六到八个标准物来生成曲线。

这不是详细一览表，在确定制定实验室校正曲线的最佳做法时还应使用其他指南。

注释： 一些分析运行中使用单点校准标准物。通过基质空白样本和单个标准物浓度可进行单
点校准。仪器反应和分析物浓度之间的关系可通过由这两个点确定的直线确定。将采集方法
和定量方法用于其预期用途前，都应进行验证。

回归

校正曲线标准物中的分析物峰的面积与已知浓度对照绘制。之后用线条连接各点。回归方程用
于计算未知样本的浓度。

• 线性 (y = mx + b)

• 过零点线性 (y = mx)

• 二次 (y = a2 + bx + c)

也可以为回归方程添加不同类型的加权，包括：

• 1/x

• 1/x2

• 1/y

• 1/y2
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本节包括 SCIEX Triple QuadTM4500MDLC-MS/MS 系统和 QTRAP®4500MDLC-MS/MS 系统。

质谱仪规格

表 5-1 质谱仪规格

S/N 大于 2000

C.V. 小于 5%

利血平 200 fg（列）灵敏度（MRM 模式）

12 000 Da/sec最大扫描速度

20 000 Da/sec最大线性离子阱扫描速
度（仅限 QTRAP® 系
统）

50 msec（Scheduled MRMTM 模式），最小 50 msec（MRM 模式）极性转换

1 msec最小 MRM 驻留时间

5 Da 至 2000 Da质量范围 (m/z)

50 Da 至 2000 Da线性离子阱质量范围
(m/z) ( 仅限 QTRAP®

系统）

可检测到小于 0.5% 的串音，驻留时间为 2 msec，MRM 内暂停时间为
3 msec

利血平 609/195 的串
音

24 小时内 0.1 Da质量稳定性
（质量稳定性评估使用
Q1 扫描和产物离子扫
描，扫描速率为 10
Da/sec。）

全扫描 MS 和适用于 Q1 和 Q3 的选择离子扫描 MS、产物离子扫描、
前体离子扫描、中性丢失或获得扫描、多反应监测 (MRM) 扫描以及计
划的 MRM 扫描类型。（仅限 QTRAP® 系统）增强型 MS 扫描、增强型
产物离子扫描、增强型分辨率扫描和 MS3 扫描。

扫描类型

四个数量级动态范围

重量

77.5 kg（171 磅）可堆叠 - 质谱仪顶部
的最大重量
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表 5-1 质谱仪规格 （续）

130 kg（287 磅）重量 - 质谱仪

34 千克（75 磅）重量 - 低真空泵

尺寸

79 cm × 79 cm × 59 cm

32 英寸 x 32 英寸 x 24 英寸

质谱仪
(W × D × H)

12 英寸 x 17 英寸 x 9 英寸低真空泵
(W × D × H)

100 cm × 84 cm × 78 cm仪器工作台
(W × D × H)

表 5-2 探针规格

APCI 探针TurboIonSpray® 探针参数

探针的温度从环境温度到 750 °C，具
体取决于液体流速

探针的温度从环境温度到 750 °C，具
体取决于液体流速

离子源温度
范围

200 μL/min - 3 mL/min5 µL/min - 3 mL/min流速兼容性

小心： 可能导致系统损坏。切勿超过最大流速。否则，可能会导致系统性能
不稳定或损坏。

• 零级空气，或联系 SCIEX 获取气体输入选项。

• 输送压力为 100 psi（6.89 巴）至 105 psi（7.25 巴），流速高达 22
L/min

请参阅《场地规划指南》。

气体 1

气体 2

表 5-3 电气规格

质谱仪

200 V 交流电 (AC ) 至 240 V 交流电 (AC)标称输入电压

标称值的 ±10%输入电压波动

50 Hz 或 60 Hz频率

10 A输入电流

1000 VA输入功率

低真空泵

200 V 交流电 (AC ) 至 240 V 交流电 (AC)标称输入电压
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表 5-3 电气规格 （续）

标称值的 ±10%输入电压波动

50 Hz 或 60 Hz频率

4.2 A (50 Hz), 4.7 A (60 Hz)输入电流

1420 VA (50 Hz), 1250 VA (60 Hz)输入功率

计算机

115 VAC - 230 VAC标称输入电压

标称值的 ±10%输入电压波动

50 Hz 或 60 Hz频率

6 A (50 Hz), 3 A (60 Hz)最大输入电流

690 VA最大输入功率

显示器

100 VAC - 240 VAC标称输入电压

–10%/+6% 标称值的输入电压波动

50 Hz 或 60 Hz频率

1.5 A最大输入电流

360 VA最大输入功率
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表 6-1 仪器设置工作流程

具体事项信息来源目的步骤

每一个硬件配置文件必须包括一台质谱
仪和其他设备，如 LC 系统。创建采集
方法时，只能使用当前硬件配置文件中
所包含的外围设备。

创建硬件配置文件创建硬件配置文
件。

1

使用项目和子项目有助于数据管理，而
且便于比较结果。

创建项目和子项目创建项目以存储数
据。

2

此过程旨在优化分辨率和质谱仪参数，
并校正质谱仪以达到系统的最佳灵敏度
和性能。

验证仪器性能优化质谱仪。3

表 6-2 常规分析工作流程示例

具体事项信息来源目的步骤

每一个硬件配置文件必须包括一台质谱
仪和其他设备，如 LC 系统。创建采集
方法时，只能使用当前硬件配置文件中
所包含的外围设备。

创建硬件配置文件激活适用于该方法
的硬件配置文件。

1

使用项目和子项目有助于数据管理，而
且便于比较结果。

创建项目和子项目创建项目以存储数
据。

2

创建采集方法后，通过创建采集批次并
提交批次至采集队列来运行样本。

添加样本集合和样
本至批次和提交样
本或样本集

创建并提交批次。3

在开始数据采集之前平衡系统。未经平
衡的系统会导致数据质量不佳。

平衡系统平衡系统。4

运行样本涉及管理采集队列以及监测仪
器和设备状态。要提交样本并采集数
据，请使用 Queue Manager。Queue
Manager 可显示队列、批次和样本状
态，有助于管理队列中的样本和批次。

采集数据运行样本以采集数
据。

5
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表 6-2 常规分析工作流程示例 （续）

具体事项信息来源目的步骤

在 Explore 模式下，可使用多种工具
来查看和处理所采集的数据。可自定义
图形的峰标签和图注，显示等值线图，
以及在谱库中保存质谱。

操作说明 - 分析
和浏览数据

在 Explore 模式
下分析数据（可
选）。

6

• 若使用 MultiQuantTM MD软件进行定量分析，请按步骤 7 至 8 操作。对于更大的数据集
建议采用 MultiQuantTM MD软件。

• 若使用 Analyst® MD软件进行定量分析，请按步骤 9 至 10a 操作。

• 若使用 Analyst® MD软件进行定性分析，请按步骤 9 至 10b 操作。

生成结果表，并使用该表手动检查批次
内每个分析物和内标物的所有峰，并查
看校正曲线、样本统计数据和度量图
表。

MultiQuantTM MD软
件参考指南：第
7、8、10、11、
12、13、14 章

在 MultiQuantTM

MD软件中分析定量
数据。

7

使用提供的报告模板为已生成且经过检
查的结果生成报告。

MultiQuantTM MD软
件参考指南：附录
C

在 MultiQuantTM

MD软件中创建一份
报告。

8

生成结果表，以便手动检查批次内每个
分析物和内标物的所有峰。对于定量分
析，还应检查校正曲线、样本统计数据
和度量图表。

操作说明 — 分析
和处理定量数据

在 Analyst® MD软
件中分析定性（或
定量）数据。

9

使用提供的报告模板为已生成且经过检
查的结果生成报告。对于专用于定性分
析的报告，请使用标有谱库搜索的报告
模板集。

生成报告在 Analyst
Reporter 中创建
一份报告。

10a

选择适用于结果的 MS/MS 质谱谱库，
然后使用提供的报告模板（被标记为谱
库搜索）为已生成且经过检查的结果生
成报告。对于专用于定性分析的报告，
请使用标有谱库搜索的报告模板集。

生成报告选择一个谱库，然
后使用 Analyst
Reporter 创建一
份报告。

10b

表 6-3 方法开发人员工作流程示例

具体事项信息来源目的步骤

每一个硬件配置文件必须包括一台质谱
仪和其他设备，如 LC 系统。创建采集
方法时，只能使用当前硬件配置文件中
所包含的外围设备。

创建硬件配置文件创建硬件配置文
件。

1

使用项目和子项目有助于数据管理，而
且便于比较结果。

创建项目和子项目创建项目以存储数
据。

2
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表 6-3 方法开发人员工作流程示例 （续）

具体事项信息来源目的步骤

软件自动优化目标化合物及其质谱仪参
数。

操作说明 - 自动
优化

自动优化化合物

- 或 - 步骤 4 手
动优化化合物。

3

用户手动优化目标化合物及其质谱仪参
数。在优化过程中，手动优化允许更有
经验的用户进行更多的控制。

操作说明 - 手动
化合物优化

手动优化化合物。4

要分析样本，请为质谱仪和任何 LC 设
备创建一个采集方法。采集方法指明了
要使用哪些外围设备、何时使用这些设
备采集数据以及相关参数。

操作说明 - 采集
方法

创建采集方法。5

创建采集方法后，通过创建采集批次并
提交批次至采集队列来运行样本。

添加样本集合和样
本至批次和提交样
本或样本集

创建并提交批次。6

在开始数据采集之前平衡系统。未经平
衡的系统会导致数据质量不佳。

平衡系统平衡系统。7

运行样本涉及管理采集队列以及监测仪
器和设备状态。要提交样本并采集数
据，请使用 Queue Manager。Queue
Manager 可显示队列、批次和样本状
态，有助于管理队列中的样本和批次。

采集数据运行样本以采集数
据。

8

在 Explore 模式下，可使用多种工具
来查看和处理所采集的数据。可自定义
图形的峰标签和图注，显示等值线图，
以及在谱库中保存质谱。

操作说明 - 分析
和浏览数据

在 Explore 模式
下分析数据（可
选）。

9

• 若使用 MultiQuantTM MD软件进行定量分析，请按步骤 10 至 12 操作。对于更大的数据
集建议采用 MultiQuantTM MD软件。

• 若使用 Analyst® MD软件进行定量分析，请按步骤 13 至 15 操作。

• 对于定性分析，请联系支持部门。

在软件中使用各种定量方法创建工具分
析所采集的数据，并建立定量方法来生
成结果表。

MultiQuantTM MD软
件参考指南：定量
方法编辑器

在 MultiQuantTM

MD软件中创建定量
方法。

10

生成结果表，并使用该表手动检查批次
内每个分析物和内标物的所有峰，并查
看校正曲线、样本统计数据和度量图
表。

MultiQuantTM MD软
件参考指南：第
7、8、10、11、
12、13、14 章

在 MultiQuantTM

MD软件中分析定量
数据。

11
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表 6-3 方法开发人员工作流程示例 （续）

具体事项信息来源目的步骤

使用提供的报告模板为已生成且经过检
查的结果生成报告。

MultiQuantTM MD软
件参考指南：附录
C

在 MultiQuantTM

MD软件中创建一份
报告。

12

在软件中使用各种定量方法创建工具分
析所采集的数据，并建立定量方法来生
成结果表。

MultiQuantTM MD软
件参考指南：定量
方法编辑器

在 Analyst® MD软
件中创建定量方
法。

13

生成结果表，以便手动检查批次内每个
分析物和内标物的所有峰。对于定量分
析，还应检查校正曲线、样本统计数据
和度量图表。

操作说明 — 分析
和处理定量数据

在 Analyst® MD软
件中分析定性（或
定量）数据。

14

使用提供的报告模板为已生成且经过检
查的结果生成报告。对于专用于定性分
析的报告，请使用标有谱库搜索的报告
模板集。

生成报告在 Analyst
Reporter 中创建
一份报告。

15
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警告！ 人身伤害危险。使用系统时，按照文件中的说明进行操作。如果未按 SCIEX
要求的方式使用设备，则该设备提供的防护可能无法发挥有效作用。

启动系统

警告！ 触电危险。确保在紧急情况下可将系统与电源插座断开。不要挡住电源
插座。

警告！ 升降危险。不要移动系统。有人身伤害或系统损坏风险。如果必须移动
系统，请联系现场人员。

注释： 操作仪器前，请阅读操作注意事项和限制中的安全信息。

前提条件

• 满足《场地规划指南》中规定的场地要求。《场地规划指南》包括有关主电源和连接件、
压缩空气、氮气、低真空泵、通风、排气和场地清理要求的信息。请联系我们获取一份
《场地规划指南》（如果需要）。关于联系信息，请访问 sciex.com/about-us/contact-us。

• 离子源废气、压缩空气和氮气与质谱仪相连。

• 4 L 离子源废气排放瓶已连接到质谱仪背面的废气废弃物连接装置和实验室通风系统上。

• 离子源排气软管牢牢地夹在质谱仪、排放瓶和通风连接件上。

• 质谱仪便捷开关已关闭，主电源电缆已插入质谱仪。

• 质谱仪和低真空泵主电源电缆已插入 200VAC 至 240VAC 电源。

• 以太网电缆同时与质谱仪和计算机相连。

1. 打开低真空泵。

液相色谱串联质谱检测系统系统用户指南
61 / 267IVD-IDV-05-6996-ZH-B

7操作说明 — 质谱仪和离子源

https://sciex.com/about-us/contact-us


图 7-1 低真空泵－开/关

2. 等待五分钟，然后打开质谱仪方便开关。请参阅图 4-2。

3. 打开计算机。

4. 打开 Analyst® MDMD 软件。

离子源优化

警告！ 电离辐射危害、生物危害或有毒化学品危害。只有在充分了解与离子源
一起使用的有毒或有害材料的妥善利用、防护和疏散方面的知识，并接受了相
关培训后，才能使用离子源。

警告！ 火灾危险。将易燃溶剂注入离子源的流速不要超过 3 mL/min。虽然 LC 组件
提供的流速可高达 5 mL/min，但是超过最大流速会造成溶剂在离子源中积聚。当离子
源与探针安装正确时，如离子源排气系统无法启动和运行，请勿使用离子源。

警告！ 刺伤危险、电离辐射危害、生物危害或有毒化学品危害。如果离子源窗
口有裂痕或破损，请停止使用离子源，并与 SCIEX 现场服务工程师联系。设备
中引入的任何有毒或有害材料均会存在于离子源排气输出中。请按照既定实验
室安全程序处置锐器。

每当分析物、流速或流动相成份有变化时，都要优化离子源。

优化离子源相关参数时，以样本分析期间所要采用的流速进样，以流动加注分析 (FIA) 或者三
通进样 (Tee-infusion) 作为进样方法。在优化离子源相关参数之前优化离子源位置。
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某些参数会影响离子源的性能。优化性能的同时，要注入已知的化合物，并监测已知离子的信
号。调节千分尺、气体和电压参数，以获得最好的信噪比和信号稳定性。

请参阅 ESI 模式或 APCI 模式。

TurboIonSpray® 探针优化

警告！ 电离辐射危害、生物危害或有毒化学品危害。离子源排气系统一定要
连接且正在运行，且实验室要保证良好的通风条件。实验室要有良好的通风条
件，以控制溶剂和样本排放，保证质谱仪的安全运行。

警告！ 火灾危险。将易燃溶剂注入离子源的流速不要超过 3 mL/min。虽然 LC 组件
提供的流速可高达 5 mL/min，但是超过最大流速会造成溶剂在离子源中积聚。当离子
源与探针安装正确时，如离子源排气系统无法启动和运行，请勿使用离子源。

警告！ 电离辐射危害、生物危害或有毒化学品危害。确保喷针的突出部分超过
探针尖端，以防止有害蒸汽从离子源溢出。喷针不能缩入探针内部。

小心： 可能导致系统损坏。如果连接到质谱仪的 HPLC 系统并非由软件控制，则在运行期间
不得使质谱仪处于无人值守的状态。质谱仪进入待机模式后，来自 HPLC 系统的液流可能会
淹没离子源。

注释： 为了保持系统清洁并处于最佳性能状况下，在改变流速时要调整探针位置。

提示！ 与柱上进样相比，使用流动注射分析可大大简化信号和信噪比的优化过程。

注释： 如果 IonSprayTM电压过高，可能会发生电晕放电。在探针尖端可以看到蓝光。电晕放
电导致灵敏度以及信号稳定性下降。

流速和离子源温度

样本导入流速和样本溶剂成分会影响最佳的 TurboIonSpray®探针温度。流速越高或含水率越
高，则最佳温度就越高。

TurboIonSpray®探针使用时的样本流速通常为 5 µL/min 至 1000 µL/min。加热旨在加快蒸发
速度，从而可以提高电离效率，从而增加灵敏度。极低流速的高浓度有机溶剂通常不需要升高
温度。请参阅 离子源参数和电压。

表 7-1提供了不同流速的典型离子源温度。用户必须始终优化用于特定应用的离子源温度。
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表 7-1 流速和典型温度

典型离子源温度 (°C)流速 (µL/min)

0 - 1001 - 20

150 - 35020 - 100

300 - 400100 - 300

400 - 500300 - 1000

方法

液态样本流由 LC 泵或注射泵输入到离子源。如果用 LC 泵来输送，则可以采用流动注射分析
(FIA) 或三通进样、通过注射泵或者通过使用环状进样器或自动进样器的分离柱将样本直接注
入流动相。如果用注射泵引入，则样本被直接喷入离子源。注入优化只能用于离子路径优化或
MS/MS 碎片选择。

系统准备

要为化合物创建一种优化方法，请参阅 操作说明 - 手动化合物优化。

1. 启动 Analyst® MD 软件。

2. 在 Navigation 栏中的 Tune and Calibrate 模式下，双击 Manual Tuning。

3. 打开先前已优化的方法，或根据所用化合物创建一种方法。

4. 如果离子源已获冷却，则执行以下操作。

a. 将 Temperature (TEM) 参数设置为 450。

b. 让离子源加热 30 分钟。

30 分钟的加热阶段可以防止溶剂蒸气在冷探针中冷凝。

5. 开始样本流和样本注射。

设置启动条件

1. 在 Tune Method Editor 中，确保选中正确的 Scan Type 和适当的化合物参数。

2. 在 Source/Gas 选项卡上，键入 Ion Source Gas 1 (GS1) 的起始值。

对于 LC 泵来说，所使用的气体 1 值在 40 至 60 之间。

3. 键入 Ion Source Gas 2 (GS2) 的起始值。

对于 LC 泵来说，所使用的气体 2 值在 30 至 50 之间。

注释： 在液相色谱系统以及温度增加的情况下，气体 2 通常采用较高的流速。

4. 在 IonSpray Voltage (IS) 字段中键入 4500。

5. 在 Curtain Gas (CUR) 字段中键入 20。

系统用户指南液相色谱串联质谱检测系统
IVD-IDV-05-6996-ZH-B64 / 267

操作说明 — 质谱仪和离子源



6. 开始采集。

优化 TurboIonSpray®探针位置

警告！ 电离辐射危害、生物危害或有毒化学品危害。确保喷针的突出部分超过
探针尖端，以防止有害蒸汽从离子源溢出。喷针不能缩入探针内部。

警告！ 刺伤危险。喷针要轻拿轻放。喷针的尖端特别锋利。

探针优化完成后，只需要进行微调。如果将探针移除，或者如果分析物、流速或溶剂组成发生
变化，则应重复这一优化过程。

请参阅 离子源组件。

1. 通过离子源罩壳的窗口查看探针的位置。

2. 用之前的水平和垂直千分尺设置作为起始位置，或将其设为 5。

3. 在 Analyst® MD 软件中监测分析物的信号或信噪比。

4. 用水平千分尺小幅调节探针位置，获得最佳信号或信噪比。

探针可向小孔的任一侧小幅优化。

提示！ 调节千分尺的水平设置，使 TurboIonSpray®探针的液体喷雾远离小孔，以防污染
小孔，防止被 Curtain GasTM 气流渗透（会造成信号不稳定），防止因液体导致的电流短
路。

5. 用垂直千分尺小幅调节探针位置，获得最佳信号或信噪比。

注释： 探针的垂直方位取决于流速。流速越低，探针应离采样孔越近。流速越高，探针应
离采样孔越远。

6. 调节探针上的黑色喷针调整螺母，将喷针伸入或移出探针。喷针尖端应当从探针末端伸出
0.5 mm 至 1.0 mm。

喷针尖端的理想设置值取决于所用化合物。喷针尖端伸出量会影响喷射锥形的形状，而喷射
锥形的形状又会影响质谱仪的灵敏度。
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图 7-2 喷针尖端伸出量调节

描述项目

探针1

喷针2

优化离子源和气体参数及电压

优化离子源气体 1（雾化气）以达到最佳的信号稳定性和灵敏度。离子源气体 2（加热气）有
助于溶剂蒸发，从而促进样本电离。

温度过高会使 TurboIonSpray® 探针尖端的溶剂过早汽化，尤其是在探针伸出过远时，这会导
致信号不稳定并产生较高的化学背景噪声。同样，加热气流速过高也会产生嘈杂或不稳定的信
号。

在不丢失信号的前提下尽可能使用最低的 IonSprayTM电压。不仅要关注信号，还要注意信噪
比。如果 IonSprayTM电压过高，可能会发生电晕放电。放电时在 TurboIonSpray® 探针尖端可
见蓝色辉光。这会导致灵敏度以及离子信号稳定性下降。

1. 以 5 为增量调节 GS1 和 GS2，直至达到最佳信号或信噪比。

2. 增加 CUR 字段的值，直至信号开始降低。

注释： 为了防止污染，在不影响灵敏度的情况下采用可能的最高帘气流速。请勿将 CUR
设置为低于 20。这有助于阻止 Curtain GasTM（会产生噪声信号），而且可以阻止孔污
染，增加整体信噪比。

3. 以 500 V 为增量调节 IS，以尽可能提高信噪比。

优化涡轮加热器温度

加热器的理想温度取决于化合物、流速和流动相成份。流量越高、水合成份浓度越高，优化温
度就越高。
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优化离子源温度时，离子源一定要和新的温度设定值保持均衡。

• 以 50 °C 至 100 °C 为增量调节 TEM 值，直至达到最佳信号或信噪比。

APCI 探针优化

警告！ 电离辐射危害、生物危害或有毒化学品危害。离子源排气系统一定要
连接且正在运行，且实验室要保证良好的通风条件。实验室要有良好的通风条
件，以控制溶剂和样本排放，保证质谱仪的安全运行。

警告！ 火灾危险。将易燃溶剂注入离子源的流速不要超过 3 mL/min。虽然 LC 组件
提供的流速可高达 5 mL/min，但是超过最大流速会造成溶剂在离子源中积聚。当离子
源与探针安装正确时，如离子源排气系统无法启动和运行，请勿使用离子源。

警告！ 电离辐射危害、生物危害或有毒化学品危害。确保喷针的突出部分超过
探针尖端，以防止有害蒸汽从离子源溢出。喷针不能缩入探针内部。

小心： 可能导致系统损坏。如果连接到质谱仪的 HPLC 系统并非由软件控制，则在运行期间
不得使质谱仪处于无人值守的状态。质谱仪进入待机模式后，来自 HPLC 系统的液流可能会
淹没离子源。

注释： 有关 APCI 探针参数的完整列表，APCI 探针支持的最低流速为 200 µL/min。请参阅
APCI 探针参数。

提示！ 与柱上进样相比，使用流动注射分析可大大简化信号和信噪比的优化过程。

注释： 当使用 APCI 探针时，电晕针一定要指向小孔。

系统准备

要为化合物创建一种优化方法，请参阅 操作说明 - 手动化合物优化。

1. 启动 Analyst® MD 软件。

2. 在 Navigation 栏中的 Tune and Calibrate 模式下，双击 Manual Tuning。

3. 打开先前已优化的方法，或根据所用化合物创建一种方法。

4. 如果离子源已获冷却，则执行以下操作。

a. 将 Temperature (TEM) 参数设置为 450。
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b. 让离子源加热 30 分钟。

30 分钟的加热阶段可以防止溶剂蒸气在冷探针中冷凝。

5. 开始样本流和样本注射。

设置启动条件

1. 在 Tune Method Editor 中，确保选中正确的 Scan Type 和适当的化合物参数。

2. 在 Ion Source Gas 1 (GS1) 字段中键入 30。

3. 在 Curtain Gas (CUR) 字段中键入 20。

4. 在 Nebulizer Current (NC) 字段中键入 1。

5. 在 Compound 选项卡的 Declustering Potential (DP) 字段中，键入 100。

6. 开始采集。

优化气体 1 和 Curtain GasTM流量

1. 以 5 为增量调节 GS1，直至达到最佳信号或信噪比。

2. 增加 CUR 参数，直至信号开始降低。

注释： 为了防止污染，在不影响灵敏度的情况下采用可能的最高帘气流速。请勿将 CUR
设置为低于 20。这有助于阻止 Curtain GasTM（会产生噪声信号），而且可以阻止孔污
染，增加整体信噪比。

调整电晕放电针的位置

所需材料

• 绝缘平头螺丝刀

警告！ 触电危险。请遵循该规程要求，以避免接触到施加在电晕针、气帘板和
涡轮加热器的高电压。

当使用 APCI 探针时，确保电晕放电针指向小孔。当使用 TurboIonSpray®探针时，确保电晕放
电针指向远离小孔的方向。

1. 用一把绝缘平头螺丝刀转动电晕放电针上方的调节螺钉。

2. 仔细查看玻璃窗，确保放电针与面向小孔的尖端对齐。请参阅 优化 APCI 探针位置。
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优化 APCI 探针位置

警告！ 电离辐射危害、生物危害或有毒化学品危害。确保喷针的突出部分超过
探针尖端，以防止有害蒸汽从离子源溢出。喷针不能缩入探针内部。

警告！ 刺伤危险。喷针要轻拿轻放。喷针的尖端特别锋利。

气帘板的小孔一定要保持干净，任何时候都不能有溶剂或溶剂液滴。

喷射器喷嘴的位置会影响灵敏度和信号稳定性。仅以较小增量调节探针位置。流速越低，探针
的位置应越靠近小孔。流速越高，探针的位置应越远离小孔。探针优化完成后，只需要进行微
调。如果将探针移除，或者如果分析物、流速或溶剂组成发生变化，则应重复这一优化过程。

图 7-3 喷射器喷嘴的位置

描述项目

电晕放电针1

气帘板2

APCI 探针3

1. 用之前的水平和垂直千分尺设置作为起始位置，或将其设为 5。

注释： 为了避免降低质谱仪性能，不要直接喷到孔内。

液相色谱串联质谱检测系统系统用户指南
69 / 267IVD-IDV-05-6996-ZH-B

操作说明 — 质谱仪和离子源



2. 在 Analyst® MD 软件中监测分析物的信号或信噪比。

3. 用水平千分尺小幅调节探针，以获得最佳信号或信噪比。

4. 用垂直千分尺小幅调节探针，以获得最佳信号或信噪比。

5. 调节探针上的黑色喷针调整螺母，将喷针伸入或移出探针。喷针尖端应当从探针末端伸出
0.5 mm 至 1.0 mm。

喷针尖端的理想设置值取决于所用化合物。喷针尖端伸出量会影响喷射锥形的形状，而喷射
锥形的形状又会影响质谱仪的灵敏度。

图 7-4 喷针尖端伸出量调节

描述项目

探针1

喷针2

优化雾化电流

离子源受电流而非电压控制。无论离子源的选择位置如何，都要为采集方法选择恰当的电流。

• 从 NC 值为 3 开始，然后增加电流值，直至达到最佳信号或信噪比。

在正离子模式下，电晕放电针所采用的雾化电流通常在 1 µA 和 5 µA 之间进行优化。当电
流升高时，如果未观察到信号变化，则将电流保持在能够达到最佳信号或信噪比的最低值。

优化 APCI 探针温度

溶剂的数量和类型会对 APCI 探针的最优温度产生影响。在高流速情况下，最优温度会上升。

• 以 50 °C 至 100 °C 为增量调节 TEM 值，直至达到最佳信号或信噪比。

优化提示

离子源优化可将清洁离子源和真空接口组件的需求降到最低。

• 优化化合物时的温度应尽可能高。700 °C 是很多化合物普遍使用的温度。高温有助于离子
源的清洁，并降低背景噪声。
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• 在不降低信号的前提下尽可能使用最高的 Curtain GasTM流速 (CUR)。这有助于：

• 防止 Curtain GasTM气流渗透（可产生噪声信号）。

• 防止小孔污染。

• 提高整体信噪比。

• 调节水平千分尺的设置，使探针射出的液体喷雾远离小孔，其目的在于：

• 防止小孔污染。

• 防止 Curtain GasTM气流渗透（可产生不稳定信号）。

• 防止因液体导致的电流短路。

具体做法是使用垂直千分尺上移探针。

• 在不丢失信号的前提下尽可能使用最低的 IonSprayTM电压。不仅要关注信号，还要注意信噪
比。

质谱仪校正程序

质谱仪校正可随时间推移而发生变化。定期检查质量校正。安装时会对系统进行质量校正，并
在单位分辨率以及高分辨率上进行谱图峰分辨率优化（正离子和负离子模式），从而达到质谱
仪的最佳灵敏度和性能。质量校正可以确保由离子化化合物获得的信号以其真实的 m/z 值1进
行记录。使用已知纯度和质量的化合物对 m/z 标度进行校正。在分辨率优化期间，调整峰宽和
峰形。质谱分辨率表示为 (m/z)/宽度，其中宽度是指给定 m/z 值 1 的谱峰峰宽。通常在强度
为峰高一半时的点处测量出峰宽。

注释： 灵敏度随分辨率的升高而下降。在灵敏度要求和分辨率之间一定找到一个平衡点。

Analyst® MD 软件中的仪器优化模块用于质量校正和优化分辨率。每周或清洁仪器后检查质量
校正和分辨率，确认系统工作正常。总体而言，除非系统失掉真空状态，否则对于一个三重四
极杆质谱仪来说，在三个月至六个月内，校正和分辨率是稳定的。如果系统失去真空状态，则
需要在使用系统前检查校正情况和分辨率。请参阅操作说明 - 调谐和校正。

小心： 潜在的错误结果。确保系统已校正。如果未正确校正系统，可能会导致质量鉴别错误
或定量分析不准确。

1 CLSI 标准 C50–A–Vol.27, No.24—临床实验室中的质谱仪：一般原则和指南：获批指南。

请参阅操作注意事项和限制和校正离子和溶液。

采用仪器优化模块来进行质量校正和优化仪器分辨率。请参阅 操作说明 - 调谐和校正。

重置质谱仪

1. 停止任何正在进行的扫描，然后关闭流向系统的样本流。

2. 在 Analyst® MD 软件中，如果硬件配置文件处于活动状态，则停用此文件。
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3. 按住 Reset 按钮五秒钟。

当继电器激活时，即可听到咔嗒声。大约三分钟后，质谱仪达到工作压力。

关闭并对系统进行排气

某些程序要求关闭系统。其他程序还要求对系统进行排气。遵循下列步骤关闭系统并对系统进
行排气（如果需要）。

注释： 如果必须断开输入气体供应装置，则应在断开前释放气体管路内的压力。

提示！ 如果长时间不使用质谱仪，应使其保持 Standby 模式，并且将离子源放置在适当位
置。如果质谱仪必须关闭，请按以下说明操作。直至涡轮泵降速后再关闭低真空泵。

1. 完成或停止任何正在进行的扫描。

小心： 可能导致系统损坏。关闭系统前，先关闭样本流。

2. 关闭流向系统的样本流。

3. 在 Analyst® MD 软件中，如果硬件配置文件处于活动状态，则停用此文件。

4. 关闭此软件。

5. （如果需要）遵循下列步骤来对系统进行排气：

注释： 请在对真空接口执行全面清洁前、清洁 Q0 区域前和更换低真空泵油前，对系统进
行排气。更多信息请联系合格维护人员 (QMP) 或 FSE。

a. 按住 Vent 按钮三秒钟。

真空 LED 灯开始快速闪烁（快于抽气期间的闪烁速度）。涡轮泵逐渐降速。

b. 让系统排气 15 分钟，然后关闭低真空泵。

6. 关闭质谱仪便捷开关。

7. 从电源插座上断开质谱仪电源电缆。

8. （如果对系统进行排气）从电源插座上断开低真空泵电源电缆。
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硬件配置文件

借助硬件配置文件，软件可获知质谱仪和设备的配置情况以及它们与计算机的连接方式。可以
设置多个硬件配置文件，但任何时候只有一个配置文件处于激活状态。

在 Hardware Configuration Editor 中创建硬件配置文件时，必须对外围设备进行配置，使软
件能够与其通信。配置外围设备需要两个步骤：设置物理连接和配置软件，以实现与外围设备
的通信。软件安装完成后，每台外围设备所需的驱动程序也安装完成。将外围设备与计算机物
理连接后，就可以设置相应的配置信息。

每一个硬件配置文件必须包括一台质谱仪。在创建采集方法之前，确保该方法使用的所有设备
均包含在硬件配置文件中（包括注射泵）。当前硬件配置文件所配置的以及在 Add/Remove
Device Method 对话框中选定的设备在 Acquisition method 窗格中以图标显示。在创建采集
方法时，只有当前激活的硬件配置文件中已包含的外围设备才可以使用。

每一个硬件配置文件必须包括一台质谱仪。在创建采集方法之前，确保该方法使用的所有设备
均包含在硬件配置文件中。当前硬件配置文件所配置的以及在 Add/Remove Device Method 对
话框中选定的设备在 Acquisition method 窗格中以图标显示。在创建采集方法时，只有当前
激活的硬件配置文件中已包含的外围设备才可以使用。

有关为设备物理连接的设置信息，请参阅《外围设备设置指南》。关于受支持设备的列表，请
参阅 Analyst® MD 软件的《软件安装指南》。

创建硬件配置文件

用户可以创建多个硬件配置文件，但任何时候只有一个配置文件处于激活状态。

1. 在导航栏的 Configure 菜单下，双击 Hardware Configuration。

液相色谱串联质谱检测系统系统用户指南
73 / 267IVD-IDV-05-6996-ZH-B

8操作说明 — 硬件配置文件和项目



图 8-1 Hardware Configuration Editor 对话框

2. 在 Hardware Configuration Editor 对话框中双击 New Profile。
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图 8-2 Create New Hardware Profile 对话框

3. 在 Profile Name 字段中键入一个名称。

4. 单击 Add Device。
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图 8-3 Available Devices 对话框

在 Available Devices 对话框的 Device Type 字段中，Mass Spectrometer 为预设值。

5. 在 Devices 列表中选择合适的质谱仪，然后单击 OK 返回 Create New Hardware Profile
对话框。

6. 单击 Setup Device。

7. （可选）若要为质谱仪配置集成式注射泵，请在 Configuration 选项卡上，选中 Use
integrated syringe pump 复选框。
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图 8-4 配置注射泵的 Configuration 选项卡

8. （可选）若要为质谱仪配置分流阀，在 Configuration 选项卡上，选择 Use integrated
injector/diverter valve。

9. （可选）根据需要选择 Configuration 和 Communication 选项卡上的其他功能。

10. 单击 OK，返回到 Create New Hardware Profile 对话框。

11. 单击 Add Device，然后逐个添加并配置与质谱仪配套使用的设备。请参阅 添加设备至硬件
配置文件。

12. 在 Create New Hardware Profile 对话框中单击 OK。

13. 在 Hardware Configuration Editor 中单击要激活的硬件配置文件。

14. 单击 Activate Profile。

复选标记变为绿色。如果显示的是红色 x，则硬件配置文件激活出现问题。

提示！ 激活另一硬件配置文件之前无需停用当前硬件配置文件。单击硬件配置文件，然后
单击 Activate Profile。另一个配置文件自动失效。

15. 单击 Close。

添加设备至硬件配置文件

必须对设备进行配置，从而使软件可以与设备进行通讯。当软件安装完成时，每个设备所需的
驱动也安装完成。在设备与计算机完成物理连接后，对它们进行配置。

1. 打开 Hardware Configuration Editor。
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2. 在 Hardware Profiles 列表中，停用硬件配置文件。

3. 单击 Edit Profile。

4. 单击 Add Device。

5. 在 Available Devices 对话框的 Device Type 列表中选择设备，然后单击 OK。

图 8-5 Available Devices 对话框

6. 单击 OK。

7. 从 Devices 列表中选择设备，然后单击 OK。

8. 单击 Setup Device。

此时会打开包含设备配置值的对话框。

9. （可选）在 Communication 选项卡的 Alias 字段中，键入一个名称或其他设备标识符。

注释： 对于使用串行通讯的设备，确保选择的串行端口和与设备物理连接的串行端口相匹
配。

注释： Alias 字段也可以指的是 Name 框，而且可能会在 Alias 下的另一个选项卡上找
到。
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• 如果设备使用了一个 Serial Port 作为通讯接口，那么在 COM Port Number 列表中，
选择与设备相连的 COM 端口。

• 如果设备使用了 Ethernet 作为通讯接口，那么键入由管理员分配给设备的 IP Address
或使用地址的相应 Host Name。

• 如果设备使用 GPIB Board 作为通讯接口，那么不要改变 GPIB 板的设置。

设备的其他预设值很可能是合适的。不要更改它们。欲获知更多关于 Configuration 和
Communication 选项卡的信息，请参阅 Help。

10. 若要恢复设备预设值，在 Communication 选项卡上，单击 Set Defaults。

11. 若要保存配置，单击 OK。

12. 对每个设备需重复步骤 4 至步骤 11。

13. 在 Create New Hardware Profile 对话框中单击 OK。

14. 若要激活硬件配置文件，在 Hardware Configuration Editor 中单击硬件配置文件。

15. 单击 Activate Profile。

复选标记变为绿色。如果显示的是红色 x，则硬件配置文件激活出现问题。详情请参阅硬件
配置文件激活问题排解。

提示！ 激活另一硬件配置文件之前无需停用当前硬件配置文件。单击一个未激活的硬件配
置文件，然后单击 Activate Profile。另一个配置文件自动失效。

16. 单击 Close。

编辑硬件配置文件中的设备

1. 打开 Hardware Configuration Editor。

2. 在 Hardware Profiles 列表中，停用硬件配置文件。

3. 单击 Edit Profile。

4. 选择适用的设备，然后单击 Setup Device。

设备配置对话框打开。

5. 编辑配置然后单击 OK。

6. 单击 OK。

7. 单击 Activate Profile。

复选标记变为绿色。如果显示的是红色 x，则硬件配置文件激活出现问题。详情请参阅 硬
件配置文件激活问题排解。

提示！ 激活另一硬件配置文件之前无需停用当前硬件配置文件。单击一个未激活的硬件配
置文件，然后单击 Activate Profile。另一个配置文件自动失效。
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8. 单击 Close。

硬件配置文件激活问题排解

如果激活一个硬件配置文件失败，则会出现一个对话框，显示出配置文件中无法正常工作的设
备。设备可能因通信错误而无法激活。

1. 阅读产生的错误消息。根据错误消息，可能存在设备问题或通讯设置方式问题。

2. 核查设备是否已通电且已开启。

3. 核查分配给设备的串行通讯端口（COM 端口）或 IP 地址是否正确。

提示！ 在具有两个内置串行端口的计算机上，在串行端口扩展卡上的第一个端口通常为
COM3，即使电缆为 P1 电缆。

4. 核查设备的通讯设置（如拨码开关设置）是否设置正确以及是否与 Communication 选项卡
上的设置相匹配。

5. 关闭设备。

6. 等待 10 秒钟。

7. 打开设备。

在尝试再一次激活硬件配置文件之前，等待设备启动完毕。一些设备可能需要 30 秒或更长
的时间完成启动。

8. 激活硬件配置文件。

9. 如果问题仍然存在，删除失败配置文件，并创建一个新的配置文件。

10. 如果问题仍然继续存在，请联系技术支持。

项目和子项目

开始实验前，要先决定将实验相关文件保存在何处。使用每个实验的项目和子项目来更好地管
理数据和比较结果。比如，使用子项目来保存特定日期的结果。

关于子项目

子项目中所包含的是项目的文件夹子集。所有子项目必须包含相同的文件夹。子项目在整理数
据方面是非常有用的。比如，如果不同实验室使用相同的采集方法运行各种化合物的样本，就
可以使用子项目来保存每个实验室的结果，而将采集方法文件夹留在项目文件夹中。这样，采
集方法就可以同子项目或实验室一起使用。或者，如果样本运行期长达数周，就可以将每一天
的结果单独保存在一个子项目中。
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图 8-6 项目和子项目文件夹结构示例

创建项目和子项目

要使用一个项目内的子项目结构，请在创建项目后创建子项目结构。

1. 单击 Tools > Project > Create Project。
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图 8-7 Create New Project/Subproject 对话框

注释： 只有在项目最初创建了子项目的情况下，才能为该项目创建新的子项目。

2. 在 Project name 字段键入项目名称。

3. （可选）若要使用子项目，请选择所需的文件夹，然后用箭头按钮将它们移动到 Subproject
folders 列表。

4. （如果使用了子项目）在 Subproject name 字段中，为第一个子项目键入一个名称，或者
使用现有日期。

5. （可选）若想要所有新项目使用此项目和子项目文件夹组织，请选择 Set configuration
as default for new projects 复选框。

所有项目在创建时均会使用此文件夹配置。

6. 单击 OK。

创建子项目

子项目只能在一个存在子项目结构的项目中创建。

1. 在 Project 工具栏上，从 Project 列表中选择项目。

2. 单击 Tools > Project > Create Subproject。

3. 在 Subproject name 框中，为子项目键入一个名称，或者使用目前的日期。

4. 单击 OK。
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复制子项目

可从既有子项目的另一项目中复制子项目。如果复制的子项目中所包含的文件夹也存在于项目
文件夹中，那么软件会使用项目层级文件夹。

1. 单击 Tools > Project > Copy Subproject。

此时会显示 Copy Subproject 对话框。

2. 单击 Browse，导航至子项目来源。

3. 单击 OK。

4. 从 Source Subproject 列表中选择子项目。

5. 单击 Browse，导航至子项目目标位置.

6. 在 Target Subproject 字段中键入名称。

7. 单击 OK。

8. 执行以下操作之一：

• 要将所有文件夹和文件从 Subproject Source 复制到 Subproject Destination，请选
中 Copy Contents 复选框。

• 要仅将结构相同的文件夹复制到 Subproject Destination，请确保已取消选中 Copy
Contents 复选框。

9. 单击 Copy。

在项目和子项目之间切换

• 在软件的工具栏的项目列表中，单击所需的项目或子项目。

图 8-8 项目列表

本图中的项目列表显示了 API Instrument、Default 和 Example 文件夹。

已安装的项目文件夹

随软件一起安装了三个项目文件夹：API Instrument、Default 和 Example。
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API Instrument 文件夹

API Instrument 文件夹具有唯一性，且对于质谱仪的正常运行非常重要。API Instrument 文
件夹包含调谐和校正质谱仪所需的相关信息。此信息包括参数设置文件、参考文件、包含校正
和分辨率信息的仪器数据文件以及自动调谐期间所用的采集方法。API Instrument 文件夹还包
含有关手动调谐运行的数据文件，执行该手动调谐运行时使用的是 Start 按钮而非 Acquire
按钮。这些数据文件会自动保存到 Tuning Cache 文件夹内的 API Instrument 文件夹中，并
以它们的创建日期和时间命名。系统会定期自动清理 Tuning Cache 文件夹。

Default 文件夹

Default 文件夹包含新项目中存在的所有文件夹，并作为新项目的模板使用。

Example 文件夹

Example 文件夹包含样本方法和数据文件。用户可以利用实例数据文件来练习使用 Explore 或
Quantitate 模式。按照质谱仪类型和应用领域将实例文件分类整理到子文件夹中。
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每周运行 Verify instrument performance 选项或者在清洁质谱仪之后运行，从而可以确认系
统工作正常。通常，对于三重四极杆系统，除非系统失去真空状态，否则在三至六个月的时间
内应维持校正情况和分辨率。对于 QTRAP® 离子阱质谱仪 系统，分辨率也应保持三至六个月的
时间，但系统约需要每月校准一次。如果系统失去真空状态，则需要在使用系统前检查校正情
况和分辨率。欲获知更多关于调谐和校正的信息，请参阅《高级用户指南》和《手动调谐指导
手册》。

提示！ 定期进行维护工作，保证质谱仪在最佳情况下运行。

前提条件

• 喷雾稳定，而且使用了正确的调谐溶液。

• 配置了一个打印机。

所需材料

• 调谐溶液存放在与系统一起运送的 Standards Chemical Kit 中。如果需要，可以从 SCIEX
订购新的试剂盒。请参阅 校正离子和溶液。

• 5 mL、1 mL 或 250 µL 系列气密注射器。

• 红色 PEEK 样本管。

关于调谐和校正

调谐仪器是优化分辨率和仪器参数以使质谱仪达到最佳灵敏度和性能的过程。优化分辨率是指
调整峰宽和峰形。您可以自动或手动调谐和校正仪器。

小心： 潜在校正错误。如果温度变化超过 2 °C，分辨率和质量标定可能会受到影响。

提示！ 定期清洁 Q0 区，以尽量减少放电现象（在很短的时间内相关离子的灵敏度出现明显
降低）对四极杆的影响。请联系合格维护人员 (QMP) 或 FSE。

自动调谐：软件使用 Instrument Optimization 向导程序执行分辨率优化和质量校正。对于
LIT 仪器，还执行 MS3 优化。

手动调谐：可以手动执行许多仪器分辨率优化和校正。
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备份 API Instrument 文件夹

定期并在执行日常维护之后备份 API Instrument 文件夹。

• 复制 API Instrument 文件夹，粘贴至另一不同位置（最好粘贴至另一台计算机），然后重
命名该文件夹。在命名文件夹时，如果质谱仪的数量不止一台，则可以使用日期和质谱仪索
引。例如，API Instrument_instrument model3_010107

备份仪器参数

1. 在导航栏的 Tune and Calibrate 项下，双击 Instrument Optimization。

2. 在 Instrument Optimization 对话框中单击 File > Backup Instrument Settings Files。

3. 键入文件名，然后单击 Save。

4. 单击 Exit。

恢复仪器参数

1. 在导航栏的 Tune and Calibrate 项下，双击 Instrument Optimization。

2. 在 Instrument Optimization 对话框中单击 File > Restore Instrument Settings Files。

3. 导航至您想要恢复的仪器设置，然后单击 Open。

4. 单击 Exit。

自动调谐和校正

Instrument Optimization 是自动仪器调谐软件，可调谐四极杆和 LIT 模式，及执行质量校
正。对于四极杆模式来说，它可以调节分辨率 Offset。对于 LIT 模式而言，它可以优化 AF3
和 EXB。对 MS3 而言，它可以调节激发和隔离系数。选择以下仪器性能选项之一：

• Verify instrument performance：测试仪器性能，但保持仪器设置不变。在测试结束时生
成报告。您可以每周使用此选项检查仪器性能的好坏。

• Adjust mass calibration only：自动检查和调整质量校正。如果质量校正已更改，则软件
会予以校正。如果需要，可以每周或者每月对 LIT 仪器使用此操作，以检查和调整质量校
正。

• Adjust instrument settings：检查并调整仪器设置和质量校正。仪器设置将从当前设置更
新为最佳设置。如果仪器性能变差或峰形不佳，请使用此选项。只有有经验的用户才可调整
仪器设置。

注释： 旧 LIT 方法必须更新新设置。在高级 MS 选项卡中切换 LIT 速度，然后保存该方
法。
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• Reset selected scan modes to default values and adjust instrument settings：将仪
器值重置为出厂预设值。如果更换了仪器的主要组件或在初次安装后，选择此选项。只有现
场服务工程师才可使用此功能。

备份当前仪器参数，以防以后必须恢复它们。仪器参数的预设位置为 <drive>:\Analyst
Data\Projects\API Instrument\Instrument Optimization\Instrument Settings Backups\User
Created Backups。

验证仪器性能

以下程序描述如何验证或调整质谱仪的性能。有关使用其他仪器性能选项的信息，请参阅帮助。
请参阅校正离子和溶液。

前提条件

• 已在硬件配置文件中激活一个注射泵。如果注射泵未激活，则编辑硬件配置文件。请参阅
编辑硬件配置文件中的设备。

• 已选中 API Instrument 文件夹。

1. 在导航栏 Tune and Calibrate 项下，双击 Manual Tuning。

2. 启动注射泵，在 Duration 字段中键入 5，然后运行校准方法。确认总离子色谱图 (TIC)
是稳定的，以及相关的峰出现在谱图中。
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图 9-1 稳定 TIC 和目标峰值的示例

3. 在导航栏 Tune and Calibrate 项下，双击 Instrument Optimization。

Instrument Optimization 对话框打开。

4. 单击 Verify instrument performance。

5. 单击 Next。

6. 单击 Approved Tuning。

7. 单击 Next。
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8. 从列表中选择一个 Tuning Solution。

根据所选溶液，不同的模式可供选用：
a. 单击一种极性。

b. （如适用）在 Quad 部分单击 Q1 和 Q3。

c. （如适用）单击所需的扫描速度。

d. （如适用）在 LIT 部分单击扫描速度。

e. （如适用）在 MS/MS/MS 部分单击 Excitation。

9. 单击 Next。

10. 如果 Select a mode 页面打开，则选择 Automatic。

11. 单击 Next。

12. 单击 GO。

Verifying or Adjusting Performance 对话框打开。完成此过程之后，Results Summary
打开。欲了解更多信息，请参阅帮助。

13. 如果适用（则取决于所选的选项）。出现提示时，更改不同扫描类型和极性所对应的溶液。

Verifying or Adjusting Performance 对话框的说
明

左上角显示的是正在进行调谐的仪器部分。

当前谱图显示了当前扫描、通过软件选择的最佳扫描或在交互模式下查看软件结果时采用当前
参数值的扫描的谱图。

右上图中的 Instrument Optimization Decision Plots（仪器优化决策图）动态显示了当前正
在优化参数的强度-电压曲线。

Results Summary

Results Summary 是 Instrument Optimization 向导所作仪器设置更改的记录。
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图 9-2 Results Summary

Results Summary 包括数据文件和仪器设置备份的位置，以及优化过程中的逐步变化和结果。

Results Summary 还会显示验证报告。该报告包含所验证扫描模式的各相关质量的质谱快照。
谱图标有目标质量、质量的发现位置、质量偏移、峰宽度以及峰强度。该谱图可用作峰形或扫
描模式性能的直观记录。谱图下面为结果汇总表。

Results Summary 自动保存在以下路径中：<drive>:\Analyst Data\Projects\API
Instrument\Data\Instrument Optimization\yyyy-mm-dd\results.doc，其中 yyyy-mm-dd 是
指报告创建日期。用户可以打印 Results Summary，或打开之前保存的 Results Summary。

恢复 API Instrument 文件夹

定期并在执行日常维护之后备份 API Instrument 文件夹。

1. 重命名当前 API Instrument 文件夹。

2. 复制备份文件夹至 Projects 文件夹。

3. 将备份文件夹更名为 API Instrument。
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若要针对特定化合物调谐仪器参数，建议采取以下步骤。用四种化合物的混合物来说明该程序
的步骤。在使用相应化合物进行所关注的分析时，用户将必须采用同样的程序。

本部分介绍如何：

• 使用 Compound Optimization 向导自动优化分析物。

• 在输注和流动注射分析 (FIA) 之间进行选择。

• 优化参数：

• 如果选择了输注分析，则使用输注方法来优化化合物相关参数。

• 如果选择了 FIA 分析，则使用 FIA 来优化化合物和离子源相关参数。

本指导手册以米诺地尔、甲苯磺丁脲、利血平和利血胺这四种化合物为例。也可以使用其他可
用化合物，但必须适当调整方法。

用户还可以手动优化化合物。请参阅操作说明 - 手动化合物优化。

前提条件

• 对质谱仪进行了调谐和校正。

• （对于 FIA 分析）有一个采集方法模板可用。

• （对于 FIA 分析）已连接 LC 泵和自动进样器，并在硬件配置文件中进行配置。

• 已在硬件配置文件中配置一个集成式注射泵。

• 所有需要的外围设备，包括 LC 组件（如果需要）都已在硬件配置文件中配置。
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所需材料

• 四种化合物的混合物 (10 ng/mL)，包括利血平、米诺地尔、甲苯磺丁脲和利血胺。该溶液
可用于输注和流动注射分析 (FIA)。浓度取决于系统。使用由 49.9% 乙腈、50% 去离子水
和 0.1% 甲酸构成的溶液作为稀释剂。

注释： 这是用于演示目的的示例混合物。在开发应用程序时，用户将在合适的溶剂中创
建自己的化合物。推荐使用单一化合物溶液。当混合化合物时，请确保化合物不会相互
干扰或具有相同的分子量。

• 一个注射器，最好是 1.0 mL 注射器。

• （对于 FIA 分析）流动相：1:1 乙腈:水 + 2 mM 乙酸铵 + 0.1% 甲酸。

注释： 用户可根据化合物的实验属性选择不同的流动相。

• 液相色谱泵和自动进样器。

• （对于 FIA 分析）自动进样器进样瓶。

关于自动优化

自动优化首先检测是否存在化合物。逐渐增大或减小不同离子路径电压参数，确定每一离子的
最大信号强度（Q1 扫描）。在优化过程中生成和显示了一个文本文件。这一文件记录了执行的
多种实验以及每一参数的最优值。此外，还生成了包含所有已执行实验的文件夹，以 Explore
模式打开数据文件夹即可找到此文件夹。对于执行的每个实验，还生成了一种采集方法，将其
保存在 Acquisition Method 文件夹中。

在优化过程中，选择要选定前体离子及相应产物离子的方式。

进样类型

输注

输注是指使用注射泵以低流速使样本连续流入离子源。在输注的优化过程中，软件可以选择前
体和产物离子，并优化去簇电压、碰撞能量和碰撞池出口电压。逐渐增大或减小离子路径电压
参数，确定前体和产物离子的最大信号强度。

使用输注优化，仅以低得多的流速而非 LC-MS/MS 分析过程中使用的流速对化合物相关参数进
行优化。

流动注射分析

流动注射分析是指使用液相色谱通过自动进样器将样本注入质谱仪。在使用流动注射分析进行
优化的过程中，执行了多次样本注射，因为在注射间隙要对多种离子源或化合物相关参数进行
更改。流动注射分析中的化合物优化是通过连续执行循环实验来优化参数的。首先对一个化合
物相关参数进行优化，接着是下一个化合物相关参数。FIA 通过每个值注射一次的方式对离子
源相关参数进行优化。
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必须再使用至少两个流动注射分析循环来限制化合物参数范围。使用液相色谱，在较高的流速
下，用流动注射分析优化方法来优化化合物相关和离子相关参数。

表 10-1 进样方法间的差异

典型流速范围参数所需设备方法

5 µL/min 至 25 µL/
min

化合物相关注射泵输注

25 µL/min - 1000 µL/
min

离子源和化合物相关液相色谱泵和自动进样器流动注射分
析

在优化过程中，生成一个文本文件，并显示出来。这一文件记录了执行的多种实验以及每一参
数的最优值。还生成一个包含所有数据文件的文件夹。对于执行的每个实验，还生成一种采集
方法，将其保存在 Acquisition Methods 文件夹中。

采用输注方式对分析物自动优化

在此部分中，用户将会进行采用输注方式的 MS/MS 自动优化，其中前体离子已知，产物离子未
知。

确认化合物的存在

在继续自动优化之前确认目标化合物的存在

1. 在 Analyst® MD 软件中，新建一个项目。

2. 激活硬件配置文件。

3. 准备样本：

a. 将化合物溶液吸入注射器，并排净注射器中的空气。

b. 使用带有特殊接头的导管将注射器连接至质谱仪。

c. 将注射器装入集成式注射泵。

4. 以 5 µL/min 至 10 µL/min 的速度输注溶液中的化合物。

5. 在导航栏 Tune and Calibrate 项下，双击 Manual Tuning。

6. 在方法列表字段中，单击 Syringe Pump Method。

7. 在 Syringe Pump Method Properties 选项卡上，键入适当的参数值。请参阅表 10-2。
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表 10-2 Syringe Pump Method Properties 选项卡

典型值参数

注射器相关，1.0 mL 注射器为 4.610 mm。注射器直径

5 至 10流速

µL/min。单位

图 10-1 Syringe Pump Method Properties 选项卡

8. 单击 Start Syringe Pump

9. 从方法列表中单击 MS Method。

10. 在 MS 选项卡上，键入表 10-3 中显示的参数。

表 10-3 MS 选项卡

数值参数

Q1 MS (Q1)扫描类型

200Start (Da)

700Stop (Da)

200扫描速度 (Da/s)（如果可以使用）

3持续时间 (min)

11. 单击 Start。

12. 等到在左侧显示出平滑的总离子色谱图，以及在右侧显示出峰后，单击 Stop。

13. 选择 MCA 复选框。

14. 在 Cycles 字段中键入 10。

15. 单击 Start。

当十次扫描完成后，图应该显示出四种化合物作为离子的质量数。
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注释： 化合物的强度应当比最小噪声峰值要高的多，但不应高至观察不到任何噪声峰。在
第一种情况下，峰可能并不代表一种真正的化合物。在第二种情况下，化合物浓度可能过
高，以致软件无法正确优化。

图 10-2 化合物离子

执行采用输注方式的自动 MS 和 MS/MS 优化，其中前体离子已
知，产物离子未知

MS/MS 分析的自动优化可优化一个或多个多反应监测离子对的某些化合物相关参数。该软件检
出相关离子，然后优化化合物相关参数，以获得针对此化合物的最大灵敏度。该软件升高碰撞
能量，然后选择满足所有产物离子选择标准的最强碎片离子。

如果最初的 Q1 扫描信号过高，该软件会尝试降低 CEM 以保持离子在检测器范围之内。如果降
低 CEM 后信号仍然过高，则该过程停止并显示错误消息。稀释溶液，然后重新启动优化。一定
要冲洗输注管路。存储最后一次定量优化的参数。

1. 确保注射泵中所装溶液的浓度正确无误，且注射泵已启动。如果集成注射泵可用并已启动，
则注射泵状态 LED 指示灯会闪烁。

开始优化化合物之前，必须在 Manual Tune 窗口中启动注射泵。

2. 在导航栏 Tune and Calibrate 下，双击 Compound Optimization。

3. 在 Instrument Settings 页面 Inlet 部分，单击 Infusion。

4. 在 Mass Spectrometer 部分单击 MS/MS Analysis。

5. 单击 Next。
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6. 在 Ions to use in MS/MS Analysis 页面上，选择适当的参数值。请参阅表 10-4。

表 10-4 要用于 MS/MS Analysis 页面的参数示例

数值参数

2.500MW 离子：搜索窗口

单位分辨率

正或负，取决于目标化合物的性质极性

自动选择产物离子

单位分辨率

注释： 该优化算法会在指定的搜索窗口寻找最强峰。如果此窗口中的最强峰不是所关注的
质量，则说明软件优化了错误的离子。

7. 单击 Auto Select 选项旁边的 Criteria。

8. 在 Product Ion Auto Selection Criteria 对话框中，键入适当的参数。请参阅表 10-5。

表 10-5 Product Ion Auto Selection Criteria 对话框参数示例

描述数值参数

要优化的碎片峰的数目。该算法在 MCA 模式下增加碰
撞能量的同时还将生成产物离子扫描谱图。本例中，
该算法会从谱图中取三个最强的碎片离子，然后仅对
这些碎片继续 MS/MS 优化。

对于未知化合物，则选择更多峰。

3来自最强（峰）

每一前体离子（目标化合物）的碎片离子数目自动包
含在采集方法中。指定数字定义了该方法中每种目标
化合物应包含的 MRM 离子对的数量。优先顺序基于碎
片离子的强度。

与一相比，二是更好的起始值，因为通常需要两个产
物离子进行定量。以三开始，以防两个最好的峰之中
任何一个出现问题。返回，第三个也已确定。

对于未知化合物，则选用更多峰，以防干扰。

2建立最终方法 -
使用（最强峰）

Da 值定义了前体离子周围的排除窗口，这样就不会选
中落在此窗口中的碎片离子进行多反应监测优化。例
如，对于一个 m/z 为 500 的前体离子，如果用户键
入 ± 5 Da，则 m/z 在 495 - 505 范围内的碎片离
子都会被排除。这可以防止前体离子被当作产物离子
优化。

20.000排除 ±（前体离
子 m/z，Da）范
围内的产物离子
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表 10-5 Product Ion Auto Selection Criteria 对话框参数示例 （续）

描述数值参数

需考虑优化的最小碎片质量。使用此选项可缩小或扩
大前体离子质量中需考虑的碎片离子窗口。

60.000产物离子的最小
质量 (Da)

需考虑产物离子计数的最小数目。100.000产物离子 (cps)
阈值

9. 单击 OK，将更改保存到选择标准。

10. 单击 Next。

11. 在 Target Components 对话框中，键入适当的参数值。请参阅表 10-6。

注释： 对于每个化合物或离子对，化合物的名称必须是唯一的。

表 10-6 Target Compounds 对话框参数示例

数值字段目标化合物

利血平化合物名称利血平

609.3MW (Da)*

1电荷数

米诺地尔化合物名称米诺地尔

210.2MW (Da)*

1电荷数

甲苯磺丁脲化合物名称甲苯磺丁脲

271.1MW (Da)*

1电荷数

利血胺化合物名称利血胺（内标）

635.3MW (Da)*

1电荷数

*键入确切的离子质量。

12. 单击 Finish，开始优化过程。

屏幕上显示两个窗口，一个文本文件窗口和一个采集窗口。用户可能需要对其中一个最小化
以便查看另一个窗口。正在运行的实验显示在采集窗口的顶部。X-轴显示了每个实验正在优
化的参数。随着结果的生成，文本文件窗口也会更新。
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优化完成后，会创建一个多反应监测采集文件，并将其命名为
[compound]_QOpt_FinalMRM_Pos.dam，其中 [compound] 是 Target Components 页面的第
一个化合物。

查看优化结果

在优化结束时，经过优化的参数会保存在一种采集方法中。将优化过程中生成的所有 dam 和
wiff 文件分别保存在项目中的 Acquisition Methods 文件夹中和 Data 文件夹的子文件夹中。
使用该化合物的名称和日期生成该子文件夹的名称。

1. 完成优化后，打印出包含每种化合物的已优化参数的文本文件。

2. 单击 File > Open，然后选择 Reserpine_QOpt_FinalMRM.POS.dam 文件。

3. 对文本文件中的值与 dam 文件中的相应值进行比较。

4. 检查以下文件夹中的内容：

• Data：浏览优化过程中执行的所有运行。对 wiff 文件与此方法或打印参数中的已优化
值进行比较。

• Acquisition Method：优化过程中创建的 Reserpine_QOpt_FinalMRM.POS.dam 文件和其
他 dam 文件。

• Log：优化过程中显示的报告文件 (rtf)。

采用流动注射分析的分析物自动优化

前提条件

• 识别化合物的离子并保存基本采集方法。

• 在基本采集方法中添加自动进样器和 LC 泵。要使用 FIA 进行优化，这些设备在硬件配置
文件中必须处于活动状态。

• 基于 Reserpine_QOpt_FinalMRM.POS.dam 文件创建一个 LC-MS/MS 采集方法，并为新方法
命名。

注释： 虽然流动注射分析可用于优化化合物相关的参数，但是通常不采取这种做法，因为需
要周期数才能获得最优参数值。

1. 将四种化合物混合稀释液放入自动进样器。

需要足够的样本来检查每个参数的每个变量，并留出剩余样本。例如，对于 300°C、400°C
和 500 °C 的运行温度，如果注射量为 10 µL，则需要超过 30 µL（3 × 10 µL 注入量）。

2. 确认方法中选择了 LC Sync。

注释： 在 LC Sync 模式下，质谱仪与 LC 系统的操作配合，确保正确采集数据。
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图 10-3 选择了 LC Sync 的采集方法

3. 确保将离子源和气体参数设置为合理水平，以防止质谱仪在优化时发生污染。请参阅离子源
优化。

4. 将水平千分尺设置为 5。

5. 在离子源上针对流速设置垂直千分尺。作为起始点，使用以下表格中的参数：

表 10-7 离子源垂直参数

初始垂直参数流速

10 mm1 µL/min 至 20 µL/min

5 mm20 µL/min 至 250 µL/min

2 mm250 µL/min 至 500 µL/min

0 mm500 + μL/min

6. 设置 HPLC 系统的数值，并使用 10 µL 的自动进样器注射量（示例）。使用与输注实验相
同或更低的浓度。

对于无色谱柱的等度洗脱，必须对液相色谱泵进行配置。质谱和液相色谱时间必须相同，以
收集正确的数据。

使用的流速和流动相百分比应当取决于使用的液相色谱柱、一般色谱和目标化合物洗脱时的
近似流动相浓度。

7. 在导航栏 Tune and Calibrate 下，双击 Compound Optimization。

8. 根据将要使用的 LC 系统，在 Instrument Settings 页面上，键入适当的参数值。请参阅
表 10-8。
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表 10-8 仪器设置参数示例

数值参数

流动注射分析Inlet

特定自动进样器Rack Code

特定自动进样器Rack Position

10 µL（容积示例）Injection Volume

MS/MS 分析Mass Spectrometer

9. 选择适当的默认采集方法。

10. 单击 Next。

11. 确保未选中 Int.Std.复选框。

选中该复选框会指示哪一多反应监测对应内标。在优化过程中未对内标进行优化。

12. 在 Resolution 部分中，在 Q1 Resolution 和 Q3 Resolution 字段中选择 Unit。

图 10-4 Q1 和 Q3 分辨率字段

13. 单击 Next。
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14. 在 FIA Source Parameters 页面上，键入规格范围内低于或高于原始值的数字。

确保不要在任何设置中设置过低的值，以便保持系统清洁。参阅表 10-9了解可用作起始点
的参数。

提示！ 先键入数值，然后选中该复选框。

表 10-9 流动注射分析源参数页面的参数示例

优化的值选中优化复选框？参数

20;40;55是Curtain Gas

—否Collision Gas

1500;2000;3000;4000;5000是IonSpray
Voltage

300;400;500;600;700是Temperature

40;50;60;70;80;90是Ion Source Gas
1

40;50;60;70;80;90是Ion Source Gas
2

15. 选择 Replicate Injection for each Parameter 旁边的 1 或 2。

根据此处的规格计算注射的总数和总样本量。记录所需的总样本量。根据正在优化的每个参
数有多少变量，样本量可能较高，因为每个变量都是一种单独的方法。
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图 10-5 Replicate Injection for each Parameter 字段示例

16. 单击 Next。

17. 在每个分析物的 FIA Compound Parameters 页面上，使用提供的参数值示例作为起始点。
请参阅 表 10-10。

注释： 表 10-10 中的值是建议值。欲了解更多信息，请参阅帮助。

表 10-10 FIA Compound Parameters 页面示例

优化的值选中优化复选框？参数

60;80;100;120;200是Declustering
Potential

—否Entrance
Potential
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表 10-10 FIA Compound Parameters 页面示例 （续）

优化的值选中优化复选框？参数

20;30;40;50;70;80;100是Collision
Energy

2;4;6;8;10;12是Collision Cell
Exit Potential

注射总数和相关样本量会自动更新。与离子源参数（需要为每值每次重复注射一次）相比，
化合物相关参数只需要为每个参数注射一次。为每个参数执行循环实验。在一次注射内，这
些值在扫描中依次交替。

注释： 请勿输入过多数值。否则会影响对参数的准确评价。

18. 使用 Compound 列表，移动至另一个化合物并键入要优化的参数。

19. 重复第 18 步，直到所有化合物的所有参数均已提供。

20. 将优化持续时间 键入 Mass Spec.Duration字段。

注释： 此值应至少是每一次注射需要的时长。

图 10-6 Mass Spec.Duration 字段示例

21. 单击 Finish，开始优化过程。

软件可以优化指定的离子源和化合物相关参数，获得针对此化合物多反应监测离子对的最大
灵敏度。当软件进行优化操作时，会自动创建一个 Compound Optimization 报告。
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22. 要获得经过优化的参数，请重复这一例行程序。

注释： 通常情况下，必须再次使用一个流动注射分析周期缩小离子源和气体参数。

23. 打开名为 *_FIA_sample_1 的最终优化流动注射分析方法。

注释： 软件会生成几种采集方法。

24. 使用一个简单的名称保存这种方法。
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采集方法包含实验和周期。使用 Acquisition Method Editor 编辑器为仪器和设备创建周期和
实验序列。

我们建议，只有精通方法开发的用户才可创建或修改采集和定量方法。有关角色和安全的更多
信息，请参阅《实验室主管指南》。

使用采集方法编辑器创建采集方法

提示！ 如果用户正在从现有的文件创建一个新采集方法文件，那么可能使用采集方法中的部
分或全部的外围设备方法。

只有在激活的硬件配置文件中配置的设备才会在 Acquisition method 窗格中显示。此外，添
加到硬件配置文件中的任何设备均必须添加到现有的采集方法中。有关设备的更多信息，请参
阅《外围设备设置指南》。

1. 确保含有质谱仪和外围设备的硬件配置文件处于激活状态。

2. 在导航栏的 Acquire 菜单下，双击 Build Acquisition Method。

3. 在 Acquisition Method Properties 选项卡上选择 Synchronization Mode。

4. （可选）选中 Auto-Equilibration 复选框，然后键入所需的平衡时间（单位为分钟）。

5. 单击 Acquisition method 窗格中的 Mass Spec 图标。

6. 选择 MS 选项卡上的 Scan type。

7. 根据需要在字段中键入值。请参阅参数。

8. 在Advanced MS 选项卡上，根据需要在字段中键入值。

9. 在 MS 选项卡中，单击 Edit Parameters。

10. 在 Source/Gas 选项卡上，根据需要在字段中键入值。

11. 在 Compound 选项卡上，根据需要在字段中指定值，然后单击 OK。

12. 单击设备图标，然后选择设备的参数。

13. 添加任何额外的时段和实验。请参阅添加实验和添加时段。

14. 单击 File > Save。

关于 LC 方法

用一台外围设备（如 LC）创建一个采集方法，包括为该设备提供工作参数。如果用现有文件创
建一个新采集方法，则可以使用原采集方法中的部分或全部外围设备方法。
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创建质谱方法

使用 Acquisition Method Editor 创建一个质谱仪采集方法。根据质谱仪的配置类型和所选择
的扫描类型的不同，可以有不同的字段和选项。键入参数时，Acquisition Method Editor 会
对设置进行验证。
创建下列方法中的某一种，然后在创建并提交批次中使用此方法采集数据：

• 创建一个使用 Q1 MS 扫描类型的采集方法

• 创建一个使用 Q1 MI 扫描类型的采集方法

• 创建一个使用 MRM 扫描类型的采集方法

创建一个使用 Q1 MS 扫描类型的采集方法

按以下程序创建一个使用 Q1 MS 扫描的方法。对于扫描范围内的每个离子都会检测记录其离子
强度。

前提条件

• 确保包含质谱仪和注射泵的硬件配置文件处于激活状态。

• 在软件工具栏上，确保选中适当的项目。

1. 在导航栏的 Acquire 菜单下，双击 Build Acquisition Method。

方法编辑器会根据当前激活的硬件配置文件显示一个方法模板。

2. 在 Acquisition method 窗格中，单击 Acquisition Method。

3. 在 Acquisition Method Properties 选项卡的 Synchronization Mode 列表中，确保已选
中 No Sync。有关同步模式的更多信息，请参阅 Help。

4. 在 Acquisition method 窗格中，单击 Mass Spec 图标。

5. 在 MS 选项卡的 Scan type 列表内选择 Q1 MS (Q1)。

6. 在 Polarity 组中单击 Positive。

7. 清空被选中的 Center/Width 和 Parameter Range 复选框。

8. 在质量范围表中键入以下数值：
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图 11-1 MS 选项卡参数值

数值示例字段

200Start (Da)

700Stop (Da)

2.5Time (sec)

200扫描速率 (Da/s)

3持续时间 (min)

9. 单击 Advanced MS 选项卡。请注意，该扫描模式被设为 Profile，且步长为 0.1。

图 11-2 Advanced MS 选项卡

在本例中，四极杆 (Q1) 正在扫描一个 500 Da 的范围，扫描步长为 0.1Da。因此，扫描整
个质量范围共有 5000 步。如果扫描时间为 2.5 秒，则每一步的驻留时间为 0.5 ms。如果
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要按照标准校正程序进行一次 Q1 或 Q3 扫描，这是通常情况下最快的速度。如果要使 Q1
或 Q3 的扫描速度更快，则需要对质量校准作适当考虑。

注释： 步长和扫描时间用于控制每一步扫描的驻留时间。驻留时间是指每一步扫描时采集
信号所花费的时长。

10. 在 MS 选项卡中，单击 Edit Parameters。

11. 在 Parameter Table 对话框中单击 Source/Gas 选项卡。

12. 键入以下数值：

表 11-1 “Source/Gas” 选项卡参数

典型值离子源/气体参数

20Curtain Gas (CUR)

5000IonSpray Voltage (IS)

0Temperature (TEM)

15Ion Source Gas 1 (GS1)

0Ion Source Gas 2 (GS2)

13. 单击 Compound 选项卡，然后将 Declustering Potential (DP) 设为 90，使 Entrance
Potential (EP) 保持 10 不变。

数值 90 可能不是质谱仪的最佳值，但它是一个较好的 DP 起始值。

14. 单击 OK。

15. 在 Acquisition method 窗格中，单击 Harvard Syringe Pump 图标。

16. 在 Syringe Pump 选项卡上编辑注射泵方法，使之包含 Syringe Diameter、Flow Rate 和
Unit。

图 11-3 Harvard Syringe Pump Method Properties 选项卡

17. 保存采集方法。

下一步：使用采集方法采集数据以进行初步分析。若要创建和提交批次，请参阅 创建并提
交批次。
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创建一个使用 Q1 MI 扫描类型的采集方法

按以下程序创建一个使用 Q1 MI 扫描的方法。仅对指定质量返回离子强度。

前提条件

• 确保包含质谱仪和注射泵的硬件配置文件处于激活状态。

• 在软件工具栏上，确保选中适当的项目。

1. 在导航栏的 Acquire 菜单下，双击 Build Acquisition Method。

方法编辑器会根据当前激活的硬件配置文件显示一个方法模板。

2. 在 Acquisition method 窗格中，单击 Acquisition Method。

3. 在 Acquisition Method Properties 选项卡的 Synchronization Mode 列表中，确保已选
中 No Sync。有关同步模式的更多信息，请参阅 Help。

4. 在 Acquisition method 窗格中，单击 Mass Spec 图标。

5. 在MS 选项卡的 Scan type 列表中，选择 Q1 Multiple Ions (Q1 MI)。

6. 在 Polarity 组中单击 Positive。

7. 在质量范围表中键入以下数值：

图 11-4 MS 选项卡参数值

数值字段

609Q1 质量 (Da)

100时间 (ms)

8. 单击 Edit Parameters。

9. 在 Parameter Table 对话框中单击 Source/Gas 选项卡。
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10. 键入以下数值：

表 11-2 “Source/Gas” 选项卡参数

典型值离子源/气体参数

20Curtain Gas (CUR)

5000IonSpray Voltage (IS)

0Temperature (TEM)

15Ion Source Gas 1 (GS1)

0Ion Source Gas 2 (GS2)

11. 单击 Compound 选项卡，然后将 Declustering Potential (DP) 设为 90，使 Entrance
Potential (EP) 保持 10 不变。

数值 90 可能不是质谱仪的最佳值，但它是一个较好的 DP 起始值。

12. 单击 OK。

13. 在 Acquisition method 窗格中，单击 Harvard Syringe Pump 图标。

14. 在 Syringe Pump 选项卡上编辑注射泵方法，使之包含 Syringe Diameter、Flow Rate 和
Unit。

图 11-5 Harvard Syringe Pump Method Properties 选项卡

15. 保存采集方法。

后续步骤：您已经创建了一个采集方法，现在就可以用它来创建并提交一个批次。若要创建
和提交批次，请参阅 创建并提交批次。

创建一个使用 MRM 扫描类型的采集方法

按以下程序创建一个使用 MRM 扫描的方法。该扫描用于定量用途。MRM 扫描可用于确定样本中
的某种化合物有多少数量。它目前被用于药代动力学分析，并且在应用市场和筛选用途方面的
运用也越来越多地被采用。
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前提条件

• 确保包含质谱仪和注射泵的硬件配置文件处于激活状态。

• 在软件工具栏上，确保选中适当的项目。

1. 在导航栏的 Acquire 菜单下，双击 Build Acquisition Method。

方法编辑器会根据当前激活的硬件配置文件显示一个方法模板。

2. 在 Acquisition method 窗格中，单击 Acquisition Method。

3. 在 Acquisition Method Properties 选项卡的 Synchronization Mode 列表中，确保已选
中 No Sync。有关同步模式的更多信息，请参阅 Help。

4. 在 Acquisition method 窗格中，单击 Mass Spec 图标。

5. 在 MS 选项卡的 Scan type 列表内选择 MRM (MRM)。

6. 在 Polarity 组中单击 Positive。

7. 在质量范围表中键入以下数值：

图 11-6 MRM 扫描类型

表 11-3 质量范围和驻留时间

时间 (ms)Q3 质量 (Da)Q1 质量 (Da)

100397.2609

8. 在 MS 选项卡中，单击 Edit Parameters。

9. 在 Parameter Table 对话框中单击 Source/Gas 选项卡。

10. 键入以下数值：
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表 11-4 “Source/Gas” 选项卡参数

典型值离子源/气体参数

20Curtain Gas (CUR)

选择 MediumCollision Gas (CAD)

5000IonSpray Voltage (IS)

0Temperature (TEM)

15Ion Source Gas 1 (GS1)

0Ion Source Gas 2 (GS2)

11. 单击 Compound 选项卡，然后将 Declustering Potential (DP) 设为 90，使 Entrance
Potential (EP) 保持 45 不变。

12. 单击 OK。

13. 在 Acquisition method 窗格中，单击 Harvard Syringe Pump 图标。

14. 在 Syringe Pump 选项卡上编辑注射泵方法，使之包含 Syringe Diameter、Flow Rate 和
Unit。

图 11-7 Harvard Syringe Pump Method Properties 选项卡

15. 保存采集方法。

后续步骤：您已经创建了一个采集方法，现在就可以用它来创建并提交一个批次。若要创建
和提交批次，请参阅 创建并提交批次。

向采集方法中添加或从中删除设备

有了 Acquisition Method Editor，用户可以通过添加或删除 HPLC 外围设备方法来自定义采
集方法。如果所需的设备图标不在 Acquisition Method Browser 窗格内，那么仅当其包含在
当前激活的硬件配置文件中时才能添加外围设备。

注释： LC 设备的可用参数视不同的生产厂商而有所不同。
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添加或删除 LC 设备

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，在 Acquisition method
窗格中，右键单击 Acquisition Method，然后单击 Add/Remove Device Method。

2. 通过选择或清空设备方法旁边的复选框来添加或删除设备方法。

3. 单击 OK。

4. 如果选择了 LC 设备，则在 Acquisition Method Properties 选项卡中为 Synchronization
模式选择 LC sync。

修改 LC 泵属性

修改方法中的每一台设备，使之在方法中正常发挥作用。

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，单击 Acquisition method
窗格中的 LC 设备图标。

LC Pump Gradient 选项卡在 Acquisition Method Editor 窗格中打开。

图 11-8 SCIEX DX 泵参数

2. 根据实验要求编辑 LC 泵方法。

3. 保存方法。

设置自动进样器属性

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，单击 Acquisition method
窗格中的 Autosampler 设备。

Autosampler Properties 选项卡随即在 Acquisition Method Editor 窗格中打开。
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图 11-9 SCIEX 自动进样器

2. 如有必要，可编辑加注和清洗详情。

3. 保存方法。

设置柱温箱属性

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，在 Acquisition method
窗格中单击 Column Oven 设备。

Column Oven Properties 选项卡随即在 Acquisition Method Editor 窗格中打开。

图 11-10 SCIEX 柱温箱

2. 键入柱温箱或柱温箱容腔的温度，单位为摄氏度。

3. 保存文件。

配置集成式注射泵

该程序适用于集成式注射泵。

1. 确认在硬件设备配置文件中选中集成式注射泵。

2. 单击 Acquisition method 窗格中的 Syringe Pump 图标。

Syringe Pump Method Properties 选项卡会在 Acquisition Method Editor 中打开。
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图 11-11 Syringe Pump Properties 选项卡

3. 在 Syringe Diameter (mm) 字段中键入注射器直径。

4. 在 Flow Rate 字段中键入流速。

5. 在 Unit 列表中选择流量单位。

设置分流阀属性

切换阀可作为切换阀或进样阀使用。

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，在 Acquisition method
窗格中单击 Valve 图标。

Valve Properties 选项卡随即在 Acquisition Method Editor 窗格中打开。
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图 11-12 集成式 Falco 阀

2. 必要时，可更改预设位置名称。切换阀有时被用来将溶剂流切换至废弃物或另外的色谱柱。
预设位置名称为 A 和 B。

• 在 Change Position Names 列表中选择一个位置。

• 在 Change Position Names 列表中，将预设名称 A 和 B 重新命名为 Inject 和 Divert，
或者 Column 和 Waste，具体取决于阀门的角度。

3. 在 Total Time (min) 列中，单击某个单元格，然后键入阀门保持在该位置的总时间。

4. 在 Position 列中单击某个单元格，然后在 Position 列表中选择阀门位置。

5. 对采集期间所需的每一次阀门切换，重复步骤 3和步骤 4。

6. 保存文件。
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设置二极管阵列检测器属性

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，在 Acquisition method
窗格中单击 Diode Array Detector (DAD) 图标。

DAD Method Editor 选项卡随即在 Acquisition Method Editor 窗格中打开。

图 11-13 DAD Method Editor 选项卡

2. 执行以下操作之一：

• 若要扫描 1 到 5 个波长，可在 Operating Mode 部分单击 Signal Data，然后编辑数
据要求。

• 若要扫描一个波长范围，可在 Operating Mode 部分单击 Spectral Data，然后编辑数
据要求。

3. 保存文件。

设置模数转换器属性

1. 在 Acquisition Method Editor 打开了一个方法文件的情况下，单击 Acquisition method
窗格中的 Analog to Digital Converter (ADC) 图标。

Analog/Digital Convertor Properties 选项卡随即在 Acquisition Method Editor 窗格
中打开。
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图 11-14 Analog to Digital Converter Properties 选项卡

2. 在 Sample 部分的 Rate (pts/sec) 字段中键入流速。

注释： 间隔时间与流速彼此成正比。更改流速时，软件会自动计算间隔时间。

3. 请按以下方式设置通道详情：

• 在 Channels 字段中，单击通道名称，然后勾选名称旁边的复选框，将其包含在方法内。

• 在 Interpreted Value @ Full Scale 字段中键入相应值。

• 在 Interpreted Unit 字段中键入相应的单位。

可用通道数是在硬件配置文件中设置 ADC 时指定的。

4. 保存文件。

更改采集方法

在 Acquire 模式下，用户可以向现有采集方法中添加或者从中删除时段和实验。

时段

一个时段中可以包括一个或多个环回实验。在一个多时段采集方法中，实验要进行一定的时间
量，然后再切换到另一系列实验。在知道 LC 运行中化合物的洗脱时间的情况下，时段是很有
用的。质谱仪可根据化合物的洗脱时间来进行不同实验，从而在相同的运行中尽可能获取更多
信息。图 11-15 显示了一个三时段方法
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图 11-15 多时段实验示例

实验

实验包括 MS 扫描期间的质谱仪设置和扫描类型。运行一定时间量内的一整套 MS 扫描被称为
时段。在整个持续时间内 MS 参数和动作都相同的采集方法被称为单时段、单实验方法。

在环回实验中，MS 设置是按逐次扫描而改变的。比如，如果样本中含有两种化合物 A 和 B，
用户可能希望用化合物 B 的 MS/MS 实验重复一遍化合物 A 的 MS/MS 实验，以获得两种化合
物在相同运行中的信息。质谱仪方法将在两次扫描类型之间交替。环回实验的其他例子包括在
样本运行和信息相关采集 (IDA) 方法中正、负模式之间的交替。

添加实验

1. 在 Acquisition method 窗格中，右键单击要添加实验的时段，然后单击 Add experiment。

图 11-16 Add Experiment

实验添加到此时段内最后一个实验之后。

注释： 实验无法插到实验、IDA 标准或时段之间。用户只能在时段末尾时添加实验。

2. 在 MS 选项卡中，选择合适的参数。
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复制实验至时段中

1. 打开一个多时段方法。

2. 在 Acquisition method 窗格中，按住 Ctrl，然后将实验拖拉至时段中。

此实验复制到此时段内最后一个实验之后。

复制时段内的实验

如果大部分或所有的参数都相同，使用此程序添加相同或相似的实验到一个时段。

• 右键单击该实验，然后单击 Copy this experiment。

该实验副本会添加至所创建的最后一个实验的下面。当向采集方法中添加相同或相似实验
时，这非常有用。

添加时段

• 在 Acquisition method 窗格中，右键单击 Mass Spec 图标，然后单击 Add period。

在创建的最后一个时段下方即会添加一个时段。

注释： 用户在信息关联采集实验中不能使用多个时段。

扫描技术

MS：在 MS 扫描（也称为单次 MS 扫描）中，离子根据不同的质荷比（m/z）进行分离。单 MS
扫描可用于确定化合物的分子量。单 MS 扫描也可称为全谱扫描。除质量信息外，MS 扫描不提
供离子化学组成方面的任何信息。执行 MS/MS或 MS/MS/MS 扫描可获得更多关于离子的信息。

MS/MS：MS/MS 扫描用于确定分子种类。

• 对于在三重四极杆系统中进行 MS/MS 扫描，前体离子在碰撞池中碎裂。

• 对于 QTRAP®系统的 MS/MS 扫描而言，前体离子碎裂发生在碰撞池或线性离子阱中。

如果采用了足够大的能量，那么前体离子碎裂产生特征性产物离子。

MS/MS/MS：线性离子阱 (LIT) 系统 MS/MS/MS 扫描比 MS/MS 扫描多一步。在碰撞池中产生的
离子碎片在线性离子阱中进一步碎裂，从而可以提供更多关于分子离子的结构信息。

四极模式扫描类型

三重四极杆仪器具备定量实验所需要的高灵敏度的多反应监测 (MRM) 性能。此外，它们具有高
度特异性的扫描类型，比如前体离子和中性丢失扫描，即可对样本的组分进行更高级的搜索。

Q1 MS (Q1)：使用第一个四极杆 (Q1) 进行的全扫描类型。对扫描范围内的每种质量均返回离
子强度。

Q1 多离子 (Q1 MI)：使用 Q1 四极杆进行的零宽度扫描类型。仅对指定质量返回离子强度。
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Q3 MS (Q3)：使用第三个四极杆 (Q3) 进行的全扫描类型。对扫描范围内的每种质量均返回离
子强度。

Q3 多离子 (Q3 MI)：使用 Q3 四极杆进行的零宽度扫描类型。仅对指定质量返回离子强度。

MRM (MRM)：一种 MS/MS 扫描，在此扫描中用户选定的离子通过 Q1 四极杆，然后在 Q2 碰撞
池中裂成碎片。然后，Q3 四极杆会选择进入检测器的碎片离子。这种扫描模式主要用于定量。

产物离子 (MS2)：MS/MS 全扫描，其中，Q1 四极杆固定用于传输特定的前体离子，而 Q3 四极
杆则扫描指定的质量范围。用于识别一种特定前体离子的所有产物。

前体离子 (Prec)：MS/MS 扫描，其中，Q3 四极杆固定在特定质荷比，以传输特定的产物离子，
而 Q1 四极杆则扫描一个质量范围。用于确认前体离子的存在，或者更通常用于识别共有一种
产物离子的化合物。

中性丢失 (NL)：MS/MS 扫描，其中，Q1 四极杆和 Q3 四极杆扫描一个质量范围，保持一个固
定的质量差。如果离子是由 Q1 四极分段通过丢失指定的中性丢失（固定质量）而选出的，则
可观察到响应。用于确认前体离子的存在，或者更通常用于识别共有一个中性丢失的化合物。

线性离子阱模式扫描类型

线性离子阱模式扫描使用 Q3 四极杆作为线性离子阱。在扫描输出之前，离子被捕获并储存于
Q3 四极杆内，从而提高灵敏度。此外，MS/MS/MS 分析可以在线性离子阱中进行，提供关于样
本的更多信息。线性离子阱模式扫描类型通常用于进行定性测定。

增强型 MS (EMS)：在 Q1 四极杆中扫描离子，进入到线性离子阱中进行收集。这些离子从 Q3
四极杆内扫描输出，产生单 MS 类型谱图。

增强型产物离子 (EPI)：这种扫描类型用于获得一个特定离子的高质量 MS/MS 谱图。在 Q2 碰
撞池中进行裂解，因此提供了具有碰撞活化解离 (CAD) 裂解特征以及丰富信息的 MS/MS 谱图。
在这个扫描类型中，首先在质量窗口宽为 1 Da 至 4 Da 的 Q1 四极杆中选择要进行裂解的前
体离子，从而过滤掉所有其他离子。在 Q2 碰撞池中通过 CAD 气体对前体离子进行裂解。产生
的碎片离子在线性离子阱中进行捕获，然后根据所要求的碎片离子分辨率不同，以三种扫描速
度中的一种将碎片离子扫描输出。

对于信息关联采集实验，Product Of 字段默认设置为 30 Da，不应更改这个数值。

增强型分辨率 (ER)：这种扫描类型与 EMS 扫描相似，不同之处在于以最慢的扫描速率从线性
离子阱内扫描输出与前体离子质量只有较小差值 30 Da 的碎片离子，从而生成较窄质量窗的最
佳分辨率谱图。

MS/MS/MS (MS3)：通过 Q1 四极杆选择一个前体离子，并在 Q2 碰撞池中通过碰撞活化解离方
式进行裂解。产生的产物离子传送到线性离子阱内，在此处分离获得单个产物离子。然后在线
性离子阱中分离离子进一步裂解，产生的产物离子以三种扫描速率中的一种从离子阱中扫描输
出。与任何离子阱内碰撞诱导解离 (CID) 相似，根据最低质量碎片离子和前体离子在离子阱中
一定同时稳定的情况，对于第二部步 MS/MS ，存在一个低质量界限。对于 QTRAP®系统，这会
导致 MS3 实验中低于前体离子质量 28% 的离子发生丢失。这种现象通常称为三分之一界限规
则。

谱图数据采集相关内容

可在表 11-5所述的其中一个模式中获得谱图数据。
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表 11-5 谱图数据

描述模式

预设值为 0.1 Da。轮廓图数据是指由质谱仪产生的数据，并且与
以一系列均匀分布的离散质量值记录的强度相对应。例如，对于
质量范围为 100 Da 至 200 Da 且步长为 0.1 Da 而言，质谱仪
扫描 99.95 至 100.05（记录值为 100），100.05 至 101.15（记
录值为 101）......199.95 至 200.05（记录值为 200）。

轮廓图

预设值为 1.0 Da。跳峰是操作质谱仪的一种模式，在这种模式
中，质谱仪进行大步长扫描（约 1 Da）。它具有速度优势（更少
的数据步），但存在峰形信息的丢失。

跳峰

棒状图模式质谱仪扫描与轮廓图模式相似，但产生的是一个数据
的棒状图，通过每一个峰的强度加权质心代替获得的质谱峰。棒
状图数据的优点在于可显著减小文件大小。缺点是峰形信息丢失，
以及如果采集数据生成棒状图，则无法进行改变。我们建议先采
用轮廓图模式，待数据采集完成后再生成棒状图。

棒状图
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小心： 可能导致系统损坏。如果连接到质谱仪的 HPLC 系统并非由软件控制，则在运行期间
不得使质谱仪处于无人值守的状态。质谱仪进入待机模式后，来自 HPLC 系统的液流可能会
淹没离子源。

创建并提交批次

一个批次是指关于待分析样本的信息集合。批次可以告知软件样本的分析顺序。有关导入批次
的信息，请参阅《高级用户指南》。

设置队列选项

列表中队列逐个采用所选择的采集方法进行每个样本的采集。在所有样本都进行采集之后，队
列停止，质谱仪进入 Standby 模式。在 Standby 模式中，液相色谱泵和一些仪器的电压是关
闭的。

最后一次采集完成后，用户可以在 Analyst® MD 软件使质谱仪进入 Standby 模式前更改队列
运行的时间长度。欲获知关于 Queue Options 对话框中其他字段的信息，请参阅 Help。

1. 在导航栏上，单击 Configure。

2. 单击 Tools > Settings > Queue Options。

图 12-1 Queue Options 对话框
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3. 在 Max.Num.Waiting Samples 字段中，将样本数的最大值设置为大于将要提交到队列的样
本数。

4. 在 Max.Idle Time 字段中，键入队列在采集完成后进入 Standby 之前将要等待的时间长
度。预设值为 60 分钟。

如果使用了气瓶，则需要调整这个时间，以保证气瓶中气体没有耗尽。

如果使用了液相色谱法，则在运行开始之前，确保在储液器中有足够的溶剂来满足所有样本
主流速运行和最大空闲时间的要求。

5. 选中 Leave Mass Spec on in Standby 复选框使质谱仪在分析完成后继续运行。这个功能
使加热器和气体在设备进入空闲状态后仍能继续运作，从而确保离子源和质谱仪入口不受污
染。

6. 选中 Fail Whole Batch in Case of Missing Vial 复选框，从而当遇到缺失样本瓶的情况
下，整个批次停止进样。如果未选中这个选项，那么仅当前样本将进样失败，而队列会继续
转至下一样本。

创建并提交批次

使用该工作流可创建一个批次。本示例使用之前创建的 MRM 扫描类型。可以将工作流从头到尾
演习两遍，一遍采用 Q1MS 方法，另一遍采用 Q1MI 方法。

如果使用 Quick Quant 功能在数据文件中存储样本类型和浓度，请勿使用自动生成的 Quick
Quant 方法执行定量分析。此定量方法不会使用已针对谱峰选择而进行了优化的化合物和样本
特异性积分参数。

添加样本集合和样本至批次

一个样本集合可包含单个样本或多个样本。

注释： 有关将定量信息添加至批次的更多信息，请参阅高级用户指南。

1. 在导航栏上，在 Acquire 菜单之下，双击 Build Acquisition Batch。

图 12-2 Batch Editor 对话框

2. 在 Sample 选项卡的 Set 列表中，键入一个名称。
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3. 单击 Add Set。

4. 单击 Add Sample 来添加样本至一个新的样本集合。

图 12-3 Add Sample 对话框

5. 在 Sample name 部分的 Prefix 字段中，为这个集合中的样本键入一个名称。

6. 若要在样本名称末添加递增编号，选中 Sample number 复选框。

7. 如果已选中 Sample number 复选框，那么在 Number of digits 字段中键入包含在样本名
称中的数字位数。

例如，如果键入了数字 3，那么样本名称将会为“样本名称 001”、“样本名称 002”和
“样本名称 003”。

8. 在 Data file 部分的 Prefix 字段中，为储存样本信息的数据文件键入一个名称。

9. 选中 Set name 复选框可以使用样本集合名称作为数据文件的一部分。

10. 选择 Auto Increment 复选框可以使数据文件名称自动递增。

当质谱仪用作体外诊断设备时，建议每个数据文件只获取一个样本。

注释： 每一个样本的数据可以储存在同一个或独立的数据文件中。数据文件的名称会有从
1 开始的数字后缀。

11. 在 Sub Folder 字段中键入一个名称。

此文件夹储存于当前项目的 Data 文件夹中。如果 Sub Folder 字段留空，那么数据文件会
储存于 Data 文件夹中，而且不会创建子文件夹。
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12. 在 New sample 部分的 Number 字段中，键入要添加的新样本数量。

13. 单击 OK。

样本表中填有样本名称和数据文件名称。

提示！ 选中单列标题或一列中多行之后，在右键菜单中可以使用 Fill Down 和 Auto
Increment 选项。

14. 在 Sample 选项卡的 Acquisition 部分中，从列表内选择一种方法。

根据系统的设置方式，必须输入自动进样器的具体信息。即使在方法中已经设置了进样容
积，用户仍能够通过更改进样容积列中的数值来改变一个或更多样本的进样容积。

注释： 若样本集合中的一些样本要采用不同方法，请选中 Use Multiple Methods 复选
框。Acquisition Method 列会显示于 Sample 表中。在这列中选择每个样本的采集方法。

15. 在 Sample 选项卡中的 Set 列表中，选择样本集合。

16. 对于集合中的每份样本，执行以下操作（如适用）：

• 在 Rack Code 列中，选择支架类型。

• 在 Rack Position 列中，选择自动进样器中的支架位置。

• 在 Plate Code 列中，选择进样盘类型。

• 在 Plate Position 列中，选择支架中的进样盘位置。

• 在 Vial Position 列中，键入进样盘或托盘中的样本瓶位置。

注释： 若要从 Locations 选项卡中自动填充样本，请在按住 Shift 键的同时单击样本集
合中的第一个和最后一个样本瓶。这些样本瓶均会显示为红色圆圈。在 Locations 选项卡
上，按住 Ctrl 键的同时单击样本瓶位置可以从同一个样本瓶进行多次进样。红色圆圈变
为绿色。

17. 或者，要使用 location 选项卡选择进样瓶的位置，请参阅 使用 Locations 选项卡选择样
本瓶位置（可选）。

18. （可选）根据需要使用表 12-1 中的程序。
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表 12-1 批次编辑器提示

方法目的

单击列标题，然后右键单击。从菜单中选择
Auto Increment 和 Fill Down 命令可更改
此列中的数值。

此功能也对同一列中的多个单元格有效。

同时更改一列中的所有数值

选择这个方法，然后从列表中单击 Method
Editor。要创建新的采集方法，从列表中选
择 None，然后单击 Method Editor。仅应由
经验丰富的用户使用此功能。

如果选择了 Use Multiple Methods，那么不
得使用此功能。

更改当前采集方法

从 Quantitation 列表中选择该方法。应用之前创建的定量方法

按下 Shift 键并单击范围内的第一个和最后
一个样本孔或样本瓶。

一次选择多个样本孔或样本瓶

19. （可选）若要在提交批次之前定义定量详情，请参阅在批次编辑器中设置定量详情（可选）。

20. 单击 Submit 选项卡。

注释： 将样本提交至队列之前，可以编辑它们的顺序。要更改样本顺序，请在 Submit 选
项卡上，双击表最左边的任何一个数字（会显示一个非常模糊的框），然后将它们拖动到
新的位置。

21. 如果 Submit Status 部分中包含一条关于批次状态的消息，请执行以下操作之一：

• 如果消息表明该批次已经准备好进行提交，那么执行步骤 22。

• 如果该消息表明批次未做好提交准备，那么根据消息的指示进行更改。

22. 确认批次信息全部正确后，单击 Submit。

该批次被提交至队列，并且可以在 Queue Manager 中查看。

23. 保存文件。

提交样本或样本集

注释： 如果在样本采集过程中发生异常终止，请再次运行该样本。如果异常终止是由停电引
起，则自动进样器托盘的温度不再保持恒定，因而给样本品质带来问题。

1. 选择样本或样本集。

2. 单击 Batch Editor 中的 Submit 选项卡。
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3. 如果 Submit Status 部分包含有关批次状态的消息，那么执行下列操作之一：

• 如果该消息表明批次已做好提交准备，那么转至下一步。

• 如果该消息表明批次未做好提交准备，那么根据消息的指示进行更改。

4. 单击 Submit。

更改样本顺序

将样本提交至 Queue 之前，可以编辑它们的顺序。

• 在 Submit 选项卡上，双击表最左边的任何一个数字（可以看见一个非常模糊的框），然后
将它们拖动到新的位置。

使用 Locations 选项卡选择样本瓶位置（可选）

1. 单击 Batch Editor 中的 Locations 选项卡。

2. 从 Set 列表中选择样本集合。

3. 从 Autosampler 列表中选择自动进样器。

4. 在与支架相关的空间中，右键单击，然后选择支架类型。

样本板或样本盘显示在支架中。

5. 双击带有空格标记的样本架类型。将显示可视化样本架布局。

自动进样器的合适支架空间数量显示在图像支架视图中。
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图 12-4 可视化样本位置

6. 双击其中一个长方形。

显示出表示进样盘或托盘的样本孔或样本瓶的圆圈。

提示！ 要在示意图中查看对应的样本瓶号，请将鼠标移至该样本位置上方。通过此信息确
认软件中的样本瓶位置与自动进样器中的样本瓶位置相匹配。
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图 12-5 位置选项卡

注释： 基于正在使用的自动进样器，可能无需在其他列中键入详细信息。

7. 若要选择按行还是按列标记样本，单击 Row/Column selection 选择按钮。

如果按钮显示一条红色的水平线，则 Batch Editor 按行标记样本。如果按钮显示一条红色
的垂直线，则 Batch Editor 按列标记样本。

8. 按分析顺序单击样本孔或样本瓶。

提示！ 再次单击一个选择的样本孔或样本瓶来移除它。

提示！ 若要自动填充样本，请按住 Shift 键并单击一个样本集合中的第一个和最后一个
样本瓶。若要由相同的样本瓶进行多次注入，按住 Ctrl 键，同时单击样本瓶位置。红色
圆圈变为绿色圆圈。

在批次编辑器中设置定量详情（可选）

如果对某一批次使用了一种定量方法，而且用户在采集后不想选择定量详情，那么必须在提交
批次之前定义定量详情（样本类型、样本浓度）。
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根据 Sample 选项卡中所选的定量方法，Quantitation 选项卡中会显示相应的 Internal
Standard 和 Standard 列。

1. 在 Batch Editor 中打开一个批次文件，单击 Quantitation 选项卡。

2. 选择包含样本的集合。

3. 从单元格的列表中为所有样本选择一种 Quant Type。

4. 如果适用，在 Analyte 列中键入分析物浓度。

5. 如果适用，在 Internal Standard 列中键入内标浓度。

6. 对批次中的每个集合均重复此程序。

平衡系统

在提交批次之前平衡系统。平衡后可以为质谱仪接收后续样本或批次做预热和准备。

1. 单击 图标。

Equilibrate 对话框随即打开。

2. 选择用于已提交批次的采集方法。

3. 在 Time(min) 字段中键入平衡时间（单位为分钟）。

4. 选择 OK。系统开始平衡。

平衡完成后，系统将变为 Ready 状态。

提示！ 如果平衡没有按预期完成，或者平衡完成后系统状态没有变为 Ready，请确保

• 激活的硬件配置文件适用于该采集方法。

• HPLC 系统已打开。

• HPLC 系统与软件已正确建立通信。

采集数据

开始样本采集时，系统切勿处于 Tune and Calibrate 模式。此外，如果系统在当天早些时间
运行过，而且还没有设置成 Standby 模式，则会自动开始样本采集。

1. 确保达到柱温箱温度。

2. 确保未按下 图标。

3. 在导航栏上，单击 Acquire。

4. 单击 View > Sample Queue。

Queue Manager 打开，显示出所有提交的样本。
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图 12-6 Queue Manager

描述项目

不要按下 Reserve Instrument for Tuning 图标。1

队列状态应该处于 Ready 模式。2

队列服务器应处于 Normal。请参阅队列状态。3

5. 单击 Acquire > Start Sample。

注释： 我们建议如果在样本采集过程中出现异常终止，请再运行一次样本。

导入批次文件

在 Batch Editor 中，用户可以导入包含批次信息的文本文件，但不能创建批次。如果所有的
样本详细信息都包含在电子表格中，那么在电子表格中重新排列和导入数据的速度比在 Batch
Editor 中手动键入数据要快。

从文本文件导入批次信息前，确保该文件中数据的组织结构和格式正确无误。尤其要提到的是，
电子表格中的列标题必须与 Batch Editor 列标题相匹配。

以文本文件建立批次

前提条件

请确保当前的硬件配置文件包括所有用于采集样本的设备。

为了确保文本文件包含合适的标题，使用 Batch Editor 创建一个批次，以文本文件导出，在
电子表格编辑器中键入适当的数值，然后将文件导回 Batch Editor。只有批次至少包含一个组
且组中至少包含一个样本时，用户才可将批次导出。保存的文本文件稍后可再作为模板使用。

1. 在 Batch Editor（批次编辑器）中，创建一个单组、单样本批次。

2. 单击 File（文件） > Export（导出）。

此时会打开 Save As（另存为）对话框。

3. 在 File name（文件名）字段中键入文本文件名称，然后单击 Save（保存）。

4. 在电子表格程序（如 Microsoft Excel）中打开此文本文件。

5. 键入或复制和粘贴样本详细信息：每行一个样本，相应标题下列入详细信息。
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注释： 不要删除任何列。电子表格中的列必须与 Batch Editor（批次编辑器）中的列相
匹配。

6. 将修改后的文本文件保存为 .txt 或者 .csv 文件，然后关闭该电子表格程序。

该文本文件现在可以导入到 Batch Editor（批次编辑器）。

从文本文件导入批次

1. 在 Batch Editor 的 Sample 选项卡中，右键单击然后单击 Import From > File。

此时会打开 Open 对话框。

2. 单击所需的文本文件，然后单击 Open。

如果使用了自动进样器，那么此时会打开 Select Autosampler 对话框。

注释： 如果保存的文本文件未显示在 Files of type 列表中，那么请选择 Microsoft
Text Driver (*.txt; *.csv)。扩展名为 .txt 的文件会显示在字段中。

3. 在自动进样器列表中，选择自动进样器，然后单击 OK。

样本表中会填入来自文本文件的详细信息。

4. 提交批次。

批次与采集方法编辑器提示

方法目的

（例如，若要更改样本名称）单击某个单元
格，然后键入新值。

更改表中的值

单击列标题，然后右键单击。在显示的菜单
中，选择 Auto Increment 和 Fill Down 命
令更改列中的数值。

这也对同一列中的多个单元格有效。

同时更改一列中的所有数值

从列表中选择方法，然后单击 Method
Editor。若要创建一个新的采集方法，在列表
中选择 None，然后单击 Method Editor。仅
应由经验丰富的用户使用此功能。

如果正在使用 Use Multiple Methods 选项，
请勿使用该功能。

更改当前采集方法

从 Quantitation 菜单中选择方法。应用之前创建的定量方法

按下 Shift 键并单击您欲选择范围内的第一
个和最后一个样本孔或样本瓶。

一次选择多个样本孔或样本瓶
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批次故障排除提示

纠正措施可能的原因症状

为批次选择正确的采集方法。批次中未选择采集方法。在 Analyst® MD软件的 Batch
editor 中，注射量 (uL) 列显
示为 -1。

打开并查看预期采集方法。更
正 LC 设备信息，然后保存该
方法。

所选采集方法中的 LC 设备与
硬件配置文件中激活的 LC 设
备不匹配。

打开 Hardware Configuration
Editor，然后失活硬件配置文
件。编辑硬件配置文件，更正
LC 设备信息，然后激活硬件配
置文件。

激活的硬件配置文件中不包含
LC 设备或包含另一个 LC 设
备。

Batch Editor 右键菜单

在 Batch Editor 中右键单击可访问选项。

图 12-7 批次右键菜单

功能菜单

打开一个批次文件。Open

导入一个文件。Import From

将批次另存为其他名称。Save As Batch
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功能菜单

将批次保存为模板。Save As a
Template

隐藏或显示一列。Hide/Show Column

保存批次列设置。Save Column
Settings

添加自定义列。Add Custom
Column

删除自定义列。Delete Custom
Column

复制相同数据至选定单元格。Fill Down

自动递增数据至选定单元格。AutoIncrement

删除选定行。Delete Samples

选择一个自动进样器。Select
Autosampler

队列状态和设备状态

Queue Manager 会显示队列、批次和样本状态。还可查看关于队列中某一特定样本的详细信息。

提示！ 单击 查看队列。

队列状态

队列的当前状态显示在 Queue Server 中。

图 12-8 显示正常模式的 Queue Server 指示灯

图 12-9 显示调谐模式的 Queue Server 指示灯

第一个图标指示队列的状态。第二个图标指示队列是处于 Tune 模式（适于调谐）还是处于
Normal 模式（适于运行样本）。表 12-2介绍图标和队列的状态。
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表 12-2 队列状态

定义状态图标

硬件配置文件被停用，队列不接受任何样本提交。Not Ready

硬件配置文件已被激活，但所有设备都处于闲置状
态。泵未运行，气体被断开。

Stand By

正在平衡质谱仪和设备，对柱子进行条件设定以及清
洗自动进样器针头，柱温箱到达预设温度。平衡的持
续时间由操作者选择。从该状态下，系统可以进入
Ready 状态。

Warming
Up

系统已准备好开始运行样本，设备已达到平衡，并准
备运行。在这种状态下，队列可以接收样本并将在样
本提交后运行。

Ready

在提交下一样本后，系统将自动开始采集。Waiting

正在将方法下载到每台设备上，且设备即将达到平
衡。这种状态出现于批次中每个样本的采集之前。

PreRun

方法在运行，进行数据采集。Acquiring

在采集过程中该系统已暂停。Paused

查看仪器和设备状态图标

位于窗口右下角状态栏上的图标，代表当前激活硬件配置中的质谱仪以及其他每个设备。用户
可以查看液相色谱泵的详细状态，从而确定液相色谱泵压力是否合适，或者还可以查看质谱仪
的详细状态，从而确定离子源的温度。

注释： 对于每一种状态，背景色可以是红色。红色背景表示当处于这种状态时设备出现错
误。

• 在状态栏上，双击设备或质谱仪图标。
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Instrument Status 对话框打开。

表 12-3 仪器和设备状态图标

描述背景色图标状态

设备没有在工作。如果背景色为黄色，则需
要在设备运行准备就绪之前进行平衡。如果
背景色是绿色，则设备运行准备就绪。

绿色或黄色空闲

设备正在平衡。绿色或黄色正在平衡

设备正等待来自软件或其他设备的命令，或
者在等待操作者的操作。

绿色正在等待

设备正在运行一个批次。绿色正在运行

设备正在中止一次运行。绿色正在中止

一个方法正转移到设备中。绿色正在下载

设备没有在运行，但运行准备就绪。绿色准备就绪

设备出现错误，需要进行调查。红色错误

停止样本采集

当停止样本采集时，当前扫描会于采集停止之前结束。

1. 在 Queue Manager 中，单击队列中在采集应该停止的点后的样本。

2. 在导航栏上，单击 Acquire。

3. 单击 Acquire > Stop Sample。

队列会在当前扫描完成对所选样本的扫描之后停止。Queue Manager (Local) 窗口中的样本
状态变化为 Terminated，队列中随后的所有其他样本状态为 Waiting。

4. 若要继续处理这个批次，单击 Acquire > Start Sample。

队列右键菜单

右键单击 Queue 表以访问选项。
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图 12-10 Queue Manager 右键菜单

功能菜单

打开 Sample Details 对话框。Sample Details

再次采集一个样本。Reacquire

在两个样本之间插入暂停时间（单位为秒）。该版本的软
件中未提供此功能。

Insert Pause

删除批次或所选择的样本。Delete

在队列内移动批次。Move Batch

按预选列排序。Sort

更改列设置。Column Settings
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使用 Example文件夹中的样本文件，学习如何使用最常用的分析和处理工具来查看和分析数据。
欲获知更多关于下列主题的信息，请参阅《高级用户指南》。

• 标注图

• 覆盖和整合质谱或色谱图

• 执行背景减除

• 平滑算法

• 采用平滑数据运行

• 采用质心数据运行

• 采用轮廓图运行

• 采用碎片解释工具运行

• 采用文库数据库和文库记录运行

质谱和色谱图数据概述

质谱数据提供了有关某化合物的质量特异性信息。色谱图提供了数据的总体情况，在使用 LC
色谱柱的情况下，色谱图通常是以时间为准的，但它没有提供有关色谱峰成份的任何信息。但
是，一个质谱可查看一个特定峰，并提供对应化合物的分子量，这可用来查找更具特异性的信
息。例如，某个色谱图可能看上去只有一个峰，但这个峰所代表的化合物可能不止一种，即代
表了不同的质量。质谱显示的是组成一个峰的所有质量，包括每一种质量的强度。

如果改变给定样本的色谱图条件，色谱图数据可能在时间和强度两方面都会随之变化。质谱强
度可能会改变，但质量是固定的，因为化合物的质量不会改变。

生成质谱数据有两种方式：

• 如果只采集到一种扫描，系统默认以质谱方式显示数据。

• 来自色谱图。

显示典型的质谱图，其中包含分子量，并在 X 轴上标记质荷比 (m/z)。强度显示在 Y 轴上。

分析数据

打开一个数据文件时，窗口中会出现不同的窗格，具体取决于所进行的实验类型。软件将数据
保存在扩展名为 wiff 的文件中。Wiff files 文件中可以包含不止一种样本的数据。除了 wiff
文件外，软件还可以打开 txt 文件。不过，txt 文件中仅包含一种样本的数据。
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可以通过表格或图形形式查看数据文件中所包含的信息。图形数据可以通过色谱图或质谱呈现。
任一来源的数据都可以显示为数据点表格，可以对这些数据进行各种排序操作。

用户可以打开包含现有数据或当前正在采集数据的文件。用户也可以通过表格形式查看所有与
实验相关的数据。表格窗格包含两个选项卡：Data List 选项卡和 Peak List 选项卡。Data
List 选项卡包含实验相关信息，如采集时间和扫描强度。Peak List 选项卡显示了与峰有关的
信息，如峰高度、峰面积和基线类型。

如果数据中包含来自多个实验的结果，用户可以为每个实验单独创建 TIC（总离子色谱图），
而用另一个 TIC 代表所有实验的汇总结果。

代表所有实验汇总结果的预设 TIC 的 X 轴中心下方会显示一个分离工具。

打开数据文件

提示！ 要关闭质谱的自动更新，右键单击质谱，然后单击 Show Last Scan。如果 Show Last
Scan 有一个复选标记，那么谱图将实时更新。

1. 在导航栏的 Explore 项下，双击 Open Data File。

Select Sample 对话框随即显示。

2. 在 Data Files 列表中，导航到要打开的数据文件，选择一个样本，然后单击 OK。

样本采集数据随即显示。如果仍然在采集数据，那么质谱、二极管阵列检测器/紫外跟踪和
总离子色谱图继续自动更新。

在数据文件中的样本之间导航

注释： 如果样本保存在不同的数据文件中，则分别打开每个文件。

表 D-5 显示了在此程序中使用的导航图标。

• 打开包含多个样本的数据文件，然后执行下列操作之一：

• 单击箭头指向右侧的图标，可跳至数据文件中的下一样本。

• 单击箭头弯向右侧的图标，可跳至非序列样本。

• 在 Select Sample 对话框中，从 Sample 列表内选择要查看的样本。

• 单击箭头指向左侧的图标，可转到数据文件中的前一样本。

查看实验条件

用于收集数据的实验条件与结果一同储存于数据文件中。此信息包含所用下列采集方法的详细
信息：包括仪器参数在内的 MS 采集方法（即时段、实验和循环数）和 HPLC 设备方法（液相
色谱泵流速）。此外，还包含 MS 分辨率和用于样本采集的质量校正表。表 13-1显示了用户浏
览文件信息时的软件可用功能。
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注释： 如果将不止一个样本的数据采集到同一个 wiff 文件中，则在滚动查看样本时，文件
信息窗格不会自动刷新。关闭文件信息窗格，然后将其重新打开，就可以查看 wiff 文件中
下一个样本的详细信息。

• 单击 Explore > Show > Show File Information。

File Information 窗格即会在图下方打开。

提示！ 要从 File Information 窗格中创建一个采集方法，右键单击 File Information
窗格，然后单击 Save Acquisition Method。

表 13-1 Show File Information 窗格的右键菜单

功能菜单

复制所选数据。Copy

粘贴数据。Paste

选择窗格内的全部数据Select All

将数据保存为 rtf 文件。Save To File

更改字体。Font

将采集方法保存为 dam 文件。Save Acquisition
Method

打开 Specify Compound Information 对话框。选择要在化合物
数据库中保存的 ID 和分子量。

Save Acquisition
Method to CompoundDB

删除选定窗格。Delete Pane

显示表中数据

1. 打开一个数据文件。

2. 单击 Explore > Show > Show List Data。

数据显示在图下方的窗格中。
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图 13-1 Peak List 选项卡

表 13-2 右键单击 Spectral Peak List 选项卡的菜单

功能菜单

打开 Select Columns for Peak List 对话
框。

Column Options

将数据保存为 .txt 文件。Save As Text

删除选定窗格。Delete Pane
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表 13-3 右键单击 Chromatographic Peak List 选项卡的菜单

功能菜单

谱峰以两种颜色显示。Show Peaks in Graph

打开 Intelliquan 对话框。IntelliQuan Parameters

将数据保存为 txt 文件。Save As Text

删除选定窗格。Delete Pane

显示基本的定量数据

1. 打开一个数据文件。

2. 单击 Explore > Show > Show List Data。

图 13-2 列表数据

3. 在 Peak List 选项卡中，右键单击，然后选择 Show Peaks in Graph。

谱峰以两种颜色显示。

4. 要更改峰发现算法的设置，右键单击，然后选择处于激活状态的 Analyst Classic Parameters
或 Intelliquan Parameters。

5. （可选）删除彩色谱峰，右键单击 Peak List 选项卡，然后清除 Show Peaks in Graph。
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质谱图

质谱是指直接从质谱仪获取的数据，通常代表的是以特定质荷比（m/z）值检测到的离子数。它
以图形形式显示，X 轴显示 m/z 值，Y 轴显示强度 (cps)。有关如何处理质谱的更多信息，请
参阅 表 13-4。

如果是 MS/MS 数据，则强度与两种质量有关：前体离子质量 (Q1) 和产物离子质量 (Q3)。

谱图窗格

表 13-4 谱图窗格的右键菜单

功能菜单

列出数据点，并对色谱图进行积分。List Data

生成包含总离子色谱图的新窗格。Show TIC

从所选窗格中提取一个特定的离子或一组离子，然后生
成包含特定离子色谱图的新窗格。

Extract Ions (Use Range)

利用选定区域中的最强峰提取离子。Extract Ions (Use Maximum)

生成窗格的文本文件，可在 Microsoft Excel 或其他程
序中打开。

Save to Text File

在 Explore 模式下处理 Wiff 文件时，将更改的信息保
存到处理参数的步骤也称为处理选项。处理历史记录存
储在一个扩展名为 eph（浏览处理历史记录）的文件中。

Save Explore History

在窗格中的光标处添加一个标题。Add Caption

在窗格中的光标处添加一个文本框。Add User Text

显示选择之前的那次扫描。Show Last Scan

在此对话框中，选择参数，以降低峰值标记。Select Peaks For Label

删除选定窗格。Delete Pane

添加记录和与化合物相关的数据（包括谱图）到库中。
执行此任务需要一个有效的谱图。

Add a Record

不设限制条件或利用先前保存的限制条件搜索谱库。Search Library

使用 Search Constraints 对话框中键入的标准搜索谱
库。

Set Search Constraints

色谱图

色谱图是从样本分析中所得数据的图形显示。它将信号强度沿代表时间或扫描次数的轴绘制成
图线。有关处理色谱图时可以用到的软件功能，请参阅表 13-7。
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软件以每秒次数 (cps) 为单位，按 X 轴所代表的时间，在 Y 轴方向绘制信号强度图线。高于
设定阈值的峰将被自动标记。如果是 LC/MS，色谱图通常作为时间的函数显示。表 13-5 中包
含对各类色谱图的介绍。

欲获知更多关于可用图标的使用信息，请参阅表 13-8。

表 13-5 色谱图类型

用途色谱图类型

通过绘制一次扫描中所有离子的强度与时间或扫描数关系而产生的色谱视
图。

当打开一个数据文件时，预设以总离子色谱图 (TIC) 打开。如果试验只包
含一次扫描，那么它将作为质谱形式出现。

如果在数据文件获取时选中 MCA 复选框，则数据文件以质谱形式打开。如
果没有选中 MCA 复选框，则数据文件以总离子色谱图 (TIC) 打开。

TIC（总离子色谱
图）

通过从一系列质谱扫描中在单个、不连续的质量数或一个质量范围内提取
产生的强度数值而创建的离子色谱图。它表示一个给定的质量数或质量范
围随时间变化的行为。

XIC（提取离子色
谱图）

显示一次扫描中强度最高离子的强度与时间或扫描次数关系的色谱图。BPC（基峰色谱
图）

汇总所获波长范围内的所有吸光度值，然后按时间对这些值进行标绘，以
此所得的色谱视图。它包括在色谱窗格中对时间绘图的一次扫描内所有离
子吸光度的综合情况。

TWC（总波长色谱
图）

总波长色谱图 (TWC) 的一个子集。提取波长色谱图 (XWC) 显示了单一波
长的吸光度或一系列波长吸光度的综合情况。

XWC（提取波长色
谱图）

监测单一或多个波长下的洗脱化合物的吸收光谱的 UV 检测器。DAD（二极管阵列
检测器）

从谱图中显示总离子色谱图

要查看示例数据文件，确保已选中 Example 项目。打开 LIT 文件夹，然后打开 Reserpine.wiff
文件。

• 单击 Explore > Show > Show TIC。

会在新窗格中打开总离子色谱图。

提示！ 在包含谱图的窗格内右键单击，然后单击 Show TIC。

显示来自总离子色谱图的谱图

TIC（总离子色谱图）是通过将一系列质量扫描中所有离子的强度贡献值加总后得出的。使用
TIC 可在单一窗格内查看整个数据集。它是由一次扫描当中所有离子的强度之和组成的，并对
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照时间绘制成色谱图，在色谱图窗格中显示。如果数据中包含来自多个实验的结果，则用户可
以为每一个实验单独创建一个 TIC，用另一个 TIC 代表所有实验汇总结果。

打开一个数据文件时，此文件预设显示为总离子色谱图 (TIC) 。不过，如果试验只包含一次扫
描，就以质谱方式显示。如果用户在获取数据文件前选中 MCA 复选框，则数据文件以质谱形式
打开。如果没有选中 MCA 复选框，软件就会用 TIC 打开数据文件。

1. 在含有总离子色谱图的窗格中，选择一个范围。

2. 单击 Explore > Show > Show Spectrum。

谱图显示在一个新窗格中。

提示！ 双击 TIC 窗格中的特定时间，以显示谱图。

图 13-3 TIC 示例

生成提取离子色谱图

仅可从单时段、单实验色谱图或谱图生成提取离子色谱图。要从多时段或多实验数据中获得提
取离子色谱图，需通过单击 X 轴下的三角形将数据分成独立的窗格。欲获知更多关于可用图标
的使用信息，请参阅表 13-8。

存在多种采用提取离子生成提取离子色谱图的方法，具体取决于使用的是色谱图数据还是波谱
数据。表 13-6 包含了一个可用于色谱图或波谱的方法总结。
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表 13-6 提取离子色谱图生成方法总结

提取使用质谱图使用色谱图方法

从谱图中的选定区域提
取离子。

是否选择范围

利用选定区域中的最强
峰从谱图中的选定区域
提取离子。此选项将使
用选定谱图范围中的最
大质量创建提取离子色
谱图。

是否最大值

只能与基峰色谱图
(BPC) 一起使用。使用
Use Base Peak Masses
命令，在标有针对各质
量的不同彩色描线的提
取离子色谱图中提取离
子结果。如果选定范围
包括多个峰，那么所得
到的提取离子色谱图将
具有相同数量的彩色描
线（每个质量一条）。

是是基峰质量

从任何类型的谱图或色
谱图中提取离子。选择
多达十个要生成提取离
子色谱图的起始和停止
质量。

是是指定质量

使用所选的范围生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在范围起始处按下鼠标左键，拖动光标到停止点，然后松开鼠标左键，即可选择范围。

所选内容显示为蓝色。

3. 单击 Explore > Extract Ions > Use Range。

即会在谱图窗格下方的窗格中打开选定范围的提取离子色谱图。窗格顶部的实验信息包含质
量范围和每秒计数的最大强度。

使用最大谱峰生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在质谱中选择一个范围。
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所选内容显示为蓝色。

3. 单击 Explore > Extract Ions > Use Maximum。

最大峰指定型选择的提取离子色谱图会在谱图窗格下方打开。窗格顶部的实验信息包含质量
范围和每秒计数的最大强度。

采用基峰质量生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在基峰色谱图中，选择提取离子的峰。

所选内容显示为蓝色。

3. 单击 Explore > Extract Ions > Use Base Peak Masses。

特定选择的提取离子色谱图会在谱图窗格下方打开。窗格顶部的实验信息包含质量范围和每
秒计数的最大强度。

通过选择质量来提取离子

1. 打开谱图或色谱图。

2. 单击 Explore > Extract Ions > Use Dialog。

图 13-4 Extract Ions 对话框

3. 键入要创建的每个提取离子色谱图的数值。如果没有键入停止值，那么该范围被定义为开始
值。

• 在 Start 字段中，键入质量范围的开始值（较低值）。
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• 在 Stop 字段中，键入质量范围的停止值（较高值）。

4. 单击 OK。

选定范围的提取离子色谱图会在色谱图窗格下方打开。窗格顶部的实验信息包括质量和每秒
计数的最大强度。

提取离子色谱图

XIC 是通过在单个离散质量值处取强度值、或者从一系列质谱扫描中的某个质量范围内取强度
值而获得的提取离子色谱图。它可以显示特定的质量或质量范围作为时间函数的行为。离子强
度或特定范围内的所有离子强度之和被绘制成色谱图，并在色谱图窗格中显示。

使用所选的范围生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在范围起始处按下鼠标左键，拖动光标到停止点，然后松开鼠标左键，即可选择范围。

所选内容显示为蓝色。

3. 单击 Explore > Extract Ions > Use Range。

即会在谱图窗格下方的窗格中打开选定范围的提取离子色谱图。窗格顶部的实验信息包含质
量范围和每秒计数的最大强度。

使用最大谱峰生成提取离子色谱图

1. 打开含有谱图的数据文件。

2. 在质谱中选择一个范围。

所选内容显示为蓝色。

3. 单击 Explore > Extract Ions > Use Maximum。

最大峰指定型选择的提取离子色谱图会在谱图窗格下方打开。窗格顶部的实验信息包含质量
范围和每秒计数的最大强度。

采用基峰质量生成提取离子色谱图

1. 在基峰色谱图中选择欲提取离子的峰。

所选范围以蓝色突出显示。

2. 单击 Explore > Extract Ions > Use Base Peak Masses。

选定范围的提取离子色谱图会在谱图窗格下方打开。窗格顶部的实验信息包含质量范围和每
秒计数的最大强度。
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通过选择质量来提取离子

1. 打开谱图或色谱图。

2. 单击 Explore > Extract Ions > Use Dialog。

图 13-5 Extract Ions 对话框

3. 键入要创建的每个提取离子色谱图的数值。如果没有键入停止值，那么该范围被定义为开始
值。

• 在 Start 字段中，键入质量范围的开始值（较低值）。

• 在 Stop 字段中，键入质量范围的停止值（较高值）。

4. 单击 OK。

选定范围的提取离子色谱图会在色谱图窗格下方打开。窗格顶部的实验信息包括质量和每秒
计数的最大强度。

基峰色谱图

BPC（基峰色谱图）显示的是每一次扫描中的最大强度离子的强度，以扫描次数或保留时间的函
数形式显示。在 TIC 中噪声占主导、从而存在较大偏差且色谱峰难以区分的情况下，这种方法
较为适用。它还有助于区分共洗脱成份。基峰色谱图只从单个时段、单个实验数据生成。

图中使用两种颜色，每当出现基峰质量变化时便交替显示。当通过翻页或缩放来操控数据时，
颜色变化维持原状。有关选择图中所用颜色方面的信息，请参阅 Help。
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生成基峰色谱图

仅可从单阶段、单实验数据生成基峰色谱图。

1. 打开一个数据文件。

2. 在总离子色谱图内选择一个区域。

所选内容显示为蓝色。

3. 单击 Explore > Show > Show Base Peak Chromatogram。

所选内容会显示在 Start Time 和 End Time 字段中。

图 13-6 Base Peak Chromatogram Options

4. 在 Mass Tolerance 字段中，键入为寻找谱峰所用质量范围的值。软件使用达到键入范围两
倍的值（±质量值）寻找此峰。

5. 在 Minimum Intensity 字段中键入最小强度，小于此值时算法即会忽略谱峰。

6. 在 Minimum Mass 字段中键入确定扫描范围的起始质量。

7. 在 Maximum Mass 字段中键入确定扫描范围的结束质量。

8. 要设置开始和结束时间，选中 Use Limited Range 复选框，执行以下操作：

• 在 Start Time 字段中，键入实验开始的时间。

• 在 End Time 字段中，键入实验结束的时间。

9. 单击 OK。
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新窗格中随即生成基峰色谱图。

调整阈值

该阈值是绘制的平行于图形 X 轴的一条隐线，其设置了一个限值，如果低于此值则软件将不会
将峰纳入谱图中。此线具有一个图柄，以 Y 轴左侧的蓝色三角形表示。单击蓝色三角形，查看
表示阈值的虚线。该阈值可以提高或降低，但更改阈值不会改变数据。该软件未标记任何处于
阈值以下区域中的谱峰。

1. 打开一个数据文件。

2. 执行以下操作之一：

• 要提高阈值，沿 Y 轴向上拖动蓝色三角形。要降低阈值，向下拖动蓝色三角形。

• 单击 Explore > Set Threshold。在打开的 Threshold Options 对话框中，键入阈值，
然后单击 OK。

• 单击 Explore > Threshold。

该图会更新以显示新阈值。峰标记和峰列表也将更新。

提示！ 若要查看当前阈值，可将光标移至阈值把手符号上方。

色谱图窗格

表 13-7 色谱图窗格的右键菜单

功能菜单

列出数据点，并对在色谱图中发现的峰进行积分。List Data

生成包含谱图的新窗格。Show Spectrum

显示一个颜色编码线图数据集，其中颜色表示该点的数据强度。只支
持某些质谱模式。

Show Contour Plot

从所选窗格中提取一个特定的离子或一组离子，然后生成包含特定离
子色谱图的新窗格。

Extract Ions

生成一个包含基峰色谱图的新窗格。Show Base Peak
Chromatogram

生成一个包含 ADC 数据追踪（如已获得）的新窗格。Show ADC Data

生成一个包含紫外数据追踪（如已获得）的新窗格。Show UV Detector
Data

生成包含窗格中数据的文本文件，此文件可在 Microsoft Excel 或其
他程序中打开。

Save to Text File
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表 13-7 色谱图窗格的右键菜单 （续）

功能菜单

在 Explore 模式下处理 Wiff 文件时，将更改的信息保存到处理参数
的步骤也称为处理选项。处理历史记录存储在一个扩展名为 eph（浏
览处理历史记录）的文件中。

Save Explore History

在窗格中的光标处添加一个标题。Add Caption

在窗格中的光标处添加一个文本框。Add User Text

在窗格中设置减除范围。Set Subtract Range

清除窗格内的减除范围。Clear Subtract Range

锁定或解锁减除范围。如果减除范围未被锁定，则每个减除范围均可
独立移动。减除范围预设为锁定状态。

Subtract Range
Locked

删除选定窗格。Delete Pane

生成总波长色谱图

TWC 是一种不常使用的色谱图。它将总吸光度 (mAU) 作为时间的函数来显示。TWC 提供了一种
在一个窗格内查看全部数据集合的方式。它包括在色谱窗格中对时间绘图的一次扫描内所有离
子吸光度的综合情况。如果数据中包含来自多个实验的结果，则可以为每一个实验单独创建一
个 TWC，用另一个 TWC 代表所有实验汇总结果。

总波长色谱图显示的是相对于 X 轴时间绘制的 Y 轴总吸光度 (mAU)。欲获知更多关于可用图
标的使用信息，请参阅表 13-8。

1. 打开包含二极管阵列检测器谱图的数据文件。

2. 单击 Explore > Show > Show DAD TWC。

在二极管阵列检测器谱图下方的窗格中即会显示总波长色谱图。

提示！ 在包含二极管阵列检测器谱图的窗格内单击右键，然后单击 Show DAD TWC。

生成提取波长色谱图

XWC 是通过取单个波长处的强度值、或通过求一系列波长的吸光度之和而获得的波长色谱图。
可以从二极管阵列检测器谱图中提取多达三个范围，以便生成提取波长色谱图。要了解有关使
用可用图标的更多信息，请参阅表 13-8。

1. 打开包含二极管阵列检测器谱图的数据文件。

2. 右键单击该窗格中的任意位置，然后单击 Extract Wavelengths。

液相色谱串联质谱检测系统系统用户指南
153 / 267IVD-IDV-05-6996-ZH-B

操作说明 - 分析和浏览数据



图 13-7 Extract Wavelengths 对话框

3. 键入 Start 和 Stop 值。

4. 单击 OK。

在二极管阵列检测器谱图下方的窗格中即会打开提取波长色谱图。

生成 DAD 数据

像质谱仪数据一样，二极管阵列检测器数据可以色谱图或谱图形式查看。您可以查看单个时点
的 DAD 质谱，或者某个时间范围的总波长色谱图 (TWC)。

1. 打开含有二极管阵列检测器采集数据的数据文件。

总波长色谱图类似于总离子色谱图，会在总离子色谱图下方的窗格中打开。

2. 在 TWC 窗格中，单击某一点，以选择单一的时间点，或者突出显示谱图的某个区域，以选
择时间范围。

3. 单击 Explore > Show > Show DAD Spectrum。

此时会在总波长色谱图下方的窗格中打开二极管阵列检测器谱图。Y-轴表示吸光度，X-轴表
示波长。

提示！ 如果总波长色谱图窗格被关闭，则可以单击总波长色谱图中的任意一点重新将其打
开。单击 Explore > Show > Show DAD TWC。

显示模拟数字转换器 (ADC) 数据

ADC（模数转换器）数据是从二次检测器获得的（例如通过 ADC 卡从 UV 检测器获得），可用
于和质谱仪数据进行对比。为了使模数转换器 (ADC) 数据可用，需要同时获得模数转换器数据
和质谱仪数据，然后将其储存在相同的文件中。

1. 确认已选中 Example 文件夹。

2. 在导航栏的 Explore 项下，双击 Open Data File。

Select Sample 对话框即会打开，

3. 在 Data Files 字段中，双击 Devices，然后单击 Adc16chan.wiff。
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4. 在 Samples 列表中选择一个样本，然后单击 OK。

5. 单击 Explore > Show > Show ADC Data。

图 13-8 Select ADC Channel 对话框

6. 在 Channel 列表中选择一个通道，然后单击 OK。

此时会在当前窗格下方出现一个显示 ADC 数据的新窗格。

图解数据处理

图解数据可以多种方式进行处理。本部分提供了有关某些最常用工具的使用信息和程序。

用户可以放大图的一部分，以更详细地查看谱图和色谱图的特定峰或某个区域。用户还可以多
次放大以查看较小的峰。

管理数据

可通过不同方式来比较或检查数据。在进行平滑或减除等处理操作之前，用户可能希望保留数
据以便进行比较。

窗口包含一个或多个以下列方式布置的窗格：所有窗格完全可见，而且互不重叠。

窗格的大小可变或固定。窗格自动在窗口中平铺，并按列和行格式排列。如果窗口大小发生变
化，则窗口中的窗格大小也发生变化，以适应新的窗口大小。窗口不能调整至其中任何窗格大
小比其最小尺寸还要小的尺寸。

两个或多个包含相似数据的窗口或窗格可以建立链接，例如，有相似质量范围的质谱。当用户
缩放某个窗格或窗口时，另一个窗格会同步缩放。例如，用户可以将提取离子色谱图 (XIC) 连
接至从中提取该 XIC 的基峰色谱图 (BPC)。放大 BPC 的同时也会放大 XIC，所以两个色谱图
的放大倍数相同。

• 使用下列菜单选项或图标以管理图中的数据。

液相色谱串联质谱检测系统系统用户指南
155 / 267IVD-IDV-05-6996-ZH-B

操作说明 - 分析和浏览数据



表 13-8 图选项

...或单击该图标使用菜单选项...目的

选择要复制的图。单击 Explore > Duplicate
Data > In New Window。

将图复制到新窗口

选择图。单击 Explore > Home Graph。将图恢复到其原始大
小

• 选择图。单击 Window > Move Pane。

• 选择窗格或窗口，然后将其拖动到新的位置。
该位置可以在同一窗口内或在其他窗口中。

当光标位于活动窗口或窗格的边界上，会显示一
个四向箭头。

• 如果窗格位于目标窗格的顶部或底部，那么分
别将窗格移动到目标窗格的上方或下方。

• 如果窗格位于目标窗格的左方或右方，那么分
别将窗格移动到目标窗格的左方或右方。

• 如果窗格位于其他位置，那么将窗格移动到目
标行。随着窗格移动的窗格阴影表示它的新位
置。

移动窗格

a. 在两个图处于打开状态的情况下，单击其中一
个可激活该窗格。

b. 单击 Explore > Link ，然后单击另一个窗
格。

链接窗格

关闭其中一个窗格。单击 Explore > Remove
Link。

删除链接

选择图。单击 Window > Delete Pane。删除窗格

选择图。单击 Window > Lock Panes。锁定窗格

选择图。单击 Window > Hide Pane。隐藏窗格
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表 13-8 图选项 （续）

...或单击该图标使用菜单选项...目的

选择图。单击 Window > Maximize Pane。最大化窗格

选择图。单击 Window > Tile all Panes。平铺窗口

放大图形

将图形局部放大，以便更详细地查看质谱和色谱图中的特定峰或面积。多次放大可查看较小的
峰。

放大 Y 轴

1. 将指针移动到待扩展区域任一侧的 Y 轴左侧，然后按住鼠标左键在垂直方向上拖离起始点。

沿 Y 轴显示的方框代表新比例。

注释： 对基线进行放大时要小心。放大程度过高，放大框会关闭。

2. 释放鼠标按钮，将图形拖至新比例。

放大 X 轴

提示！ 要使图返回到原始大小，双击任一个轴。要使整个图恢复到原始大小，单击 Explore
> Home Graph。

1. 将指针移动到待扩展区域任一侧的 X 轴下方，然后按住鼠标左键在水平方向上拖离起始点。

2. 释放鼠标按钮，将图形拖至新比例。

标记图形

可以自定义图形和色谱图上标记的预设样式。选择用于峰和轴线标记的字体，以及轨迹线的颜
色。添加轴线标记和标记类型，以及峰的精度。

向图形添加图注

图注可用于标记关注的峰或图形上的重要点。如果将图注置于峰旁边，当用户对峰进行缩放时，
图注会始终伴随着峰。当用户在数据文件中的多个样本之间移动时，图注也始终伴随着原始样
本。图注为一行，最多可含 128 个字符。

1. 在质谱上单击右键，然后单击 Add Caption。

此时会出现一个 Add Caption 对话框。

2. 在 Caption 框中键入文本内容。
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3. 若要更改图注的大小和样式，单击 Font。

4. 若要放置图注，单击 OK。

提示！ 要更改图注的位置，请将其拖至其他位置。当用户对峰进行缩放时，图注与 X 和
Y 轴的相对位置保持不变。若要编辑或删除图注，用右键单击图注，然后单击相应的命令。

向图形添加文本

使用文本可向图形中添加多行信息。图注是与特定峰相关联的，并且在用户缩放图形时会随之
移动，而文本标记与之不同，在用户缩放图形时仍位于原来位置。当用户在数据文件中的多个
样本之间移动时，文本不伴随原始样本。

1. 在图形上单击右键，然后单击 Add User Text。

此时会打开 Add User Text 对话框。

2. 在 User Text 字段中键入文本。

3. 若要使文本居中，选择 Center Text 复选框。

4. 若要更改图注的大小和样式，单击 Font。

5. 若要插入文本，单击 OK。

提示！ 要更改文本的位置，请将文本拖至其他位置。若要编辑或删除文本，用右键单击文
本，然后单击相应的命令。

叠加和汇总质谱或色谱图

将使用类似方法创建的图形叠加在一起，通过目测比较两个或多个数据集合。每个质谱都可以
按轨迹线的颜色加以区分。对于全扫描数据而言，用户可以用这种方式观察若干样本质谱之间
的差别。

将两个或以上的图形叠加之后，可以将图形汇总，以获得一条新轨迹。新轨迹上的每个点都是
各个图形上的点之和。对类似数据类型的若干叠加图求和可以让后面的处理操作变得更容易和
更迅速。例如，将若干个 XIC 叠加，对其求和，然后对汇总后的叠加图进行平滑，以消除噪
声。

对叠加图求和类似于生成一个总离子色谱图，其优点是能够选择用哪些图来叠加。比如，如果
用户要看 10 个实验的结果，总离子色谱图就会将全部 10 个实验的数据加在一起。如果对叠
加图求和，用户可以选择只添加 10 个叠加图中的 9 个。如果有 1 个实验中采集的数据都是
噪声，这种方法将会很有用。

叠加图形

如果选择了数个窗格，每个 XIC 将以单独窗格打开。
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提示！ 如果在同一窗格内叠加的图形少于 4 个，按住 Ctrl 键并在窗格内单击右键，然后
单击 Appearance Options。在 Appearance Options 对话框的 Multiple Graph Options 选
项卡中，对 Spectrum 和 Chromatogram 的 Overlay Multiple Panes 字段选择 Yes。

1. 选择要叠加的第一个窗格。

2. 单击 Explore > Overlay。

3. 单击要叠加的窗格。

图形将进行叠加，并用不同的颜色显示两条轨迹。

提示！ 若要查看叠加图形的颜色代码列表，在窗格的标题栏上单击右键。

在叠加图形之间循环

1. 选择一个包含叠加图形的窗格。

2. 单击 Explore > Cycle Overlays。

此时视图会发生改变，序列中的下一个图形将在前台显示。

叠加求和

1. 将要求和的图形叠加在一起。

2. 单击 Explore > Sum Overlays。

图形便会叠加在一起。

表 13-9 浏览工具栏快速参考：叠加图形

功能名称图标

单击后使图形恢复原始尺寸。Home Graph

单击后叠加图形。Overlay

单击后循环显示叠加图形。Cycle Overlays

单击后将图形叠加在一起。Sum Overlays

执行背景减除

背景减除是通过从含有峰的范围内减去一个或两个含有噪声的范围，从而减少质谱中的噪声数
量。独立移动各个范围，或者将其锁定，然后将其作为图形内的一个实体来移动。Locked
Background Subtraction 为预设设置。
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Background Subtract：使用背景减除选项来隔离所关注的峰。突出显示，然后从峰中减除最多
两个选定范围。锁定选定范围，然后将其在图形内移动，以优化色谱峰隔离，或者隔离另一个
峰。

在质谱中执行背景减除

1. 打开一个数据文件。

2. 选择一个背景范围。

图 13-9 所选背景范围

3. 向下按住 Shift 键，然后选择另一个背景范围。

4. 若要设置减除范围，可单击 Explore > Background Subtract > Set Subtract range。

5. 选择所关注的峰。

6. 单击 Explore > Background Subtract > Perform Background Subtract。

此时峰的背景便被减除，并生成一个新的质谱。

7. 若要隔离另一个峰，拖动色谱图内的锁定范围，并重复上述背景减除操作即可。

注释： 若要清空背景减除范围，单击 Explore > Background Subtract > Clear Subtract
Range。

8. 若要将经过背景减除的质谱作为经过处理的数据文件保存，可单击 File > Save。
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解锁范围

选定的减除范围被设置为已锁定。

• 单击 Explore > Background Subtract > Subtract Range Locked。

此时选定范围便被解锁，您可以独立移动每一个范围。

表 13-10 浏览工具栏快速参考：背景减除

功能名称图标

在选定背景范围后，单击该图标执行背景减
除。

Perform Background
Subtract

单击后将选定背景范围锁定。解锁背景范围
即可独立移动每一个范围。

Subtract Range Locked

平滑算法

对数据集合进行平滑处理可消除噪声引起的本地差异。用户可以对数据进行多次平滑处理，但
只能取消上一次的平滑操作。MI/MRM 质谱不能进行平滑。选择平滑算法或高斯平滑算法作为预
设平滑方法。

Smooth Algorithm（平滑算法）

使用此算法进行数据平滑时，可以设置三个数据点的点加权值：当前数据点、前面的数据点以
及后面的数据点。平滑算法是用数据点乘以指定的加权值，对这些数值求和，然后用该值除以
点权重值之和。它比高斯算法更为平滑一些，但平滑噪声较大的数据时需要较长时间。

Gaussian Smoothing Algorithm（高斯平滑算法）

高斯平滑要用每一个数据点两侧的一系列数据点的加权平均值来替代该数据点。每个新数据点
的加权是基于高斯曲线计算的。它比平滑算法的平滑度差一些，但对于平滑噪声较大的数据而
言是一个不错的选择。

使用高斯平滑算法需要设置两个值：

高斯过滤宽度（两个点之间的最小距离 %）：该值表示的是用于相邻点加权计算的宽度。这个
宽度是用扫描中两个点之间距离的百分比表示的，预设宽度 100% 表示其分布范围与数据点之
间的宽度相同。

高斯过滤极限（两个点之间的最小距离数）：该值对应于高斯曲线的极限值，以两点之间距离
的倍数表示。例如，预设值 10 生成的高斯曲线会将中心点两侧 10 倍数据点宽度之后的点截
去。
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平滑数据

您可以选择 Analyst® MD 软件平滑方法或高斯平滑方法。

提示！ 若要取消平滑，单击 Edit > Undo。软件支持取消上一级操作。

用平滑算法平滑数据

提示！ 若要取消平滑，单击 Edit > Undo。软件支持取消上一级操作。

1. 选择一个含有色谱图或质谱的窗格。

2. 单击 Explore > Smooth。

此时会出现 Smoothing Options 对话框。

图 13-10 Smoothing Options 对话框

3. 在 Previous Point Weight 字段中，键入要应用到前一个数据点的加权系数。

4. 在 Current Point Weight 字段中，键入要应用到中心数据点的加权系数。

5. 在 Next Point Weight 字段中，键入要应用到后面数据点的加权系数。

6. 单击 OK。

软件便会对数据集合进行平滑处理，并取代窗格中的当前数据集合。

用高斯平滑算法平滑数据

1. 选择一个含有色谱图或质谱的窗格。

2. 单击 Explore > Gaussian Smooth。

此时会出现 Gaussian smooth options 对话框。
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图 13-11 Gaussian Smooth Options 对话框

3. 在 Gaussian filter width 字段中，键入用于寻找相邻点权重的宽度，以两点间距离的百
分比表示。

4. 在 Limit of gaussian filter 字段中，键入高斯曲线的极限，以两点间距离的倍数表示。

5. 若要平滑数据，单击 OK。

软件便会对数据集合进行平滑处理，并取代窗格中的当前数据集合。

表 13-11 浏览工具栏快速参考：平滑数据

功能名称图标

单击后用平滑算法平滑数据Smooth

单击后用高斯平滑算法平滑数据Gaussian smooth

棒状图数据

棒状图数据会将峰分布值转变成一个 m/z 值以及代表峰的强度。在轮廓图模式下采集的棒状图
数据可以将数据简化，并减小文件的字节数。棒状图可以提供更为准确的峰分布，并减少数据
量，但也会删除峰形状方面的信息。

棒状图算法通过运用加权平均强度，将峰转换成单个数值，以计算峰的质心。该算法会输出一
个带参数的峰列表，如表 13-12 中所示。

表 13-12 峰参数

定义参数

棒状图数据的值，以质量或时间为单位。Centroid Value

每一个峰的强度，单位为 cps。Intensity

棒状图峰的宽度，单位为 amu。Width
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向数据库中添加数据或者在进行搜索时，数据会自动形成棒状图。

1. 选择一个含有质谱的窗格。

棒状图数据会改变现有图形的外观。若要将结果与原始数据进行比较，可以在生成棒状图前
将图形复制一份。

2. 单击 Explore > Centroid。

软件将对数据进行棒状图处理。

图 13-12 分析物质心位置

功能名称图标

单击后对数据进行棒状图处
理。

Centroid

保存并打开经过处理的数据文件

用户可以保存经过处理的数据，如图形排布和图注，保存后只能在 Explore 模式下重新打开。
这些文件还包含了相关的历史信息，与数据文件较为相似，唯一不同在于仅包含 Explore 模式
下的活动窗格内的数据。这些文件有 pdt 扩展名，并保存在当前项目的 Data 文件夹项下。

保存经过处理的数据文件

1. 选择您要保存的数据窗格。

2. 单击 File > Save Processed Data File。
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此时会出现 Save Processed Data File 对话框。

3. 在 File name 字段中，键入经过处理的数据文件的名称，然后单击 Save。

打开经过处理的数据文件

1. 在 Explore 模式下，单击 File > Open Processed Data File。

此时会打开 Load Processed Data File 对话框。

2. 选择一个文件，然后单击 Open。

使用等值线图

等值线图是一种有颜色代码的完整数据集合图，它在图中用颜色来表示第三维度。在总离子色
谱图 (TIC) 的等值线图中，X-轴表示保留时间或扫描次数，Y-轴表示质量，颜色表示该点的数
据强度。在二极管阵列 (DAD) 数据的总波长色谱图 (TIC) 的等值线图中，X-轴表示保留时间
或扫描次数，Y-轴表示波长，颜色表示吸光度。等值线图是一种用于数据采集后的工具，在实
时扫描采集中不起作用。

注释： 等值线图不支持 MI 或 MRM 扫描，但支持 DAD 扫描。

颜色是等值线图的第三根轴，代表强度或者吸光度。用等值线图上方颜色条上的控制三角来更
改等值线图内的高低强度或吸光度值。等值线图窗格上方的百分比参数表示高、低滑块位置的
值。实际值要以选定区域内最大强度或吸光度的百分比为依据。该值在等值线图窗格的右上角
显示。

图 13-13中所示控件可以改变等值线图中的颜色。

图 13-13 等值线图颜色控制按钮

定义等值线图上的颜色，以便根据需要更好地比对和显示数据。例如，设置强度/波长并更改
Below Low Data 和 Above High Data 的颜色可以消除等值线图上的背景噪声。

移动滑块控件时，Below Low Data 和 Above High Data 按钮可以缩小和放大颜色条。更改等
值线图颜色时，新颜色将成为所有后续图形的预设颜色。

查看等值线图

采集完成后，用户能从 TIC、XIC、TWC 或 XWC 图形中查看等值线图。TIC 和 XIC 适用于所有
wiff 数据文件。TWC 和 XWC 仅适用于通过 DAD 采集的数据。

1. 在 Explore 下，将数据文件以 TIC、XIC、TWC 或 XWC 图形方式打开。
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2. 突出显示要在等值线图中查看的范围。如果未进行选择，则将查看整个范围。

3. 单击 Explore > Show > Show Contour Plot。

选定区域的等值线图便会显示在一个单独的窗格中。

在等值线图中选择一个区域

用户可以放大某个特定的选择区域，或者查看该选择区域所对应的质谱。

• 执行以下操作之一：

• 若要选择一个框内的标准区域，可在等值线图中的某个区域周围用鼠标画一个方框。

• 若要在垂直方向选择，可按住 Ctrl 键，然后沿垂直方向拖动鼠标。

• 若要在水平方向选择，可按住空格键，然后沿水平方向拖动鼠标。

在等值线图中设置强度和吸光度

• 执行以下操作之一：

• 若要在等值线图中设置强度/吸光度低限值，可将左侧的三角形滑块从等值线图上方的颜
色条拖至所需位置。
等值线图会自动调节低于该设置的数值的颜色，表示这些数值在设定范围以外。

• 若要在等值线图中设置强度/吸光度高限值，可将右侧的三角形滑块从等值线图上方的颜
色条拖至所需位置。
等值线图会自动调节高于该设置的数值的颜色，表示这些数值在设定范围以外。

更改等值线图中的颜色

1. 在 Contour Plot 窗格中，单击某个颜色按钮。

此时会出现 Color 对话框。

2. 单击一种颜色，然后单击 OK。

此时图形会随颜色的改变而发生变化。

提示！ 用 Define Custom Colors 调色板创建在等值线图中使用的自定义颜色。
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等值线图窗格的右键菜单

功能菜单

用 DAD 质谱打开一个新窗格。Show DAD Spectrum

从 DAD 质谱中提取最多三个波长范围，用于
显示提取波长色谱图。

Extract Wavelengths (Use Range)

提取使用最大波长的波长范围。Extract Wavelengths (Use Maximum)

在选定区域内放大。Zoom to selection

在光标位置添加一个文本框。Add User Text

使图形恢复原始尺寸。Undo Zoom

删除选定窗格。Delete Pane

显示十字线 (nm/min)。Show Cross-Hair

碎片解读

Fragment Interpretation 工具能够帮助用户解读 MS/MS 数据。Fragment Interpretation 工
具可以从一个分子结构的非环单键裂解生成理论碎片质量列表。可以在第三方绘图程序中创建
一个分子结构，然后将其保存为 mol 文件。然后，它可以将理论列表与当前质谱中的峰进行匹
配。Fragment Interpretation 可以用碎片列表显示理论碎片，并将碎片质量与质谱中的峰进
行比较。超过阈值强度并在用户定义的碎片质量允差（最大 2 Da）范围内的峰被认为是匹配
的，并以黑体字在碎片列表中显示。

注释： Fragment Interpretation 工具不能用于以下扫描类型：

• 前体离子

• 中性丢失

• Q1 多离子

• Q3 多离子

• 多反应监测 (MRM)

使用碎片解读工具

如果查看多个质谱窗格，Fragment Interpretation 工具会与当前激活的质谱关联。如果数据
文件所包含的样本不止一个，Fragment Interpretation 工具会与当前激活的质谱关联。

工具会自动从 mol 文件计算非环单键裂解碎片。当碎片解读工具与质谱关联时，以黑体字显示
的理论碎片表示质谱中与指定质量允差和强度阈值范围相匹配的峰。

在分子结构中选择了一个非环单键后，碎片解读工具就会突出显示键裂解时所形成的两个碎片，
然后在关联的质谱中显示与之匹配的峰。
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关联 Fragment Interpretation 工具与质谱

如果在 Fragment Interpretation 工具打开时打开一个质谱，则活动的面板会自动链接至打开
的质谱。

1. 单击 Explore > Show > Show Fragment Interpretation Tool。

2. 在 Fragment Interpretation 窗格的右下角单击 connect 按钮。

此时鼠标会切换至关联工具。

3. 单击要与碎片解读工具相关联的质谱图。

左下角的关联图形指示图标中含有与碎片解读窗格关联的图形名称。如果图形或碎片解读窗
格中有一个被关闭，关联便会中断。如果关联的 wiff 文件中含有不止一个样本，则在用户
翻页查看样本时，碎片解读窗格会自动更新。

将碎片与峰匹配

1. 单击 Explore > Show > Show Fragment Interpretation Tool。

2. 在 Fragment Interpretation 窗格中有 mol 文件打开的情况下，在 Fragment List 中选
择一个以黑体显示的单元格。

在质谱中，软件会用 Options 选项卡中选定的颜色突出显示匹配的谱峰。在分子结构中，
键被突出显示。

如果单击的某一行中包含的匹配碎片不止一个，软件就会在质谱中以 Options 选项卡中所
选择的颜色突出显示最接近单同位素质量的谱峰。

在分子结构中选择一个键

1. 单击 Explore > Show > Show Fragment Interpretation Tool。

2. 在 Fragment Interpretation 窗格中有 mol 文件打开的情况下，单击分子结构中的一个非
环单键。

此时所产生的两个碎片就会在 Fragment List 中突出显示。两个碎片的质量显示在键的某
一侧。

如果有质谱与之关联，Fragment Interpretation 工具就会在图形中显示匹配的峰。如果选
择了列表中的碎片，且该碎片与某个峰匹配，Fragment Interpretation 窗口就会放大该
峰。

查看同位素

Fragment Interpretation 工具可以显示与碎片列表中的碎片相匹配的谱峰的理论同位素分布。

1. 单击 Explore > Show > Show Fragment Interpretation Tool。

2. 在 Fragment Interpretation 窗格中，单击 Options 选项卡。

3. 选择 Show Isotopes 复选框。

4. 单击 Apply。
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5. 从 Fragment List 中选择与谱峰匹配的碎片。

匹配谱峰的同位素分布在质谱中显示。

显示碎片的方程式差异

软件可显示两种相关假定碎片之间方程式和单同位素质量的差异。当选择两个峰时，会显示方
程式差异。当选择两个碎片或两个非环单键时，会显示方程式和单同位素质量的差异。

在质谱中显示方程式差异

1. 单击某个碎片峰。

2. 按住 Shift 键，然后选择另一个碎片峰。

如果方程式差异与碎片列表中的某个碎片相等，则该碎片在列表中会突出显示。否则，与峰
匹配的碎片之间的方程式差异就会在消息框中显示。

在碎片列表中显示方程式差异

1. 单击某个碎片的行号。

2. 按住 Shift 键，然后选择另一个碎片峰。

如果碎片有相关性，则方程式和单同位素质量差异就会在消息框中显示。

在分子结构中显示方程式差异

1. 单击一个非环单键。此时软件会选择（两个突出显示碎片中的）默认碎片。若要选择裂解键
的另一个碎片，请按住 Ctrl，然后单击化学键。

2. 选择一个第二非环键。若要选择默认碎片，按住 Shift 然后单击化学键。若要选择裂解键
的另一个碎片，请按住 Ctrl+Shift，然后单击化学键。

Fragment Interpretation 工具会计算步骤 1和步骤 2 中所选碎片之间的方程式和单同
位素质量差异，前提是这些碎片之间具有相关性。方程式和单同位素质量差异在消息框中显
示。

谱库数据库

Library Search 功能可以将未知质谱与谱库数据库内的已知 MS 质谱进行比较，并生成一份可
能的匹配项列表。

使用 Library Search 执行以下操作：

• 对照谱库内容比较未知质谱。

• 向谱库添加纪录。

• 编辑现有纪录。
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谱库数据存储在以下位置：

• 本地数据库的 MS Access

• MS SQL Server

在使用 Library Search 功能之前，确定谱库数据库的存储位置，然后将计算机连接至该位置。
谱库数据库可以在计算机上本地保存，或者保存在服务器上，并通过网络访问。

在现有谱库数据库之间切换

用户可以连接任何已设置别名的数据库。

1. 单击 Tools > Settings > Optimization Options。

Optimization Options 对话框随即显示。

2. 单击 Library Manager 选项卡。
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图 13-14 Library Manager 选项卡

3. 在 Available Libraries 部分单击要连接至的数据库的别名，然后单击 Connect。

4. 若要允许其他用户访问数据库，可勾选 Available to all users of this machine 复选
框。

5. 单击 OK。

连接本地谱库数据库

1. 单击 Tools > Settings > Optimization Options。

Optimization Options 对话框随即显示。

2. 单击 Library Manager 选项卡。

3. 在 Available Libraries 部分，单击 New。
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图 13-15 Add Library 对话框

4. 键入谱库的名称。

5. 在 Database Information 部分选择 MS Access (local)。

6. 键入数据库位置。

7. 在 Security Information 部分，如果用户名和密码是访问该数据库的必填项，则须键入用
户名和密码。

8. 单击 Save。

连接服务器谱库数据库

1. 单击 Tools > Settings > Optimization Options。

Optimization Options 对话框随即显示。

2. 单击 Library Manager 选项卡。

3. 在 Available Libraries 部分，单击 New。

4. 键入谱库的名称。
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5. 在 Database Information 部分选择 MS SQL Server (server)。

图 13-16 Add Library 对话框

6. 键入数据库服务器的名称。

7. 键入数据库的名称。

8. 在 Security Information 部分执行以下操作之一：

• 如果需要特定的用户名和密码才能访问该数据库，则请键入用户名和密码。

• 要使用 Windows 安全功能，请选择 Use Windows integrated security 选项。

9. 单击 Save。

使用谱库记录

如果在查询谱库内容时没有限制条件，系统便会列出所有记录。如果在查询谱库记录时有限制
条件，系统仅会列出与设定限制条件相符的记录。显示的记录数量由所选限制条件的数量来决
定。如果选择了很多限制条件，列出的记录就很少。
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查看所有谱库记录

• 单击 Explore > Library Search > List。

此时会出现 Librarian 对话框，并列出数据库中的所有记录。

用限制条件搜索谱库记录

1. 单击 Explore > Library Search > List With Constraints。

图 13-17 List Constraints 对话框

2. 在 Field Name 列表中，选择一个限制条件所依据的字段。

3. 在 Relation 列表中，选择应用到字段名称的关系（操作人员）。

4. 在 Value 字段中，键入基于所选关系的字段名称的值。

5. 若要将选定的限制条件添加到 Conditions 列表，单击 Add。

6. 根据需要继续向条件列表中添加限制条件。

7. 将各种独立的限制条件结合在 Conditions 列表中可以创建特定的条件，以便提高搜索效
率。

• 若要将限制条件进行组合，先选择好限制条件，然后单击 Group。

• 若要将组合的限制条件分开，单击该组，然后单击 Ungroup。
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8. 若要改变限制条件之间的关系，单击关系，然后单击 And 或 Or。

9. 若要排除含有一定数量的特定元素原子的化合物，可在 Elements Included 表中选择或键
入元素，然后键入元素原子数的最小值和最大值。

注释： 元素符号区分大小写。例如，氢的符号是 H 而不是 h，钠的符号是 Na 而不是 NA
或 na。

10. 若要排除含有某些元素的化合物，需在 Excluded 表中选择或键入元素。

11. 若要搜索符合设定条件的化合物，单击 List。

符合所有限制条件的记录在 Records 表中显示。列出的限制条件会被系统保存。

向谱库添加纪录

1. 右键单击一个处于激活状态的质谱，然后单击 Add a Record。

没有经过棒状图处理的质谱数据会自动进行棒状图处理。

此时会出现 Add a Record 对话框，对话框内有来自该质谱的数据。

2. 在 Mass Spectral Information 选项卡的 Compound Name 字段内键入一个名称。化合物名
称是强制性的，必须是谱库内化合物的唯一标识。

3. 编辑其他字段。很多字段都是用质谱关联数据自动填入的。

4. 单击 General Information 选项卡，根据要求编辑字段，然后单击 OK。

搜索相似质谱

用户可以针对某个与激活质谱匹配（或类似）的质谱及其相关化合物信息来搜索谱库。搜索可
以附带或不附带限制条件。附带限制条件搜索时，只有符合所有标准的记录才会列出。结果以
排序列表的方式显示。列表中的第一项是与激活质谱符合程度最高的项。列表中排名较低的条
目符合度较差。

选择的限制条件越多，列表就越精确，列出的项就越少，且相关程度越高。在定义一组限制条
件后，除非对它们进行编辑，否则它们将应用到所有后续搜索。

只有高于阈值的峰才会在搜索中被用到。选好搜索限制条件后，可以向激活质谱添加或从中删
除峰。比如，如果某个峰被认为是背景或噪声尖峰，则不应用它进行搜索，因为这会使结果不
准确。

在不附带限制条件进行搜索的情况下，会得到相当多的建议质谱列表，因为谱库对质谱数据的
特定匹配较少。

搜索相似质谱

1. 右键单击一个处于激活状态的质谱，然后单击 Search With Constraints。

软件将自动对质谱数据进行棒状图处理（如果需要）。
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图 13-18 Search Constraints 对话框

2. 在 Maximum Number of Match 字段中，键入希望搜索返回的最大化合物数量。

3. 在 Preselect Constraints 部分，选择将应用的限制条件的复选框。

4. 对选择的每一项限制条件，在 Preset Tolerance 部分键入允差。

5. 如有必要，从 Result Sorted by 列表中选择一种记录排列方法。

6. 如有必要，可在 Comment Contains 字段中键入说明文本。

7. 如有必要，可在 Keyword Contains 字段中键入说明文本。

8. 若要通过添加和删除峰的方式来应用峰限制条件，可单击 Peak Constraints。

此时 Peaks Included 表便会打开。

9. 若要将峰添加到您的搜索列表中，请单击 Add，然后在空单元格内键入 m/z 以及相应的强
度。
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10. 若要将峰删除，使之不在搜索范围内，请选中这些要从搜索中排除的峰，然后单击 Remove。

11. 单击 Search 保存限制条件，并开始搜索。

从搜索结果中查看化合物

如果有多个质谱与未知质谱匹配，则可以查看其他质谱，并与未知质谱进行比较。

1. 在 Search Results 对话框的化合物列表中，选择化合物的行号。

2. 单击某个已知化合物的质谱窗格。

此时会打开所选化合物的质谱。

谱库搜索提示

方法目的

选择组合条件，然后单击 Group。该功能的作用类似于
方程式中的括号。

谱库搜索：将条件进行组合

右键单击一个处于激活状态的质谱，然后单击 Search
Library。此时会出现 Search Results 对话框。

谱库搜索：不用限制条件搜索

在结果表中的任意位置单击右键，然后单击 Query >
Show All。您可以再次应用或编辑该查询。

对用来分析结果表中数据的查询，建议用户加以验证。

表专用查询：再次查看整个表

若要检查所有峰，需确定所有样本均已在结果表中列出。

Peak Review 窗口中含有结果表中列出的色谱峰。如果
表中隐藏了某些样本（例如应用了某个查询），这些样
本在峰检查过程中也会隐藏。

对用来分析结果表中数据的查询，建议用户加以验证。

峰积分：检查峰

在 Peak Review 窗格中的任意位置单击右键，然后单击
Show First Page。若要移至批次中的最后一个峰，在
Peak Review 窗格中的任意位置单击右键，然后单击
Show Last Page。

峰积分：移至批次中的第一个峰

在曲线中的任意位置单击右键，然后单击 Active Plot，
选择待绘制在上方的曲线。

检查校正曲线

选择 Display the Data Set(s) 复选框，然后在 Data
Point 列中双击代表峰的数据点。软件将打开带有选定
峰的 Peak Review 窗口。

样本统计数据检查：检查单个峰

在结果表中单击右键，然后单击 Sort > Sort By
Index。

结果表：使结果表回到原来的顺序

右键单击文件信息窗格，然后单击 Save Acquisition
Method。

采集方法：从文件信息窗格中创建一
个采集方法
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本部分介绍如何使用 Analyst® MD软件来分析和处理定量数据。也可以使用 MultiQuantTM MD
软件来处理数据。我们建议使用 MultiQuantTM MD软件来定量数据。请参阅随 MultiQuantTM MD
软件来处理数据。

使用 Example 文件夹中的样本文件，学习如何选择样本进行定量，如何选择预设查询和创建表
格特定查询，以及如何分析所采集的数据。欲获知更多关于下列主题的信息，请参阅《高级用
户指南》。

我们建议用户验证用来分析 Results Table 中数据的任何查询。

• 度量图表

• Results Table 布局

定量分析

定量分析用于确定样本中特定物质的浓度。通过分析未知样本并与包括已知浓度的相同物质的
其他样本（标准品）进行比较，Analyst® MD软件可以计算出未知样本的浓度。这个过程涉及使
用标准品创建一个校正曲线，然后计算未知样本的浓度。之后可以在 Results Table 中看到每
一个样本的浓度计算值。

定量方法

定量方法是用于生成样本谱峰的一组参数。定量方法可以包括用于谱峰定位和积分、生成标准
曲线和计算未知浓度的参数。可以从批次的 Quantitation 菜单中选中先前保存的定量方法。

以下三种工具可用于创建定量方法：Quantitation Wizard、Build Quantitation Method 和
Quick Quant。

创建定量方法

Build Quantitation Method 无法生成定量 Results Table，但随后可以在 Quantitation
Wizard 中使用此方法创建 Results Table。Build Quantitation Method 也可用于改变现有的
定量方法。这是创建定量方法的最灵活的方式。请参阅使用定量方法编辑器创建一种方法。

定量向导

借助 Quantitation Wizard，可同时生成 Results Table 与定量方法。另外，现有定量方法可
用于定量不同的数据集。
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快速定量

不建议在结果定量中使用 Quick Quant。

Quick Quant 是 Batch Editor 的一部分。在数据采集之前使用 Quick Quant 添加化合物浓
度。因为尚未采集到样本，所以无法选择有代表性的样本，也不能对各质谱峰进行评估。在此
过程中仅需定义方法构成。

如果使用 Quick Quant 功能在数据文件中存储样本类型和浓度，不得使用自动生成的 Quick
Quant 方法执行定量分析。此定量方法不会使用已针对谱峰选择而进行了优化的化合物和样本
特异性积分参数。

要使用先前保存的定量方法，请从批次的 Quantitation 菜单中将其选中。有关创建批次的操
作说明，请参阅创建并提交批次。

定量方法和结果表

对于以下过程，请使用与 Example 文件夹一起安装的样本数据。Triple Quad 文件夹包含数据
文件 Mix_Batch_1 and Mix_Batch_2。这些样本文件用于证明公制图解在分离问题样本方面的
有效性。扫描到的离子为利血平 (609.3/195.0)、米诺地尔 (210.2/164.2)、甲苯磺丁脲
(271.1/91.1) 和利血胺 (635.3/221.2)，即为内标。Mix_Batch_1 在样本制备方面没有错误，
而 Mix_Batch_2 包含一份添加了两次内标的质量控制样本（样本 QC2）。

使用定量方法编辑器创建一种方法

注释： 我们建议用户验证用来分析结果表中数据的任何查询。

前提条件

• 选择包含待定量数据的项目。

• 在项目和子项目之间切换

1. 确认已选中 Example 文件夹。

2. 在导航栏 Quantitate 项下，双击 Build Quantitation Method。

Select Sample 对话框即会打开。

3. 双击 Data Files 列表中的 Triple Quad。

4. 选择 Mix_batch_2.wiff。

所选数据文件中的样本都显示在 Samples 列表中。

注释： 如果在采集方法中已填充样本和内标的 Compound ID 字段，则在 Internal
Standards 表中，当 Q1/Q3 字段中的值已选定时，Name 字段会自动填充。

5. 选择一个样本，从而提供一个可检测信号以便选择能够适合整个批次的积分参数，然后单击
OK。
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6. 在 Internal Standards 表的 Name 一列中，选择利血胺。在 Q1/Q3 列中，选择 635.3/
221.2。

7. 在 Analytes 表中，执行以下操作：

a. 在 Name 一列中，为 210.2/164.188、271.3/91.146 和 609.4/195.039 的Q1/Q3 列质
量分别选择米诺地尔、甲苯磺丁脲和利血平。

b. 在 Internal Standard 列中，从列表中选择利血胺作为与每个分析物相关的内标。

c. 从 Analytes 表的 Q1/Q3 列中删除 635.4/221.185。

注释： 如果在采集方法中样本和内标的 Compound ID 字段已填充，则在 Analytes 表中，
Name 字段和 Q1/Q3 字段也已填充。

8. 单击 Integration 选项卡。

预设积分参数适用于大多数的峰。

9. 若积分不适用，则更改算法。请参阅对峰进行手动积分。

10. 单击 Show or Hide Parameters 图标以显示额外的积分算法。

11. 单击 Calibration 选项卡。

预设参数适用于这些样本。用户可以根据特定应用更改拟合方法、权重和回归参数。

12. 保存此定量方法。

当在 Batch Editor 中创建一个批次或用 Quantitation Wizard 生成一个 Results Table
时，可以使用这一新方法。

提示！ 此定量方法只能在当前项目中使用，除非将它复制到另一个项目。要执行此操作，
请单击 Tools > Project > Copy Data。必须创建一个新的项目，并选定以供使用。

使用定量向导创建结果表

注释： 我们建议用户验证用来分析结果表中数据的任何查询。

前提条件

• 选择包含待定量数据的项目。

• 在项目和子项目之间切换

1. 在导航栏 Quantitate 项下，双击 Quantitation Wizard。

打开 Create Quantitation Set - Select Samples 页面。

2. 双击 Triple Quad 文件夹中的 Available Data Files 列表。

3. 选择 Mix_batch_2.wiff。
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4. 单击 Add All。

注释： 我们建议用户不要处理或报告任何采集异常或意外终止样本的结果。

5. 单击 Next。

打开 Create Quantitation Set - Select Settings & Query 页面。

6. 单击 Select Existing: Query 中的 Default Query 部分。

7. 从 Query 列表中选择 Accuracy 15%。

注释： 若要同时创建查询，请参阅创建一个标准查询（可选）。

注释： 用户有责任对要用于特定应用的查询进行评估和验证。

8. 单击 Next。

打开 Create Quantitation Set - Select Method 页面。

9. 单击 Choose Existing Method。

10. 从 Method 列表中选择 PK Data_Mix.qmf。

11. 单击 Finish。

打开 Results Table。

提示！ 添加或删除 Results Table 中的样本，单击 Tools > Results Table > Add/Remove
Samples

12. 查看样本类型、实际浓度、峰积分、校正曲线、统计窗格、内标物的度量图表以及其他与数
据定量有关的信息。

13. 保存 Results Table。

注释： 如果 Results Table 包括文件中的样本，我们建议用户不要更改数据文件 (wiff)
的名称。

提示！ 可使用 Reporter 软件从 Results Table 中创建格式良好的报告。如果使用包含
查询的 Reporter 模板，我们建议用户对结果进行验证。请参阅Reporter 软件。

创建一个标准查询（可选）

高级用户可以通过多种方式来创建查询和标准查询。下面是一个示例。有关创建查询的更多信
息，请参阅 Help。

我们建议用户验证用来分析 Results Table 中数据的任何查询。

1. 在导航栏 Quantitate 项下，双击 Quantitation Wizard。
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2. 打开 Create Quantitation Set - Select Samples 页面。

3. 单击 Next。

4. 在 Select Settings & Query 页面的 Default Query 部分中，选择 Create New Query。

5. 键入查询的名称。

图 14-1 Create Quantitation Set - Select Settings & Query 页面

6. 单击 Next。
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图 14-2 Create Quantitation Set - Create Default Query 页面

7. 在 Maximum Allowed Accuracy Variation for QCs (%) 表的 Max.Variation 列中，在与
相应浓度相同的行中键入各质量控制的最大允许变化百分比（例如，5 是 ± 5%）。如果采
集过程中未指定浓度，那么在此处则不会显示它们。在这种情况下，在 Concentration 列
中键入这些值。

8. 在 Maximum Allowed Accuracy Variation for Standards (%) 表的 Max.Variation 列中，
在与相应浓度相同的行中键入各标准的最大允许变化百分比（例如，10 是 ± 10%）。如果
采集过程中未指定浓度，那么在此处则不会显示它们。在 Concentration 列中键入浓度。

9. 单击 Next。
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图 14-3 打开 Create Quantitation Set - Select Method 页面

10. 选择或创建一种方法。

11. 单击 Finish。

该查询作为标准查询应用。查询结果在 Results Table 的 Standard Query Status 列中显
示为 Pass 或 Fail 条目。

提示！ 要返回完整视图，右键单击，然后单击 Full。

定义结果表的版面

结果表的预定义视图可以使用。

• 在结果表中单击右键，然后单击以下其中一项：

• 若要查看全部版面，单击 Full。

此时会显示所有分析物。

• 若要查看概况版面，单击 Summary，然后单击字段名称。

• 若要查看分析物版面，单击 Analyte，然后单击某个分析物（如果分析物不止一种）。

• 若要查看分析物组版面，单击 Analyte Group，然后单击某个分析物组。
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提示！ 首先必须新建一个分析物组。若要这么做，可在结果表中单击右键，然后单击
Analyte Group > New。

提示！ 若要返回全视图，单击右键，然后单击 Full。

表格与选定版面一起显示。

在结果表中排列数据

结果表中的数据可以采用以下方式排列：

• 用 Sort 按钮对表中的 1-3 列迅速排序。排序标准无法保存。

• 创建一个表专用排序，将排序标准与当前表一起保存。表专用排序允许用户对当前表中的
1-3 列排序，并保存该表所使用的排序标准。

• 使用以前创建的预设排序。用户可以创建并保存一个排序，随后将其应用到结果表中。

提示！ 若要保存排序或任何其他表设置，在结果表中单击右键，然后单击 Table Settings
> Export To New Table Settings。排序和其他参数可以在当前项目中使用。若要在其他项
目中使用表设置，将其复制到其他项目中。单击 Tools > Project > Copy Data。必须创建
一个新的项目，并选定以供使用。

对结果表排序

1. 在结果表中选择最多 3 列，按顺序排列。

2. 执行以下操作之一：

• 若要按升序排列，单击 A-Z。

• 若要按降序排列，单击 Z-A。

对结果表排序并保存排序标准

1. 在结果表中单击右键，然后单击 Sort > New。
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图 14-4 Sort 对话框

2. 在 Name 字段中，键入新排序的名称。

3. 对于每一条排序规则，在 Sort By 和 Then By 部分进行下列操作：

• 在 Group 列表中，选择要排序的列类型。

• 在 Column 列表中，选择要排序的列。

• 选择排列的方向：Ascending 或 Descending。

4. 执行以下操作之一：

• 若要进行排序、保存排序标准，并关闭 Sort 对话框，单击 Save/Execute。

• 若要执行排序并关闭 Sort 对话框而不保存排序标准，单击 Execute。

保存默认排序标准供以后的结果表使用

1. 单击 Tools > Settings > New Quantitation Results Table Settings。
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图 14-5 Table Settings 对话框

2. 展开 Table Settings 文件夹，然后双击 Default 文件夹。

3. 在展开后的 Default 文件夹中选择 Sorts 文件夹，然后单击 New。

图 14-6 Sort 对话框

4. 在 Name 字段中，键入新排序的名称。

5. 对于每一条排序规则，在 Sort By 和 Then By 部分进行下列操作：

• 在 Group 列表中，选择要排序的列类型。
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• 在 Column 列表中，选择要排序的列。

• 选择排列的方向：Ascending 或 Descending。

6. 若要保存标准并关闭 Sort 对话框，单击 OK。

7. 若要关闭 Table Settings 对话框，单击 Done。

用预设排序标准对结果表排序

• 在结果表中单击右键，单击 Sort，然后选择排序名称。

Results Table 右键菜单

右键单击 Result Table 可访问表 14-1 中所示的选项。

表 14-1 Results Table 右键菜单

功能菜单

显示所有列。Full

显示特定列。Summary

显示一种特定分析物。Analyte

创建一个分析物组。Analyte Group

显示一个特定类型的样本或所有样本。Sample Type

添加公式列。

如果使用了公式列，我们建议用户对结果进行验证。

Add Formula
Column

编辑或选择一个表设置。Table
Settings

创建或选择一个查询。

我们建议用户验证用来分析 Results Table 中数据的任何查询。

Query

创建一个类别或按索引分类。Sort

创建一个度量图表。Metric Plot

删除当前窗格。Delete Pane

复制相同数据至选定单元格。Fill Down

添加自定义列。Add Custom
Column

删除自定义列。Delete Custom
Column
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谱峰检查和谱峰的手动积分

使用谱峰检查检验该软件已确定的谱峰，然后重新定义谱峰或起点和终点（如果需要）。

识别出软件必须找到的分析物和内标物后，软件会搜索样本中的谱峰。当软件识别出一个谱峰
时，它会显示 Standard Wizard 的 Create Quantitation Method: Define Integration 页面
或 Full Method Editor 的 Integration 选项卡上每一种分析物和内标物的色谱图。用户可以
确认已发现的谱峰或更改定量方法，以便更好地定义谱峰。我们建议用户手动检查所有的积分
结果。

检查峰

在检查峰的过程中，用户可能希望查看完整的谱峰或检查基线，了解软件在寻找峰起点和终点
方面的表现如何。自动缩放功能可用于实现上述目标。

要帮助软件寻找谱峰，手动定义谱峰的确切起点和终点以及背景。除非更新通用方法，否则这
些变化将只应用于单个谱峰。

注释： 我们建议对手动积分的结果进行验证。

提示！ 要查看单个谱峰，右键单击曲线上的一个点，然后单击 Show Peak。软件将打开带有
选定峰的 Peak Review 窗口。

1. 右键单击 Results Table，然后单击 Analyte。

2. 选择一种分析物。

3. 单击 Tools > Peak Review > Pane。

峰显示在 Results Table 下方，其中仅包含仅在 Results Table 中列出的峰。
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图 14-7 峰检查

4. 右键单击该窗格，然后单击 Options。

5. 在 Peak Review Options 对话框的 Appearance 部分，更改 Num.rows 为 1，更改
Num.columns 为 2。

6. 在 Automatic Zooming 部分中，单击 Zoom Y axis to: 100% of largest peak，显示整个
峰。
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图 14-8 Peak Review Options 对话框

定义项目

行数1

列数2

Zoom Y-axis to 100% of largest peak，显示整个峰3

7. 单击 OK。

8. 要穿过峰，单击向右箭头。请参阅图 14-9 和图 14-10。

9. 转到标准品 3 的第二次注射。

在此示例中，通过选择 Specify Parameters 选项，可以对峰进行积分，使之更接近于基
线。

提示！ 要在 Peak Review 窗格中移动到特定的峰，在 Results Table 中选择相应的行。
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图 14-9 Peak Review 窗格

图 14-10 Peak Review 窗格
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定义项目

箭头：单击此处，在峰之间切换。1

显示或隐藏参数：单击，显示积分参数。2

积分参数：单击，更改参数。3

噪声百分比：键入一个噪声百分比。4

应用：单击后对参数进行积分。5

10. 单击 Show or Hide Parameters 两次。

11. 单击 Specify Parameters - MQ III。

12. 更改 Noise Percent 的值。

13. 单击 Apply。

对峰进行积分，使之更接近于基线。

14. 如果更改并未改善峰积分，那么调整 Noise Percent 直到找到最优值。

注释： Update Method 功能只能更新特定分析物（或内标）的算法值，而非所有分析物的
算法值。

15. 要更新所有峰的算法，右键单击窗格，然后单击 Update Method。

图 14-11 Update Method
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对峰进行手动积分

最后应对峰进行手动积分，以限制人与人之间的变化性。仅在调整和更新算法参数后观察不到
所有的峰时，对峰进行手动积分。我们建议用户对结果进行验证，以确定手动积分是否适用于
特定应用。

注释： 与样本算法参数发生改变但并不适用于整个分析物组的峰一样，进行手动积分或仅针
对本身而改变算法的峰会标识在 Results Table 的 Record Modified 列中。

1. 在 Peak Review 窗格中，单击 Manual Integration Mode。

图 14-12 Peak Review 窗格：手动积分

2. 放大显示峰下部的 10%。

图 14-13 Peak Review 窗格：放大显示峰

3. 将十字线移至要界定的峰起始位置，然后将十字线拖至要界定的峰终止位置。

软件会罩住由峰基部和两侧界定的区域。峰参数为灰色，因为它们不再适用，原因在于该峰
由手动绘制而成。

4. 执行以下操作之一：
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• 要使此更改永久有效，请单击 Accept。

• 要放弃这些更改，请取消选中 Manual Integration 复选框。

提示！ 如果最初选择的峰正确，那么请右键单击该峰，然后单击 Revert to Method。

Peak Review 右键菜单

在 Peak Review 窗口或窗格中右键单击可访问表 14-2 中所示的选项。

表 14-2 Peak Review 右键菜单

功能菜单

打开 Peak Review Options 对话框。Options

打开 Sample Annonation 对话框。Sample
Annotation

将所选择的峰保存为文本文件。Save Active to
Text File

显示第一个样本。Show First Page

显示最后一个样本。Show Last Page

打开幻灯片。Slide Show Peak
Review

更新所有峰的算法。Update Method

选择一个根据当前定量方法重新确定的峰。Revert to
Method

删除当前窗格。Delete Pane

校正曲线

使用校正曲线，找到样本的计算所得浓度，包括质量控制 (QC) 样本。将质量控制样本添加至
某一批次中，以估测该批次中标准品的数据质量和准确性。已知质量对照样本的分析物浓度，
但这些值会被视为未知量，以便将测得的浓度与实际值相比较。

校正曲线是通过绘制标准浓度-面积或高度曲线而生成的。如果使用内标，那么使用标准浓度与
内标之比相对于标准峰高度或面积与内标峰高度或面积之比进行绘图。然后将样本的面积或高
度比应用到此曲线，找到样本浓度，如结果表中所示。回归方程是由校正曲线根据指定的回归
分析生成的。回归方程用于计算未知样本的浓度。

建议线性回归用于校正曲线。

我们建议用户不报告落在校正曲线所覆盖浓度范围以外的定量值。
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查看校正曲线

用户可以查看校正曲线，并在打开的 Results Table 中更改回归选项。如果打开了两个或两个
以上的 Results Table，则可以叠加校正曲线。要叠加曲线，确保用于创建表的方法是相同的。

绘制校正曲线，查看用于回归分析的曲线。Results Table 中 Calculated Concentration 字
段可以反映拟合曲线受标准品点影响所发生的任何变化。

注释： 仅当 Results Table 打开时，此选项才可供使用。

1. 打开一个 Results Table。

2. 单击 Tools > Calibration > Pane。

包含校正曲线的 Calibration Curve 窗格即会打开。

图 14-14 校正曲线

3. 如果有一种以上的分析物，那么使用以下步骤查看另一种分析物的校正曲线：

a. 从 Analyte 列表中，选择一种分析物。

b. 如果需要，从下一个列表中，选择 Area 或 Height。

4. 要更改校正曲线的回归选项，请执行以下操作：

a. 单击 Regression。

图 14-15 Regression Options 对话框
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b. 在 Fit 列表中选择 Linear。

c. 在 Weighting 列表中选择 1/x。

d. 单击 OK。

校正曲线打开。用户可以查看曲线上的各个峰或从曲线中排除点，以便生成更好的曲线。

5. 如果需要，重复这些步骤，创建更合适的曲线。

6. 要保存这些更改，单击 Accept。

叠加校正曲线

提示！ 为了更仔细地检查表格的曲线，右键单击曲线，然后单击 Active Plot。选择要在顶
部绘制的曲线

1. 有两个或更多 Results Tables 是打开的，查看其中一个表的校正曲线。

2. 右键单击校正曲线，然后单击 Overlay。

图 14-16 Overlay 对话框

3. 选择与当前曲线叠加的表格。

4. 单击 OK。

该软件在同一图上绘制出所有选定表格的曲线。

校正曲线右键菜单

右键单击 Calibration 窗口或窗格可访问表 14-3 所示的选项。
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表 14-3 校正曲线右键菜单

功能菜单

右键单击一个点然后单击 Exclude，可从曲线中排除该点。右键单
击一个点然后单击 Include，可该点计入在内。

Exclude (Include)

右键单击一个点然后单击 Exclude All Analytes，可从曲线中排
除所有分析物。右键单击一个点然后单击 Include All Analytes，
可将这些点计入在内。

Exclude All Analytes
(Include All Analytes)

检查单个峰。Show Peak

叠加两个图。Overlay

确定哪一图解是有效的。Active Plot

显示图例。Legend

X 轴使用对数刻度。Log Scale X Axis*

Y 轴使用对数刻度。Log Scale Y Axis*

删除当前窗格。Delete Pane

将图形恢复到其原始大小Home Graph

* 利用对数刻度可在更易于管理的视图中布置数据点，以便可同时监测所有点的影响。在此
视图中，所选的是 Log Scale Y Axis - Log Scale X，而非只对一轴取对数。

样本统计数据

使用 Statistics 窗口查看统计样本，通常适用于标准液和 QC（质量对照液）。在网格中以列
表形式打开 Results Table 中各个可用批次的数据，每一标准和质量对照浓度的数据显示为一
行。

我们建议将批次统计数据纳入报告，确保结果的有效性。

查看标准和质量控制的统计数据

当打开一个以上的 Results Table 时，即可获取 Statistics 窗口中关于其他批次的标准和质
量控制的统计信息。这有利于比较批次之间的结果和鉴定标准或质量控制的趋势。

1. 打开一个 Results Table。

2. 单击 Tools > Statistics。

3. 从 Statistics Metric 列表中选择 Concentration。

4. 在 Analyte Name 字段中选择一种分析物。

5. 在 Sample Type 字段中选择 Standard。

显示结果。
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6. 看一下 %CV 和 Accuracy 列。

%CV 显示的是单个参数测量值之间的变异系数，例如面积。准确性表示的是标绘点距离内插
值的远近程度。

7. 如果需要，选中 Display Low/High values 复选框，然后检查网格中每一行的 Low、High
和 Mean。每一行代表具有相同浓度水平的标准。

8. 选择另一种分析物。

按每一种分析物显示结果。

9. 要检查相同浓度水平下的 Quality Control 变化，在 Sample Type 字段中选择 QC。

度量图表

度量图表以图形方式，在 X 轴或 Y 轴上显示结果表列中的数据，或者将两列中的数据彼此对
照绘制成图。本节主要介绍如何生成并使用度量图表。

一些预定义的度量图表也包括在内：

• Int_Std_Response（用于找到问题样本）

• Analyte_Area versus Height（用于验证色谱图行为）

• PK profile（浓度与时间点对照，在样本查询后运行）

生成度量图表

使用度量图表可绘制指定列的图，如结果表中的 Analyte Peak Area、Accuracy 或 Calculated
Concentration。也可以用结果表的两个字段彼此对照绘制成图，然后使用此图表检查位于正常
范围之外的数据点。度量图表经常与查询一起使用。有关查询的更多信息，请参阅帮助。

通过以下方式生成度量图表：

• 用 Plot 键绘制当前结果表中的一列或多列数据的图表，但不保存绘图标准。

• 创建一个表专用图表，将绘图标准与当前表一起保存。

• 创建一个通用图表，保存绘图标准，供今后的结果表使用。

校正曲线上不显示 QC 样本、未知样本、空白样本、双空白样本或溶剂，但可以生成它们的度
量图表。
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图 14-17 度量图表示例

描述项目

双空白样本1

生成临时度量图表

1. 在结果表打开的情况下，采取以下某一项操作：

• 若要沿 Y 轴绘制数据图表并以 X 轴为参照，单击要绘制的数据列的题头。

• 若要以选定的第一列为 X 轴、以选定的第二列为 Y 轴开始绘图，按住 Ctrl 键并单击
列题头，选择两个数据列。

2. 单击结果表上方的 Metric Plot by Selection 图标。请参阅 表 D-10。

此时度量图表便会打开。

3. 在图表窗格中单击右键，然后单击 Data Legend 查看图表中所用颜色的相关说明。

4. 在图表窗格中单击右键，然后单击 Point Legend 查看图表中所用符号的相关说明。

创建度量图表并保存绘图标准

1. 打开相应的 Results Table。

2. 在 Results Table 中单击右键，然后单击 Metric Plot > New。
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图 14-18 Metric Plot 对话框

3. 在 Name 字段中，键入新绘图标准的名称。

4. 在 X-Axis 部分的 Group 列表中，若要在 Y 轴上绘制某个字段的图表，并以 X 轴为参照，
选择 Index 并将 Column 列表留空。

5. 若要将两列数据彼此对照进行绘图，请在 Y-axis 部分的 Group 列表中选择 Internal
Standard，然后在 Column 列表中选择 IS Peak Area。

6. 如有必要，在 Regression 列表中，选择要使用的回归类型，然后选择相应的回归设置。

7. 若要生成图表并保持绘图标准，单击 Save/Execute。

此时度量图表便会打开。详情请参阅 图 14-17。

8. 在图表窗格中单击右键，然后单击 Data Legend 查看图表中所用颜色的相关说明。

9. 在图表窗格中单击右键，然后单击 Point Legend 查看图表中所用符号的相关说明。

此时可通过 Results Table 的右键菜单将该标准集合用于该 Results Table 以后的绘图操
作。用户也可以编辑绘图标准。

10. 若要查看有问题的样本，可尝试对照时间来绘制未知样本的浓度图，或者对照索引绘制内标
物的面积。
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保存默认绘图标准供以后的结果表使用

1. 在结果表中单击右键，然后单击 Table Settings > Export To New Table Settings。

这样就可以从 rdb 文件中导出结果表设置，从而可以在项目内的其他定量运行中重复使用。

2. 若要将表设置导出到其他项目，单击 Tools > Project > Copy Data。

图 14-19 Copy Data 对话框
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Reporter 软件扩展了 Analyst® MD 软件来处理数据。

小心： 潜在的错误结果。

• 我们建议用户在使用前对所有 Reporter 查询进行验证。

• 如果使用经过修改或包含查询的 Reporter 模板，我们建议用户对结果进行验证。

• 我们建议用户确保完成对 Reporter 模板的验证。

Reporter 软件可用于利用 Microsoft Word 和 Excel（2010、2013 或 2016）创建自定义报
告。Reporter 软件具有以下功能：

• 提供各种利用 Results Table、文件信息以及定量峰检查窗口中的数据编写而成的报告。

• 提供各种展现 MS/MS 谱库搜索结果的报告。用户可以将 Reporter 软件配置为针对使用
Analyst® MD(mdb) 格式的任何 MS/MS 谱库进行搜索。

• 使用 Microsoft Word 模板提供生成报告时所需的格式信息。可以创建或修改这些模板，以
提供自定义的报告格式。有关创建或编辑 Report Template Editor 的信息，请参阅 Help。

• 包含一个空白起始模板，可在 Analyst® MD 软件的 Reporter 编辑环境下使用，用于设计
满足大多数报告要求的报告模板。

• 自动打印，导出为 Adobe Portable Document Format (pdf) 以及通过电子邮件传输结果。

• 从使用现有 Analyst® MD 软件编程库的自定义软件应用程序中生成报告。

Reporter 软件可用于以下各方面：

• 在 Analyst® MD 软件中手动生成报告或报告集。

• 通过不使用 Analyst® MD 软件来处理数据。
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Analyst Reporter 用户界面

图 15-1 Analyst Reporter

描述选项项目

退出程序并释放所有资源。File > Exit1

设置语言字典，用于替换报告模板中的语言标签。包含语
言标签的模板可用于生成任何语言的报告。语言标签被替
换为来自所选语言的字典文件中匹配的标签文字。这些字
典文件包含在以下文件夹中：C:\Program Files\AB
SCIEX\AnalystReporter\Resources\Languages（Windows
7，32 位操作系统）或 C:\Program Files (x86)\AB
SCIEX\AnalystReporter\Resources\Languages（Windows
7，64 位或 Windows 10，64 位操作系统）。

Settings >
Select Output
Language

2

浏览谱库。该谱库将用于匹配和记录来自结果表的 MS/MS，
其中含有来自信息关联采集 (IDA) 触发的 MS/MS 扫描类
型的数据。

Settings >
Select Library

2

设置将从中读取可用模板的文件夹。若要返回到默认的模
板文件夹，请选择 Default 选项。

Settings >
Select Template
Folder

2

显示有关当前安装的 Reporter 软件的版本信息。Help > About3
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描述选项项目

显示当前选定的用于替换报告模板中的语言标签的语言字
典。可利用 Settings > Select Output Language 来选择
语言字典。

Current Output
Language

4

显示当前所选谱库。可利用 Settings > Select Library
来选择谱库。

Current Spectral
Library

5

显示可用的报告模板的列表。选择一种模板将显示对该模
板的说明。若要更换从中读取可用模板的文件夹，请选择
Settings > Select Template Folder > Browse。

Available
Templates and
Description

6

显示 Reporter 软件支持的输出格式。仅会启用与所选报
告模板兼容的格式。

• Word：生成 Microsoft Word 文档 (docx)。本文档可以
通过 Microsoft Word 2010 及以上版本进行查看。

• PDF：直接以 PDF 格式创建报告。

• HTML：使用 Microsoft Word 生成 HTML 文件。相关图
像文件存储在与 HTML 文件具有相同名称的文件夹中。

• Excel：生成纯文本文件 (csv)。可以在 Microsoft
Excel 中打开包含由逗号分隔的值的报告模板，每个值
将显示在一个单独的单元格内。只有那些明确标记为文
本兼容的模板才可用于这个输出格式。

• Text：生成纯文本文档 (txt)。只有那些明确标记为文
本兼容的模板才可用于这个输出格式。

Output Format7

创建报告后，在选定打印机打印报告。选择任何可用的打
印机。

Print
Automatically

8

使用选定的报告模板，以选定的输出格式创建报告。Create Report9

退出程序并释放所有资源。Close10

生成报告

Reporter 软件会从 Results Tables 中提取数字型数据，并从 wiff 文件中提取样本和图形信
息。

在 Available Template 字段中选择一个模板。

1. 打开一个 Results Table。

2. 在 Companion Software 下，双击 Reporter。

3. 在 Analyst Reporter 对话框的 Available Templates 字段中，选择适用的报告模板。

4. 单击 PDF 输出格式。
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Word 选项是预先选定的，报告将自动保存在当前项目 Results 文件夹中。如果未选定此选
项，则报告会以 Word 格式创建和打开或以选定的格式打印，但报告不会保存。这可以让用
户在保存原始报告之前编辑 Word 格式的报告。

5. 如果使用的 Results Tables 包含来自信息关联采集 (IDA) 所触发 MS/MS 扫描类型的数
据，则可选择用于谱库搜索（定性）工作流：单击 Settings > Select Library，导航至相
应的 MS/MS 谱库数据库（mdb 格式），然后单击 Open。

6. （可选）要在预选打印机上自动打印报告，请选中 Print Automatically 复选框。

除非选择了另一台打印机，否则使用 Windows 中的 Default Printer 设置。Reporter 工
具在各操作之间会保留的所选打印机。如果打印机被设置为 PDF 打印机驱动程序，那么
Reporter 会自动生成 PDF 文件版本的已创建报告。

7. 单击 Create Report。

当工具打开模板并使用 Results Table 数据填充时，屏幕上会显示不同进度指示器。一些
报告可能需要数秒即可生成，其他报告可能需要更长的时间。包含许多多反应监测离子对或
大量图形的大数据集可能会生成需耗时数小时才能完成的数百页报告。
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定期清洁和维护系统以保持最佳性能。

警告！ 触电危险。切勿拆除保护盖。拆除保护盖可能会导致人员受伤或系统故
障。进行例行维护、检查或调整时不需要拆下保护盖。当修理需拆下主盖时，
请与 SCIEX 现场服务工程师 (FSE) 联系。

警告！ 电离辐射危害、生物危害或有毒化学品危害。在清洁或维护质谱仪之
前，确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，
在清洁或维护之前客户必须先消除系统污染。

建议的维护计划

表 16-1 提供了用于清洁和维护系统的推荐计划。

提示！ 定期进行维护工作，保证质谱仪在最佳情况下运行。

有关调谐频率的信息，请参阅 操作说明 - 调谐和校正。

请联系合格维护人员 (QMP) 订购耗材件，并了解基本维修和维护要求。请与 SCIEX 现场服务
工程师 (FSE) 联系，了解所有其他维修和维护要求。

注释： 对于部件号，请参阅质谱仪的《部件和设备指南》。

表 16-1 维护任务

欲了解更多信息……任务频率组件

系统

如果管路有泄漏或堵塞，请参阅
更换样本导管。有关处理和清除
泄漏的信息，请参阅 化学品注
意事项。

检查管线和管
件，以确保其连
接牢固且无泄
漏。

每日管线

质谱仪
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表 16-1 维护任务 （续）

欲了解更多信息……任务频率组件

请参阅 清洁气帘板。当日常清
洁无法提高灵敏度时，必须进行
全面清洁。联系合格维护人员或
现场服务工程师。

清洁每日气帘板

请参阅 清洁锥孔板的前部。清洁每日锥孔板（前部）

请参阅 检查低真空泵油位。检查油位每周低真空泵油

联系当地的合格维护人员或现场
服务工程师。

更换每 6 个月质谱仪空气过滤
器

联系当地的合格维护人员或现场
服务工程师。

更换Sogevac SV28 BI：每
年。Sogevac SV28 ES：
每三年或根据需要。

低真空泵油

请参阅 清洁表面。清洁根据需要仪器表面

请参阅 清空离子源废气排放瓶。清空根据需要离子源废气排放
瓶

联系当地的合格维护人员或现场
服务工程师。

清洁根据需要锥孔板（前部和
后部）

联系当地的合格维护人员或现场
服务工程师。

清洁根据需要QJet®离子导向
器和 IQ0 透镜

联系当地的合格维护人员或现场
服务工程师。

清洁根据需要Q0 杆装置和
IQ1 透镜

联系当地的合格维护人员或现场
服务工程师。

加注根据需要低真空泵油

联系当地的合格维护人员或现场
服务工程师。

更换根据需要接口加热器

离子源

请参阅 取下探针和安装探针。更换根据需要TurboIonSpray®

和 APCI 探头

请参阅 更换喷针。检查和更换根据需要TurboIonSpray®

和 APCI 喷针

请参阅 更换电晕放电针。更换根据需要电晕放电针

联系当地的合格维护人员或现场
服务工程师。

更换根据需要涡轮加热器

请参阅 连接离子源导管。更换根据需要样本管线

对于“根据需要”任务，请遵循以下指导准则：
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• 在溢出或质谱仪表面变脏后，清洁质谱仪表面。

• 在排放瓶装满前清空该瓶。

• 如果系统的灵敏度降低，清洁锥孔板、QJet®离子导向器和 Q0 区域。

提示！ 定期清洁 Q0 区，以尽量减少放电现象（在很短的时间内相关离子的灵敏度出现明
显降低）对四极杆和透镜的影响。联系合格维护人员或现场服务工程师。

• 如果系统的灵敏度降低，清洁 QJet®离子导向器和 Q0 区域。

提示！ 定期清洁 Q0 区，以尽量减少放电现象（在很短的时间内相关离子的灵敏度出现明
显降低）对四极杆和透镜的影响。联系合格维护人员或现场服务工程师。

• 当油位低于最低水平时，请再向低真空泵注油。

清洁表面

在溢出或质谱仪外表面变脏之后，请清洁质谱仪外表面。

小心： 可能导致系统损坏。只能使用推荐的清洁方法和材料，以避免损坏设备。

1. 用一块浸湿温肥皂水的软布擦拭外表面。

2. 用一块浸湿水的软布擦拭外表面，从而去除任何的肥皂残留。

清空离子源废气排放瓶

警告！ 电离辐射危害、生物危害或有毒化学品危害。将有害物质存放在有标
记的废液容器中，并根据当地法规进行处置。

警告！ 电离辐射危害、生物危害或有毒化学品危害。请小心将废气排至专门的
实验室通风橱或排气系统，并确保通风管道已用夹子固定牢靠。确保实验室具
有适合所执行工作的适当换气措施。

定期检查离子源废气排放瓶，并在其装满前将其清空。同时检查排放瓶及其接头有无泄漏，并
在必要时拧紧连接件或更换组件。按照本规程中的步骤清空排放瓶。

1. 取出离子源。请参阅 取下离子源。

2. 松开将软管连接到离子源废气排放瓶盖的夹具。
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图 16-1 离子源废气排放瓶

描述项目

通风口连接1

离子源废气排放管：内径 (i.d.) 为 2.5 cm（1.0 英寸）2

低真空泵排气软管：内径为 3.2 cm（1.25 英寸）3

离子源废气排放瓶。确保瓶子已固定牢靠，以免溢出。4

连接至质谱仪：内径为 1.6 cm（0.625 英寸）5

注释： 排液瓶、质谱仪和实验室通风口处的离子源排气软管接头用软管夹固定。

3. 从瓶盖上拔下软管。

4. 将排放瓶拿到固定架外。

5. 取下排放瓶上的瓶盖。

6. 清空排放瓶，然后根据实验室规程和当地废弃物法规处置废弃物。

7. 在瓶子上安装瓶盖，然后把瓶子放在支架里。

8. 将软管与瓶盖相连，然后用夹子将软管紧紧固定住。
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清洁前端

以下警告适用于本节所有程序：

警告！ 高温表面危害。在开始任何维护程序之前，先让离子源冷却至少 30 分
钟。在操作过程中，离子源和真空接口组件的表面会发烫。

采用日常清洁方法清洁质谱仪前端，以便达到以下目的：

• 最大限度地减少计划外的系统停机时间。

• 保持最佳灵敏度。

• 避免范围更广的清洁（需要上门维修）。

当污染发生时，执行初始日常清洁。清洁至并包括锥孔板的前部。如果日常清洁不能解决灵敏
度问题，可能必须进行一次全面清洁。联系当地的合格维护人员或现场服务工程师。

本部分提供了关于在不破坏真空环境的情况下执行日常清洁。

注释： 遵守所有适用的地方法规。关于健康与安全指导准则，请参阅化学品注意事项。

污染的症状

如果观察到以下任一情况，则系统可能受到了污染：

• 灵敏度显著降低

• 背景噪音增加

• 不属于样本的其他谱峰出现在全扫描或全谱扫描方法中

如果观察到这些问题中的任何一种，即需清洁质谱仪前端。

必需材料

注释： 如需耗材订购信息和询价，请参阅《MD 仪器系列部件和设备指南》。请联系本地现
场服务工程师或访问 sciex.com/diagnostics 了解更多信息。

• 无粉手套（推荐丁腈和氯丁橡胶）

• 护目镜

• 实验室外套

• 新鲜的高品质（纯）水（至少为 18 MΩ 去离子 [DI] 水或超纯 HPLC 级水）。陈水可能包
含会进一步污染质谱仪的污染物。

• MS 级甲醇、异丙醇（2-丙醇）或乙腈

液相色谱串联质谱检测系统系统用户指南
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• 清洗液。请使用下列中的一种：

• 100% 甲醇

• 100% 异丙醇

• 1:1 乙腈：水溶液（新鲜配制）

• 1:1 乙腈：含有 0.1% 醋酸的水溶液（新鲜配制）

• 干净的 1 L 或 500 mL 玻璃烧杯，用于配制清洗液

• 1 L 烧杯，用于接收用过的溶剂

• 有机废弃物容器

• 无绒擦拭巾。请参阅制造商可提供的工具和用品。

• （可选）聚酯棉签

制造商可提供的工具和用品

部件编号描述

1017396小聚酯棉签（热粘合）。也包含在清洁套件中。

018027无绒擦拭布（11 cm x 21 cm，4.3 英寸 x 8.3 英寸）。也包含在清洁套
件中。

5020761清洁套件。包含有小聚酯棉签、无绒擦拭布、Q0 清洁工具、直线型 QJet®

离子导向器清洁刷和 Alconox 包。

清洁最佳做法

警告！ 高温表面危害。在开始任何维护程序之前，先让离子源冷却至少 30 分
钟。在操作过程中，离子源和真空接口组件的表面会发烫。

警告！ 有毒化学品危害。在处理、储存和处置化学品时，请参阅化学品安全数据表，
并遵守所有建议的安全规程。健康与安全注意事项方面的内容，请参阅《系统用户指
南》。

警告！ 电离辐射危害、生物危害或有毒化学品危害。在清洁或维护质谱仪之
前，确定是否需要去污。如果系统使用了放射性物质、生物制剂或有毒化学品，
在清洁或维护之前客户必须先消除系统污染。
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警告！ 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵循
当地法规。

• 拆除离子源前先使其冷却。

• 请始终戴着干净的无粉手套（推荐丁腈和氯丁橡胶）执行清洁程序。

• 在清洁质谱仪组件之后及重新组装之前，戴上一副新的干净的手套。

• 不要使用此程序中未指定的其他清洁用品。

• 如果可能的话，在开始清洁前即行制备清洗液。

• 仅在非常干净的玻璃器皿中制备和储存所有的有机溶液和含有机物的溶液。切勿使用塑料
瓶。污染物可从这些瓶子中浸出并进一步污染质谱仪。

• 为避免污染清洗液，将溶液倒在擦拭布或棉签上。

• 仅用擦拭布的中心区域接触质谱仪表面。切割边缘会留下纤维。

提示！ 将擦拭布卷绕在热粘合聚酯棉签上。

图 16-2 示例：折叠擦拭布

• 为避免交叉污染，擦拭布或棉签触及表面一次之后就应丢弃。

• 真空接口较大的部件，如气帘板，可能需要使用多个擦拭布进行几次清洁。

• 应用水或清洗液时，只需稍微沾湿擦拭布或棉签。水往往比有机溶剂更可能造成擦拭布变质
而在质谱仪上留下残留物。

• 不要用擦拭布来回摩擦孔隙。在孔隙周围擦拭，以防止擦拭布的纤维进入质谱仪。

• 不要将刷子插入气帘板或锥孔板的孔隙内。

准备质谱仪

警告！ 高温表面危害。在开始任何维护程序前，先让离子源和真空接口冷却至
少 30 分钟。离子源和真空接口的某些表面在工作过程中会发烫。
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小心： 可能导致系统损坏。卸下离子源时，不得使异物掉入离子源排液口中。

图 16-3 真空接口上的离子源排放

1. 失活硬件配置文件。

2. 取出离子源。请参阅取下离子源。

当离子源未使用时，对其进行存储以保护它免受损坏，并保持操作的完整性。

清洁气帘板

小心： 可能导致系统损坏。不得用小孔尖端支撑气帘板或锥孔板的重量。气帘板的锥形侧一
定要朝上。

小心： 可能导致系统损坏。不得将金属丝或金属刷插入气帘板、锥孔板或接口加热器上的小
孔中，以免损坏小孔。

1. 从真空接口上取下气帘板，然后将其圆锥形的一面朝上，放置在干净、稳定的台面上。

气帘板通过安装在锥孔板上的三个定位球掣而保持在适当的位置。

提示！ 如果气帘板无法立即从锥孔板卸下，则轻微旋转气帘板（小于 90 度）以释放球弹
簧闩。

2. 先用纯净水润湿一块无绒布，再清洁气帘板的两侧。

注释： 根据需要，可使用多块擦拭布。

系统用户指南液相色谱串联质谱检测系统
IVD-IDV-05-6996-ZH-B214 / 267

维修和维护信息



3. 使用清洗液重复步骤 2。

4. 用润湿的擦拭布或聚酯棉签清洁孔隙。

5. 等到气帘板变干燥。

6. 检查气帘板上是否残留了溶剂污渍或绒毛，用干净的微湿的无绒布除去任何残留物。

注释： 一直存在斑点和油膜则说明溶剂受到污染。

清洁锥孔板的前部

小心： 可能导致系统损坏。清洁锥孔板表面时，请勿卸下接口加热器。频繁卸下接口加热器
会导致其损坏。就日常清洁而言，接口加热器的表面清洗已经足够。

小心： 可能导致系统损坏。不得将金属丝或金属刷插入气帘板、锥孔板或接口加热器上的小
孔中，以免损坏小孔。

1. 先用水润湿一块无绒布，再擦拭锥孔板前部，包括接口加热器。

2. 使用清洗液重复步骤 1。

3. 等到锥孔板变干燥。

4. 检查锥孔板上是否残留了溶剂污渍或绒毛，用干净的微湿的无绒布除去任何残留物。

注释： 一直存在斑点和油膜则说明溶剂受到污染。

使质谱仪重新工作。

1. 在质谱仪上安装气帘板。

2. 将离子源安装在质谱仪上。请参阅 将离子源安装到质谱仪上。

通过将离子源闩向下旋转至锁定位置来固定离子源。

3. 如果质谱仪连接到 LC 系统，则恢复与 LC 系统的所有连接。

4. 激活硬件配置文件。请参阅 创建硬件配置文件。

检查低真空泵油位

• 检查低真空泵上的视镜，以确认泵油高于最低油位。

如果泵油低于最低油位，则联系合格维护人员 (QMP) 或 SCIEX 现场服务人员 (FSE)。
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图 16-4 视镜

离子源维护

以下警告适用于本节中的所有维护规程。

警告！ 高温表面危害。在开始任何维护程序之前，先让离子源冷却至少 30 分
钟。在操作过程中，离子源的表面会发烫。

警告！ 火灾和有毒化学品危害。使易燃液体远离明火和火花，并且只能在通风
的化学通风橱或安全柜中使用。

警告！ 有毒化学品危害。穿戴个人防护设备、手套和护目镜，以避免皮肤或眼睛暴
露在外。

警告！ 电离辐射危害、生物危害、触电危害或有毒化学品危害。发生化学品
溢漏情况下的具体操作说明请查看产品安全数据表。在清理离子源附近的溢漏
液时，一定要确认系统处于待机模式。请使用相应的个人防护设备和能吸湿的
抹布来吸除溢漏物，并按当地法规进行处置。

警告！ 触电危险。在操作过程中，应避免接触施加在离子源上的高电压。先将
系统置于待机模式，然后调整样本管路或靠近离子源的其他设备。
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警告！ 刺伤危险、电离辐射危害、生物危害或有毒化学品危害。如果离子源窗
口有裂痕或破损，请停止使用离子源，并与 SCIEX 现场服务工程师联系。设备
中引入的任何有毒或有害材料均会存在于离子源排气输出中。请按照既定实验
室安全程序处置锐器。

小心： 可能导致系统损坏。不要单手抬起或携带离子源。离子源设计为使用离子源两侧的模
塑把手抬起或携带。

本部分介绍了离子源的基本维护规程。要确定清洗离子源或进行预防性维护的频率，应考虑以
下因素：

• 检测的化合物

• 样本的洁净度和样本制备技术

• 含有样本的探针的闲置时间

• 系统总计运行时间

这些因素会引起离子源性能的变化，表示需要进行维护。

确保已安装的离子源被完全密封在质谱仪上，无任何气体泄漏迹象。定期检查离子源及其接头
有无泄漏。定期清洁离子源组件，保证离子源的良好工作条件。

小心： 可能导致系统损坏。只能使用推荐的清洁方法和材料，以避免损坏设备。

所需材料

• 1/4 英寸开口扳手

• 平头螺丝刀

• MS 级甲醇

• HPLC 级去离子水

• 护目镜

• 呼吸面罩和过滤器

• 无粉手套（建议使用丁腈橡胶或氯丁橡胶）

• 实验室外套

离子源的取放

在操作过程中，离子源的表面会发烫。图 16-5 显示温度较低的表面（蓝色和灰色）和较长时
间内持续发烫的表面（红色）。在使用或取下离子源时，请勿触碰下图所示的红色表面。
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图 16-5 离子源高温表面（红色=烫，灰色=温，蓝色=小心取放）

描述项目

正面1

背面2

取下离子源

注释： 在质谱仪关闭时或者离子源从系统中移除时，氮气继续以 5.3 升/分钟的速度流动。
要尽量减少氮气消耗并在不使用质谱仪时保持仪器清洁，可将离子源安装在质谱仪中并使系
统保持运转。

离子源可迅速而方便地取下，无需工具。对其进行维护或更换探针之前，一定要先将离子源从
质谱仪上取下。

1. 停止任何正在进行的扫描动作。

2. 关闭样本液流。

3. 如果正在使用加热器，则在 TEM 字段中键入 0。

4. 等待至少 30 分钟直到离子源冷却。

5. 将样本导管与接地接头断开。

6. 将两个离子源插锁向上转至 12 点钟位置，将离子源松开。

7. 将离子源轻轻拉出真空接口。

注释： 小心不要弄丢安装在真空接口上的 O 形密封圈
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8. 将离子源放在一个干净、稳固的表面上。

清洁表面

警告！ 触电危险。进行下一步操作前，离子源与质谱仪一定要完全断开。

如有液体溢出或外表面变脏，请清洁离子源外表面。

必要程序

• 取下离子源

• 用一块柔软、蘸湿的清洁布擦拭离子源外表面。

清洁探针

无论用何种化合物取样，都要定期冲洗离子源。完成此工作的方法是，在 Analyst® MD 软件中
专门为冲洗操作建立一个方法。

1. 换成流动相，即 1:1 水:乙腈或 1:1 水:甲醇。

2. 调节探针的位置，使之离小孔越远越好。

3. 在 Analyst® MD 软件执行以下操作：

a. 创建一种质谱方法。

b. 将 TEM 设置在 500 和 600 之间。

c. 将 GS1 和 GS2 设置为至少 40。

d. 将 CUR 尽可能设置为最高值。

4. 等到达到 TEM 设定点。

5. 确保对探针和样本导管进行彻底冲洗。

取下探针

警告！ 触电危险。在开始操作前，将质谱仪上的离子源取下。请按所有电气安
全工作要求操作。

小心： 可能导致系统损坏。不要让凸出的喷针尖端或电晕放电针触碰离子源外壳的任何部
分，以免损坏探针。

探针可迅速而方便地取下，无需工具。更换探针或对其进行维护之前，一定要先将离子源从质
谱仪上取下。
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必要程序

• 取下离子源

1. 松开样本导管上的螺母，然后将样本导管与探针断开。

2. 松开用来将探针固定在离子源罩壳上的固定环。

3. 将探针从塔形离子源罩壳中向上轻轻抽出。

4. 将探针放在一个稳固、干净的表面上。

更换喷针

警告！ 触电危险。在开始操作前，将质谱仪上的离子源取下。请按所有电气安
全工作要求操作。

警告！ 刺伤危险。喷针要轻拿轻放。喷针的尖端特别锋利。

探针含喷针。喷针性能下降时，请予以更换。

注释： 更换喷针后，评估变更对系统性能的影响。

必要程序

• 取下离子源

• 取下探针

该程序适用于两种探针。

1. 取下喷针调节螺母，然后移除喷针。

2. 握住探针使其尖端朝下，使弹簧仍然位于探针内，在 PEEK 接头中安装样本管件，用手拧
紧。
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图 16-6 探针，放大视图

描述项目

喷针调节螺母1

1/4 英寸固定螺母2

弹簧3

固定环4

喷射器导管5

喷针尖端6

喷针7

PEEK 接头8

3. 从探针中抽出 PEEK 接头及附着的喷针。

4. 从 PEEK 接头取下样本管件。

5. 用 1/4 英寸开口扳手卸下 PEEK 接头中固定喷针的固定螺母。

6. 将喷针从固定螺母中取出。

7. 将新的喷针插入固定螺母，然后再插入 PEEK 接头中。

在 PEEK 接头一定要将喷针插到底。如果喷针和接头中的底座间有空隙，就可能会产生死体
积。

8. 拧紧固定螺母。

请勿将固定螺母拧歪或拧得过紧，否则导管可能会出现泄漏。

9. 确认弹簧仍在探针内，然后拧紧喷针调节螺母。

10. 将喷针对准喷射管的窄口，然后再插入 PEEK 接头，并将喷针装入探针。小心不要弯折喷
针。

11. 安装并紧固喷针调节螺母。

12. 安装探针。请参阅 安装探针。
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13. 连接样本管路。请参阅 连接离子源导管

14. 将离子源安装到质谱仪上。请参阅 离子源安装。

15. 调整喷针尖端伸出量。请参阅 优化 TurboIonSpray®探针位置或优化 APCI 探针位置。

更换电晕放电针

警告！ 触电危险。在开始操作前，将质谱仪上的离子源取下。请按所有电气安
全工作要求操作。

警告！ 刺伤危险。放电针要轻拿轻放。放电针的尖端特别锋利。

必要程序

• 取下离子源

• 取下探针

如果电晕放电针尖被腐蚀，可能用手无法移除。如果发生此种情形，割断针尖并取下，然后更
换整个电晕放电针。

1. 转动离子源，使敞开侧可触及。
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图 16-7 电晕放电针

描述项目

排气道1

陶瓷套管2

电晕放电针针头3

2. 用一只手的拇指和食指捏住电晕放电针调节螺钉（请参阅 离子源组件），同时另一只手捏
住电晕放电针，逆时针方向转动针头，将其松开并轻轻取下。

3. 将电晕放电针轻轻向下拉动，经排气道抽出。

4. 将新的针经排气道插入陶瓷套管，插入越深越好。

5. 用一只手的拇指和食指捏住一个新针头，另一只手捏住电晕放电针调节螺钉，顺时针方向转
动针头进行安装。

6. 插入探针，然后将离子源安装到质谱仪上请参阅 离子源安装。
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更换样本导管

警告！ 触电危险。在开始操作前，将质谱仪上的离子源取下。请按所有电气安
全工作要求操作。

必要程序

• 停止样本流入，并确认剩余气体已通过离子源排气系统清除。

• 取下离子源。

如发生堵塞，请按下列步骤更换样本导管。

1. 将样本导管与探针和接地接头断开。

2. 用合适的截管器截取一段长度适宜的导管，然后用此导管更换样本导管。 。

3. 安装离子源。请参阅 离子源安装。

4. 开始样本流入。

质谱仪存储和处理

警告！ 环境危害。请勿按照城市垃圾处置方式来处置系统组件。处理组件时，请遵循
当地法规。

如果质谱仪须长时间储存或准备装运，那么联系 SCIEX 现场服务工程师，获取关于停止使用的
信息。要断开质谱仪的电源，从交流电源上拔下电源连接器。

注释： 离子源和质谱仪的运输和保存温度范围必须为 –30 °C 至 +60 °C (–22 °F 至
140 °F)。将系统存放在海拔高度不超过 2000 m（6562 英尺）之处。
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本节包含了对基本系统问题进行故障排除的信息。某些活动只能在实验室中由接受过 SCIEX 培
训的合格维护人员 (QMP) 执行。对于高级故障排除，请联系 SCIEX 现场服务工程师 (FSE)。

表 17-1 系统问题

纠正措施可能的原因症状

将电晕针向气帘板转动，并远
离加热气气流。请参阅调整电
晕放电针的位置。

电晕针的位置不正确。出现电弧或火花。

更换喷针。请参阅更换喷针。喷针阻塞。喷射不均匀。

验证 CUR 参数设置，并在需要
时提高此参数。

Curtain GasTM 流速太低。QJet® 离子导向器非常脏或经
常变脏。

1. 检查低真空泵油位。请参阅
检查低真空泵油位。必要时
可联系当地的合格维护人员
或现场服务工程师添加油。

2. 检查并修复泄漏。

3. 安装正确的锥孔板。

1. 低真空泵油位过低。

2. 有泄漏。

3. 安装了错误的锥孔板。

系统发生了故障，因为真空压
力过高。

联系当地的合格维护人员或现
场服务工程师。

1. 质谱仪空气过滤器阻塞。

2. 环境温度过高。

3. 线圈盒未经调谐。

系统发生了故障，因为 QPS 激
发器模块温度过高。

1. 确认设备状态面板中故障所
在的详细页面。

2. 安装探针。请参阅安装探
针。

3. 取下并装回探针。拧紧固定
环。请参阅取下离子源和取
下探针。

1. 没有安装探针。

2. 探针连接不牢。

Analyst® MD 软件报告质谱仪
因离子源受损而处于故障状
态。

请联系现场服务工程师。F3 熔断器烧坏。Analyst® MD 软件指示正在使
用 APCI 探针，但安装的是
TurboIonSpray® 探针。
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表 17-1 系统问题 （续）

纠正措施可能的原因症状

1. 优化离子源参数。

2. 使用仪器优化向导优化质谱
仪。

3. 请参阅清洁气帘板。

4. 请参阅清洁锥孔板的前部或
者联系当地的合格维护人员
或现场服务工程师。

5. 全面清洁质谱仪正面组件。
联系合格维护人员或现场服
务工程师。

6. 清洁 Q0 区域。联系合格维
护人员或现场服务工程师。

7. 检查注射器或样本管路有无
泄漏，并维修所发现的泄
漏。确保所有配件的类型和
大小正确无误。

8. 验证样本浓度。使用新鲜样
本。

9. 拆卸和安装探针。

10. 拆卸和安装离子源，确保妥
善固定插锁。如果问题仍未
解决，则安装并优化备用离
子源。

11. 如果 O 形密封圈位于离子
源，则将其安装在真空接口
上。如果缺失，则予以更
换。

12. 排查 LC 系统问题。

1. 离子源参数未优化。

2. 质谱仪未优化。

3. 气帘板变脏。

4. 锥孔板变脏。

5. QJet® 离子导向器或 IQ0
透镜变脏。

6. Q0 区域变脏。

7. 注射器或样本管路泄漏。

8. 样本品质下降或浓度低。

9. 未正确安装探针。

10. 未正确安装离子源，或离子
源有故障。

11. 真空接口上的一个或多个 O
形密封圈丢失。

12. LC（液相色谱）系统或接头
有问题。

灵敏度降低。

使用仪器优化向导优化质谱
仪。

质谱仪未优化。分辨率差。
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表 17-1 系统问题 （续）

纠正措施可能的原因症状

1. 优化离子源参数。

2. 清洗或更换注射器或样本管
路。

3. 请参阅清洁气帘板。

4. 请参阅清洁锥孔板的前部或
者联系当地的合格维护人员
或现场服务工程师。

5. 全面清洁质谱仪正面组件。
联系合格维护人员或现场服
务工程师。

6. 清洁 Q0 区域。联系合格维
护人员或现场服务工程师。

1. 温度 (TEM)、IonSprayTM 电
压 (IS) 或加热气的气流速
度 (GS2) 过高。

2. 注射器或样本管路较脏。

3. 气帘板变脏。

4. 锥孔板变脏。

5. QJet® 离子导向器或 IQ0
透镜变脏。

6. Q0 区域变脏。

背景噪声过高。

液相色谱串联质谱检测系统系统用户指南
227 / 267IVD-IDV-05-6996-ZH-B

质谱仪故障排除



表 17-1 系统问题 （续）

纠正措施可能的原因症状

1. 清洁或更换离子源组件，然
后调节离子源和前端：

a. 将探针移至距锥孔最远
的位置（垂直和水平方
向）。

b. 接口加热器一定要打
开。

c. 以 1 mL/min 的泵流速
注入 50:50 的甲醇和
水。

d. 在 Analyst® MD 软件
中，将 TEM 设为 650，
GS1 设为 60，GS2 设为
60。

e. 将 CUR 气流设为 45 或
50。

f. 运行最少 2 小时或最好
隔夜，以达到最佳效
果。

1. 离子源被污染。背景噪声过高。
（续）

1. 优化探针参数。请参阅
TurboIonSpray® 探针优化
或APCI 探针优化。

2. 确认样本制备正确。

3. 确认管件大小和类型正确无
误，并确保其结合紧密。管
件请勿过度拧紧。如仍有泄
漏，请更换管件。

4. 安装并优化替代离子源。

5. 如果问题仍然继续存在，请
联系 FSE。

1. 探针未优化。

2. 样本制备不正确或样本品质
下降。

3. 样本进口管件泄漏。

质谱仪性能下降。

更换样本导管。请参阅更换样
本导管。

管路堵塞。没有信号。

1. 优化 DP。

2. 更换喷针。

1. 去簇电压 (DP) 未优化。

2. 喷针较脏或被堵塞。

信号太弱。
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表 17-1 系统问题 （续）

纠正措施可能的原因症状

更换样本导管。请参阅更换样
本导管。

管路堵塞。信号不稳定。

打开 Mass Spectrometer
Detailed Status 对话框。
Source Temperature 字段中应
包含设定温度，且 Interface
Heater Status 应为 Ready。
如果不是这样，请联系合格维
护人员或现场服务人员更换接
口加热器。

接口加热器有故障。温度未达到，或者温度过高或
不稳定。

对于销售、技术援助或服务，请联系现场服务工程师，或访问 SCIEX 网站
sciex.com/diagnostics 获取联系信息。
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下表含 4500MD 系列仪器的泛型参数。每个扫描类型下的第一个数字是预设值。数字范围是每
个参数的可使用范围。

表 A-1 三重四极杆扫描类型的系统参数 (4500MD 系统 )

阴离子模式阳离子模式使用权限
ID 号

MS/MSQ3Q1MS/MSQ3Q1

20

10 - 55

20

10 - 55

20

10 - 55

20

10 - 55

20

10 - 55

20

10 - 55

CUR(1)(2)

中度

低，中，高

6

固定

0

固定

中度

低，中，高

6

固定

0

固定

CAD(a)

9

0 - 12

5

固定

0

固定

9

0 - 12

5

固定

0

固定

CAD(b)

-4500

-4500 至 0

-4500

-4500 至 0

-4500

-4500 至 0

5500

0 - 5500

5500

0 - 5500

5500

0 - 5500

IS(1)(2)

–3

-5 至 0

–3

-5 至 0

–3

-5 至 0

3

0 - 5

3

0 - 5

3

0 - 5

NC(3)

0

0 - 750

0

0 - 750

0

0 - 750

0

0 - 750

0

0 - 750

0

0 - 750

TEM(2)(3)

–100

-300 至 0

–100

-300 至 0

–100

-300 至 0

100

0 - 300

100

0 - 300

200

0 - 300

DP(a)

–150

-300 至 0

–60

-300 至 0

–60

-300 至 0

120

0 - 300

130

0 - 300

130

0 - 300

DP(b)

–10

-15 至 -2

–10

-15 至 -2

–10

-15 至 -2

10

2 - 15

10

2 - 15

10

2 - 15

EP

1800

0 - 3300

1800

0 - 3300

1800

0 - 3300

1800

0 - 3300

1800

0 - 3300

1800

0 - 3300

CEM(a)

2000

0 - 3300

2000

0 - 3300

2000

0 - 3300

2000

0 - 3300

2000

0 - 3300

2000

0 - 3300

CEM(b)
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表 A-1 三重四极杆扫描类型的系统参数 (4500MD 系统 ) （续）

阴离子模式阳离子模式使用权限
ID 号

20

0 - 90

20

0 - 90

20

0 - 90

20

0 - 90

20

0 - 90

20

0 - 90

GS1(a)

15

0 - 90

15

0 - 90

15

0 - 90

15

0 - 90

15

0 - 90

15

0 - 90

GS1(b)

0

0 - 90

0

0 - 90

0

0 - 90

0

0 - 90

0

0 - 90

0

0 - 90

GS2

–30

-180 至 -5

不适用不适用30

5 - 180

不适用不适用CE(a)

–40

-180 至 -5

不适用不适用53

5 - 180

不适用不适用CE(b)

–15

-55 至 0

–15

-55 至 0

不适用15

0 - 55

15

0 - 55

不适用CXP(a)

–12

-55 至 0

–17

-55 至 0

不适用27

0 - 55

9

0 - 55

不适用CXP(b)

(1) Turbo VTM离子源 (2) TurboIonSpray®探针 (3) APCI 探针

(a) QTRAP®4500MD 系统 (b) SCIEX Triple QuadTM4500MD 系统

表 A-2 LIT 扫描类型的系统参数（仅限 QTRAP®）

阴离子模式阳离子模式使用权限 ID 号

20

10 - 55

20

10 - 55

CUR(1)(2)(3)

高

低，中，高

高

低，中，高

CAD

-4500

-4500 至 0

5500

0 - 5500

IS(1)

–3

-5 至 0

3

0 - 5

NC(3)

0

0 - 750

0

0 - 750

TEM(2)(3)
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表 A-2 LIT 扫描类型的系统参数（仅限 QTRAP®） （续）

阴离子模式阳离子模式使用权限 ID 号

–100

-300 至 0

100

0 - 300

DP

–10

-15 至 -2

10

2 - 15

EP

0.100

0 或 1

0.100

0 或 1

AF2

质量-速度取决因素

0 - 10

质量-速度取决因素

0 - 10

AF3

质量-速度取决因素

0 - 165

质量-速度取决因素

-165 至 0

EXB

1800

0 - 3300

1800

0 - 3300

CEM

20

0 - 90

20

0 - 90

GS1

0

0 - 90

0

0 - 90

GS2

0

0 - 50

0

0 - 50

CES

–30

–180 至 –10

10

5 - 180

CE

(1)TurboIonSpray®探针 (2) APCI 探针
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TurboIonSpray® 探针参数

下表显示了 TurboIonSpray® 探针在三种不同流速下的推荐工作条件。对于每个流速，Curtain
GasTM流速应尽可能高。用于优化的溶剂成份为 1:1 的水和乙腈。这些条件代表的是探针优化
的起始点。对于目标化合物，用流量注入分析法反复优化参数，以获得最佳信号或信噪比。

表 B-1 TurboIonSpray® 探针的参数优化

工作范围典型值参数

5 µL/min - 3000
µL/min

1000 µL/min200 µL/min5 µL/min
- 50 µL/
min

LC 流速

0 psi - 90 psi40 psi - 60 psi40 psi - 60 psi20 psi -
40 psi

气体 1（雾化气）

0 psi - 90 psi50 psi50 psi0 psi气体 2（加热气）

5500 V5500 V5500 V5500IonSpray 电压

20 psi - 50 psi20 psi20 psi20 psiCurtain GasTM气源

最高 750 ºC400 ºC - 750 ºC200 ºC - 650 ºC0 ºC -
200 ºC

温度*

阳离子：0 V - 400
V
阴离子：–400 V
- 0 V

阳离子：70 V
阴离子：-70 V

阳离子：70 V
阴离子：-70 V

阳离子：
70 V
阴离子：
-70 V

去簇电压 (DP) **

0 - 130 - 22 - 57 - 10探针垂直刻度设置

0 - 104 - 64 - 64 - 6探针水平刻度设置

* 最优温度值取决于化合物和流动相的成份（水含量越高，所需温度越高）0 表示未应用任
何温度。

** DP 值取决于化合物。
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APCI 探针参数

表 B-2 APCI 探针的参数优化

工作范围典型值参数

200 µL/min - 2000 µL/min1000 µL/minLC 流速

0 psi - 90 psi30 psi气体 1 （雾化气）

20 psi - 50 psi20 psiCurtain GasTM气源

100 ºC 至 750 ºC400ºC温度*

阳极：0 mA 至 5 µA

阴极：–5 mA 至 0 µA

阳极：3 µA

阴极：-3 µA

雾化电流 (NC)

阳离子： 0 V - 300 V

阴离子：-300 V 至 0 V

阳离子：60 V

阴离子：-60 V

去簇电压 (DP)

标度 0 至 134探针垂直千分尺设置

* 温度值取决于化合物。

探针位置

探针的位置会影响到分析的灵敏度。请参阅离子源优化，了解更多关于优化探针位置方面的内
容。

溶剂成份

甲酸铵或乙酸铵的标准浓度为 2 mmol/L - 10 mmol/L（阳离子）及 2 mmol/L - 50 mmol/L（阴
离子）。有机酸的体积浓度为 0.1% - 0.5%（ TurboIonSpray® 探针）和 0.1% - 2.0%（APCI
探针）。

常用溶剂有：

• 乙腈

• 甲醇

• 丙醇

• 水

常用的改性剂有：

• 乙酸

• 甲酸

• 甲酸铵
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• 乙酸铵

下列改性剂不常使用，因为它们的离子混合物和团簇的结合会使谱图复杂化。它们还会抑制目
标化合物离子信号的强度：

• 三乙胺 (TEA)

• 磷酸钠

• 三氟乙酸 (TFA)

• 十二烷基磺酸钠
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小心： 潜在的错误结果。切勿使用过期溶液。

表 C-1 调谐频率

分辨率优化校正

手动/自动频率手动/自动频率扫描类型

两者皆有3 个月至 6 个月两者皆有3 个月至 6 个月Q1 和 Q3

仅限自动3 个月至 6 个月两者皆有每 2 周一次，视要求而定LIT

表 C-2 4500MD 系列仪器的建议调谐溶液

LITQ1 和 Q3系统

阳离子和阴离子阴离子阳离子

不适用NEG PPG, 3e-4 MPOS PPG, 2e-6 MSCIEX Triple QuadTM4500MD LC-MS/
MS 系统

Agilent ESI 调谐混合NEG PPG, 3e-4 MPOS PPG, 2e-6 MQTRAP®4500MD LC-MS/MS 系统
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表 C-3 Q1 和 Q3 PPG 阳离子扫描

质量仪器

1952.41545.11254.9906.7616.5500.3175.159.0SCIEX Triple QuadTM4500MDLC-MS/MS
系统

1952.41545.11254.9906.7616.5500.3175.159.0QTRAP®4500MDLC-MS/MS 系统

表 C-4 Q1 和 Q3 PPG 阴离子扫描

质量仪器

1979.31863.31572.11223.8933.6585.4411.245.0SCIEX Triple QuadTM4500MDLC-MS/MS 系
统

1979.31863.31572.11223.8933.6585.4411.245.0QTRAP®4500MDLC-MS/MS 系统

表 C-5 用于 QTRAP®4500MDLC-MS/MS 系统 (Agilent) 的质量和极性

质量仪器 / 极性

1521.972922.010622.030322.049118.087LIT 阳离子

1633.9491033.988601.978431.982112.985LIT 阴离子
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有关其他工具栏图标，请参阅《高级用户指南》。

表 D-1 工具栏图标

描述名称图标

创建一个子项目。只有在项目最初创建时包含子项目的情况下，
才可在后期创建子项目。

New
Subproject

复制子项目文件夹。

只能从既有子项目的项目中复制子项目。如果相同的文件夹在项
目层级和子项目层级中均存在，那么软件会使用项目层级文件夹。

Copy
Subproject

表 D-2 Acquisition Method Editor 图标

描述名称图标

单击以在 Acquisition Method Editor 中显示 MS 选项卡。Mass Spec

右键单击可添加实验、添加 IDA Criteria Level 或删除时段。Period

单击后打开 Autosampler Properties 选项卡。Autosampler

单击后打开 Syringe Pump Properties 选项卡。Syringe Pump

单击后打开 Column Oven Properties 选项卡。Column Oven

单击后打开 Valve Properties 选项卡。Valve

单击后打开 DAD Method Editor。请参阅生成 DAD 数据。DAD

单击后打开 ADC Properties 选项卡。请参阅 显示模拟数字转换
器 (ADC) 数据。

ADC
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表 D-3 Acquire Mode 图标

描述名称图标

显示样本队列。View Queue

显示远程仪器站。Instrument
Queue

显示远程仪器的状态。Status for
Remote
Instrument

在队列中开始采样。Start Sample

在队列中停止采样。Stop Sample

在样本处理过程中终止样本采集。Abort Sample

在所有样本的处理完成之前停止队列。Stop Queue

选择要使用的方法以使设备平衡。此方法应与队列中第一份样本
所用的方法相同。

Equilibrate

将仪器置于 Standby 模式。Standby

将仪器置于 Ready 模式。Ready

保留质谱仪进行调谐和校正。Reserve
Instrument
for Tuning

启动 IDA Method Wizard。IDA Method
Wizard

表 D-4 Tune and Calibrate Mode 图标

描述名称图标

打开 Mass Calibration Option 对话框并使用当前有效谱图校正
质谱仪。

Calibrate
from spectrum

打开 Manual Tune Editor。Manual Tune

利用流动注射分析方式对化合物进行优化。Compound
Optimization
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表 D-4 Tune and Calibrate Mode 图标 （续）

描述名称图标

验证仪器性能、调整质量校正或调整质谱仪设置。Instrument
Optimization

查看样本队列。View Queue

查看远程仪器。Instrument
Queue

查看远程仪器的状态。Status for
Remote
Instrument

保留仪器进行调谐和校正。Reserve
Instrument
for Tuning

启动 IDA Method Wizard。IDA Method
Wizard

表 D-5 查阅快速参考：色谱图和谱图

描述名称图标

打开文件。Open Data
File

转到下一样本。Show Next
Sample

转到前一样本。Show Previous
Sample

打开 Select Sample 对话框。Go To Sample

查看表中的数据。List Data

由谱图生成总离子色谱图。Show TIC

通过选择质量来提取离子。Extract Using
Dialog

生成基峰色谱图。Show Base
Peak
Chromatogram

由总离子色谱图生成谱图。Show Spectrum

将当前图表复制到新窗口。Copy Graph to
new Window
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表 D-5 查阅快速参考：色谱图和谱图 （续）

描述名称图标

打开 Baseline Subtract 对话框。Baseline
Subtract

调整阈值。Threshold

显示 Noise Filter Options 对话框，可用于界定峰的最小宽度。
此最下宽度以下的信号被视为噪声。

Noise Filter

显示模数转换器数据。Show ADC

显示数据收集的实验条件。Show File
Info

在当前图表的 X 轴上添加箭头。Add arrows

移除当前图表 X 轴上的箭头。Remove all
arrows

补偿模数转换器数据和质谱仪数据记录过程中的微小差异。在叠
加图表以便比较时，非常有用。

Offset Graph

标记所有的峰。Force Peak
Labels

设置图表某一部分的扩大系数，以进行更详细地查看。Expand
Selection By

将扩大的选定部分恢复至正常视图。Clear ranges

界定选定部分的起始和终止点。与利用光标进行选择相比，此功
能可更准确地选定所需区域。

Set Selection

依比例将图表调整至最大尺寸，从而使最强的峰扩展至全刻度，
无论其是否可见。

Normalize To
Max

显示对特定文件执行的数据处理操作汇总，如平滑化、减除、校
正和噪声过滤。

Show History

打开此化合物的数据库。Open Compound
Database

调整阈值。Set Threshold

以频谱图或提取离子色谱图显示选定数据。此外，对于二极管阵
列检测器所获的数据，等值线图还可通过二极管阵列检测器谱图
或提取波长色谱图显示选定数据。

Show Contour
Plot

生成二极管阵列检测器谱图的总波长色谱图。Show DAD TWC
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表 D-5 查阅快速参考：色谱图和谱图 （续）

描述名称图标

生成二极管阵列检测器谱图。Show DAD
Spectrum

从二极管阵列检测器谱图中提取三个波长范围以查看提取波长色
谱图。

Extract
Wavelength

表 D-6 浏览工具栏快速参考：叠加图形

描述名称图标

单击后使图形恢复原始尺寸。Home Graph

单击后叠加图形。Overlay

单击后循环显示叠加图形。Cycle
Overlays

单击后将图形叠加在一起。Sum Overlays

表 D-7 浏览工具栏快速参考：碎片解读工具

描述名称图标

单击后打开碎片解读工具，该工具会自动从 .mol 文件计算非环
单键裂解碎片。

Show Fragment
Interpretation
Tool

表 D-8 浏览工具栏上的导航图标

功能名称图标

单击后打开文件。Open File

单击后找到下一个样本。Show Next
Sample

单击后找到前一个样本。Show Previous
Sample

单击后打开 Select Sample 对话框。GoTo Sample

单击后查看表中的数据。List Data

单击后从质谱生成总离子色谱图。Show TIC
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表 D-8 浏览工具栏上的导航图标 （续）

功能名称图标

单击后通过选择质量来提取离子。Extract Using
Dialog

单击后生成一个基峰色谱图。Show Base
Peak
Chromatogram

单击后从总离子色谱图生成质谱。Show Spectrum

单击后将当前激活图形复制到新窗口。Copy Graph to
new Window

单击后打开 Baseline Subtract 对话框。Baseline
Subtract

单击后调整阈值。Threshold

单击后用 Noise Filter Options 对话框定义最小峰宽。此最下
宽度以下的信号被视为噪声。

Noise Filter

单击后查看 ADC 数据。Show ADC

单击后显示收集数据所采用的实验条件。Show File
Info

单击后在当前激活图形的 x 轴上添加箭头。Add arrows

单击后从当前激活图形的 x 轴上删除箭头。Remove all
arrows

单击后补偿记录 ADC 数据和质谱仪数据的过程中出现的微小差
异。在叠加图表以便比较时，非常有用。

Offset Graph

单击后标记所有峰。Force Peak
Labels

单击后设置您要仔细观察的局部图形的放大系数。Expand
Selection By

单击后将放大部分恢复至正常视图。Clear ranges

单击后键入选定部分的起点和终点。这样选择比通过光标勾画区
域更为精确。

Set Selection

单击后按最大尺寸显示图形，这样可以将最强峰扩至全尺寸，无
论其是否可见。

Normalize to
Max

单击后查看对特定文件执行的数据处理操作的总体情况，如平滑
化、减除、校正和噪声过滤。

Show History
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表 D-8 浏览工具栏上的导航图标 （续）

功能名称图标

单击后打开化合物数据库。Open Compound
Database

单击后调整阈值。Set Threshold

单击后将选定数据显示为谱图或 XIC。此外，对于 DAD 所采集的
数据，等值线图还可通过 DAD 谱图或 XWC 显示选定数据。

Show Contour
Plot

单击后生成二极管阵列检测器的总波长色谱图。Show DAD TWC

单击后生成一个二极管阵列检测器谱图。Show DAD
Spectrum

从二极管阵列检测器质谱中提取最多三个波长范围，以查看提取
波长色谱图。

Extract
Wavelength

表 D-9 积分选项卡和定量向导图标

描述名称图标

使用选定的峰。Set parameters from
Background Region

使用选定的背景。Select Peak

对峰进行手动积分。Manual Integration
Mode

在显示与隐藏之间切换峰检出参数。Show or Hide
Parameters

仅显示分析物色谱图。Show Active Graph

显示分析物及其关联的色谱图（仅当存在相关联的内标时
才可提供）。

Show Both Analyte
and IS

恢复到预设（查看所有数据）视图（例如，在用户已放大
色谱图的情况下）。

Use Default View for
Graph

表 D-10 结果表图标

描述名称图标

对选定部分升序排序Sort Ascending by
Selection

对选定部分降序排序Sort Descending by
selection
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表 D-10 结果表图标 （续）

描述名称图标

锁定或解锁选定的列。无法移动已锁定的列。Lock Or Unlock
Column

从选定列创建度量图表。Metric Plot By
Selection

显示 Results Table 中的所有样本。Show all Samples

删除公式列。Delete Formula
Column

打开 Reporter 软件。Report Generator

表 D-11 图标快速参考：定量模式

描述名称图标

在 Results Table 中添加或从中移除样本。Add/Remove Samples

将 Results Table 保存为文本文件。Export as Text

打开一个 wiff 文件。Modify Method

在窗格中打开峰。Peak Review - Pane

在窗口中打开峰。Peak Review - Window

在窗格中打开校正曲线。Calibration - Pane

在窗口中打开校正曲线。Calibration - Window

在窗格或窗口中显示第一个峰。Show First Peak

在窗格或窗口中显示最后一个峰。Show Last Peak

显示 Results Table 的审核记录。Show Audit Trail

清除 Results Table 的审核记录。此功能不可用。Clear Audit Trail

打开 Statistics 窗口。Statistics

打开 Reporter 软件。Report Generator
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电喷雾电离模式

探针位于两个涡轮加热器之间的中心位置，涡轮加热器在探针任何一侧成 45 度角放置。
IonSprayTM的流出物和来自涡轮加热器的加热干燥气体混合在一起，以 90 度角射入气帘板上
的小孔。

只有在液态溶剂中电离的化合物才能在离子源中生成气相型式的离子。生成离子的效率和速度
取决于具体离子的溶剂化能量。溶剂化能量低的离子比溶剂化能量高的离子更容易蒸发。

IonSprayTM电压与涡轮加热器之间的交互作用有助于聚集样本流并提高液滴蒸发率，从而增强
离子信号。受热气体会提高离子蒸发的效率，从而提高灵敏度和更高液态样本流速下的处理能
力。

高速雾化气流会在 IonSprayTM入口剪切液体样本流中的液滴。在喷雾器上施加可变高电压，离
子源就会在每一颗液滴上施加一个净电荷。该电荷有助于液滴的分散。单一极性的离子从液流
中分离后，在高电压下很容易被液滴吸附。不过，这种分离是不彻底的，而且每颗液滴都含有
很多两种极性的离子。在每一颗液滴中，以一种极性的离子占主导，带正电和负电的离子数量
的差异会产生净电荷。占主导极性的离子中只有多出的离子才能用于离子蒸发，而且其中仅有
一部分会真正蒸发。

探针可以从具有很多电荷中心（如肽和寡聚核苷酸）的化合物中产生大量带电离子。这在分析
高分子量物种（多电荷产生质量电荷 (m/z) 比在质谱仪质量范围内的离子）时非常有用。这样
就可以正常确定 kiloDalton (kDa) 范围内的化合物的分子量。

如图 E-1 所示，每一颗带电的液滴都含有溶剂和两种极性的离子，但离子都以一种极性为主。
作为导电介质，多余的电荷均驻留在液滴表面。当溶剂蒸发时，液滴表面的电场强度会因为液
滴半径的减小而提高。

图 E-1 离子蒸发
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描述项目

液滴两种极性的离子，以一种极性为主。1

随着溶剂蒸发，电场强度会因为液滴提高，离子移至表面。2

在某些重要的电场值处，离子会从液滴上发射。3

不挥发的残留物以干燥颗粒的型式残留下来。4

如果液滴含有多余的离子，而且有足够的溶剂蒸发，就会达到一个临界电场值，此时离子会从
液滴表面发射。最终，所有溶剂均从液滴上蒸发，留下由样本溶液中不挥发成份组成的干燥颗
粒。

由于大多数有机分子的溶剂化能量是未知的，因此任何指定有机离子对于离子蒸发的灵敏度是
难以预计的。溶剂化能量的重要性显而易见，因为聚集在液体表面的表面活性剂能够非常灵敏
地被发现。

APCI 模式

以前液相色谱法与质谱仪不兼容的原因是，在不造成过度分解的条件下将挥发性相对较差的分
子（溶于液体中）转换为分子气体的难度较大。APCI 探针在柔和条件下将样本在加热陶瓷管内
雾化成分散的细小液滴的过程，可以在样本分子不分解的情况下使样本迅速汽化。

图 E-2 显示的是 APCI 过程中反应阳离子（水合质子，H3O
+[H2O]n）的反应流量。
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图 E-2 APCI 反应流量示意图

在空气的主要中性成份中经电晕产生的电子的作用下，形成的主要离子是 N2
+、O2

+、H2O
+ 和

NO+。虽然 NO+ 通常不是干净空气的主要成份，但离子源中这类离子的浓度会因为电晕放电造
成的中性反应而升高。

经 APCI 探针引入的样本在雾化气的帮助下被喷入加热陶瓷管。在导管中，样本和溶剂的细小
分散液滴会在最少热分解的情况下迅速汽化。柔和的汽化可保持样本的分子识别性。
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气态样本和溶剂分子进入离子源罩壳，由连接到陶瓷管端部的电晕放电针诱发 APCI 电离。在
流动相溶剂分子电离产生的试剂离子的碰撞下，样本分子会发生电离。如图 E-3 中所示，汽化
的溶剂分子电离后产生试剂离子 [X+H]+（在阳离子模式下）和 [X-H]–（在阴离子模式下）。
正是这些试剂离子在与样本分子碰撞后产生了稳定的样本离子。

图 E-3 大气压化学电离

描述项目

样本1

主要离子是在电晕放电针附近产生的2

电离会产生占主导性的溶剂离子3

试剂离子与样本离子簇发生反应4

气帘板5

接口6

x=溶剂分子，M=样本分子

样本分子经质子转移后形成阳离子，并通过电子转移或质子转移形成阴离子。因为离子源的气
压相对较高，所以 APCI 电离过程的能量以碰撞为主。

在反相情况下，溶剂离子由阳离子模式的质子化溶剂分子和阴离子模式的溶剂化氧离子组成。
在热动力学条件适宜的情况下，加入改性剂会改变试剂的成份。例如，加入醋酸盐缓冲剂或改
性剂可以使醋酸盐离子 [CH3COO]

– 成为阴离子型式中的主要试剂。铵基改性剂可使质子化铵
离子 [NH4]

+ 成为阳离子型式中的主要试剂。

通过碰撞，某些离子（例如，质子化的水合离子）可以达到均匀分布。样本离子在离子源内的
提前分解减少的原因可能是溶剂分子团簇对试剂离子的缓和作用以及离子源内的气压相对较高。
因此，在质谱仪的质量分析中，电离过程主要产生分子型的产物离子。
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APCI 电离区

图 E-4 显示了 APCI 探针离子分子反应器的一般位置。斜线部分表示无壁反应器。自发的电晕
放电离子的毫安级电流是放电针和气帘板之间的电场作用的结果。主要的离子，如 N2

+ 和 O2
+，

是在紧邻放电针尖端的等离子体中通过失去电子而产生的。这些电子经过与气体分子的多次碰
撞后，能量得到一定程度的缓释，而后又在有效电离横截面处获得能量，使之能够有效电离中
性分子。

图 E-4 APCI 电离区

描述项目

放电针针头1

样本流速2

无壁反应器3

气帘板小孔4

Curtain GasTM气源5

小孔6

锥孔板7

陶瓷管8
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主要离子依次产生中间离子，从而导致样本离子的形成。选定极性的离子在电场的作用下向气
帘板漂移，并经过气帘板进入质谱仪。因为 APCI 探针的气压相对较高，所以整个离子形成过
程以碰撞为主。除紧邻放电针尖端、产生电场强度的区域以外，电场作用在离子上的能量要小
于离子的热能。

通过碰撞，某些离子（例如，质子化的水合离子）可以达到均匀分布。离子在离子-分子反应过
程中获得的多余能量会变成热能。经碰撞稳定后，很多产物离子已固定，即使还会发生很多后
续碰撞。在 760 torr（大气压）的工作压力下，产物和反应物离子的形成是受均衡条件制约
的。

APCI 探针的作用类似于无壁反应器，因为从离子源转至真空腔并最终到达探测器的离子从未与
探针壁发生碰撞—只与其他分子发生碰撞。在指定离子源以外也会形成离子，但这些离子不会
被检测到，而且最终会通过与壁面的相互作用而得到中和。

探针的温度是影响 APCI 探针操作的一个重要因素。为了保持分子的本质不变，设置温度必须
足够高，以确保迅速蒸发。在足够高的工作温度下，液滴会迅速蒸发，从而使液滴中的有机分
子被吸收时的热衰减最小。不过，如果温度设置过低，蒸发过程就会变慢，从而在彻底蒸发前，
有机分子会出现热解或分解。在最佳温度以上操作 APCI 探针可能会导致样本热分解。
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用户必须手动控制自动进样器和进样阀，因为在设备处于 Tune and Calibrate 模式时，无法
通过系统来控制这些设备。

前提条件

• 对质谱仪进行了调谐和校正。

• 液相色谱分离条件已知。

• 硬件配置文件包含一个注射泵。

• 所有必需的外围设备（包括注射泵（如果需要））以及液相色谱组件都在硬件配置文件中。

所需材料

若要针对特定化合物调谐仪器参数，建议采取以下方案。用四种化合物的混合物来说明该程
序的步骤。在使用相应化合物进行所关注的分析时，用户将必须采用同样的程序。

• 流动相：1:1 乙腈:水 + 2 mM 乙酸铵 + 0.1% 甲酸。

• 液相色谱泵和自动进样器。

• 自动进样器小瓶。

• 四种化合物的混合物 (10 ng/mL)，包括利血平、米诺地尔、甲苯磺丁脲和利血胺。该溶液
可用于输注和流动注射分析 (FIA)。浓度取决于系统。使用由 49.9% 乙腈、50% 去离子水
和 0.1% 甲酸构成的溶液作为稀释剂。可以用其他化合物代替，前提条件是其分子量已知
且化合物适合通过 Turbo VTM离子源电离。

表 F-1 化合物和分子量

m/z化合物

210.2米诺地尔

271.1甲苯磺丁脲

609.3利血平

635.3利血胺
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关于手动化合物优化

手动化合物优化用于优化针对一个分析物的化合物和离子源相关参数。当用户手动对分析物进
行优化时，在 Tune and Calibrate 模式下会创建一个 MS 采集方法。基于所选的进样方法，
将一种液相色谱法添加至采集方法，以便可以使用输注和液相色谱。

可产生最大信号的优化不一定具有最高的信噪比。对于一些参数，噪声和信号是成比例的，如
果要获得最大信噪比，那么应该在优化过程中验证噪声大小。

当优化离子源相关参数时，以样本分析时将要使用的流速进行进样，采用流动注射分析（FIA）
或者 Tee-infusion 作为进样方法。CAD 气体是唯一的化合物相关参数，显示在 Source/Gas
选项卡上，当使用输注方法进样分析物时，可以轻松地对 CAD 气体进行优化。

在优化离子源相关参数之前优化离子源位置。请参阅离子源优化。

关于扫描类型

对于这个例子，采用 Q1 MS、Q1 MI、Product Ion（产物离子）和 MRM（多反应监测）扫描类
型。Q1 MS 扫描类型用于确认目标化合物的存在。Q1 MI 扫描用于优化 MS 或预碰撞池电压。
Product Ion（产物离子）扫描类型用于确定每个化合物的产物离子。MRM（多反应监测）扫描
类型用于针对每个产物离子或碎片进行碰撞能量 (CE) 和碰撞池出口电压 (CXP) 的优化。使用
在这个部分中创建的方法进行定量或定性分析。

手动优化分析物

创建采集方法后，使用 Edit Ramp 功能或通过手动编辑 Tune Method Editor 中的参数，优化
化合物相关的参数。只能通过手动调整 Tune Method Editor 中的参数，优化离子源相关的参
数。根据所使用的扫描类型，不同的参数都可供优化使用。

按照给定的顺序执行以下程序：

1. 确认化合物的存在

2. 优化质谱特定的参数

3. 确定产物离子以进行优化

4. 确定产物离子以进行优化

5. 优化每个产物离子的碰撞池出口电压

确认化合物的存在

1. 创建一个项目

2. 激活硬件配置文件。

3. 准备样本：

a. 将化合物溶液吸入注射器，并排净注射器中的空气。

b. 使用带有特殊接头的导管将注射器连接至质谱仪。
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c. 将注射器装入集成式注射泵。

4. 以 5 µL/min 至 10 µL/min 速度输注溶液中的化合物。

5. 在导航栏 Tune and Calibrate 项下，双击 Manual Tuning。

6. 在方法列表字段中，单击 Syringe Pump Method。

7. 在 Syringe Pump Method Properties 选项卡上，键入表 F-2 中所示的参数值。

表 F-2 Syringe Pump Method Properties 选项卡

数值参数

注射器相关。4.61 mm（如果使用 1.0 mL 的注射器）Syringe Diameter

10Flow Rate

µL/minUnit

图 F-1 Syringe Pump Method Properties 选项卡

8. 单击 Start Syringe Pump

9. 从方法列表中单击 MS Method。

10. 在 MS 选项卡上，键入表 F-3 中所示的参数值。

表 F-3 MS 选项卡

数值参数

Q1 MS (Q1)扫描类型

200Start (Da)

700Stop (Da)

200扫描速度 (Da/s)（如果可以使用）

3持续时间 (min)

11. 单击 Start。
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12. 等到在左侧显示出平滑的总离子色谱图，以及在右侧显示出峰后，单击 Stop。

13. 选择 MCA 复选框。

14. 在 Cycles 字段中键入 10。

15. 单击 Start。

16. 当十次扫描完成后，将显示四种化合物作为离子的质量。

提示！ 如果之前或预期的离子色谱图窗格被隐藏，请从 Window 菜单中选择要显示的窗
口。

注释： 化合物的离子强度可能显示出极大的差异。为方便在优化期间按需移动至较高或较
低浓度的溶液，在开始优化前制备多种浓度水平。

17. 右键单击右下方的谱图窗格，然后单击 Open File。

18. 查找目标化合物，然后记录下最高峰的 m/z 值。这些值应在 0.1 Da 至 0.2 Da 的预期 m/
z 范围内。在下一过程中，使用这些 m/z 值。

优化质谱特定的参数

去簇电压 (DP) 和入口电势 (EP) 构成预碰撞池电压。这些数值的优化涉及逐渐改变电压范围
和监测化合物的信号强度。

去簇电压是孔口和接地装置间的电势差。电势差越大，去簇的数量越大。

去簇电压参数对分析物信号影响显著。典型去簇电压值的范围介于 20 V 至 150 V 之间。如果
去簇电压值过低，则会产生较低的离子强度和簇合物电位干扰。如果去簇电压值过高，会导致
分析物在离子源中裂解。通常，去簇电压应设置为提供最高强度的数值。

入口电势参数控制入口电势，通过 Q0 区域的高压导引和聚集离子。通常将正离子设定在 10
V 或负离子设定在 -10 V。入口电势对化合物优化的影响很小，一般可在不影响分析物检测范
围的情况下保留为默认值。

1. 返回 Tune Method Editor，将方法变更为 Q1 Multiple Ions (Q1 MI) 扫描类型。

2. 在质量表格中，键入适当的参数值。请参阅表 F-4。

表 F-4 质量表参数 - Q1 多离子 (Q1 MI)

时间Q1 质量化合物

1609.3利血平

1210.2米诺地尔

1271.1甲苯磺丁脲

1635.3利血胺

从利血平这一简单的例子开始。对余下的化合物重复手动优化过程。
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3. 单击 Edit Ramp。

4. 选择 Ramp Parameter Settings 对话框中的 Declustering Potential (DP)。

注释： 从去簇电压参数开始，然后按照对话框中显示的顺序依次优化其他参数。如果优化
的次序颠倒，这些参数则不能被正确地优化。

5. 键入所需的 Start、Stop 和 Step 的数值。

提示！ 现存数值是很好的起始点。使用 Edit Ramp 功能可将这些数值更改为更有效的数
值。

6. 单击 OK。

7. 单击 Start。

8. 右键单击右下方 XIC（提取离子色谱图）窗格，然后单击 Open File，最大化提取离子色谱
图的视图。

9. 监测提取离子色谱图。

注释： 目标离子给出的每秒最佳信号的数值是最佳值。

10. 记录目标离子的最佳值。

11. 将光标移动至质量表，右键单击，然后添加刚优化的参数。

表格中会增加一列。

12. 将最佳值添加到相应的行。

13. 对采集方法中的每个质量重复这些步骤，直到取得所有质量的最佳值列表。

14. 重复这些步骤，以优化其他质谱 - 特定参数。

表 F-5 质谱 - 特定参数

注释参数

将去簇电压设定在提供最高强度的数值。DP

很少优化这个参数，因为它的影响较小。EP

确定产物离子以进行优化

碰撞能量 (CE) 控制前体离子在加速进入碰撞池时接受的能量大小。

使用先前获得的 MS 特异性优化值执行此程序，一次一种化合物。产物离子提供多反应监测离
子对的 Q3 质量。

在此例中，使用了化合物利血平。

系统用户指南液相色谱串联质谱检测系统
IVD-IDV-05-6996-ZH-B256 / 267

操作说明 - 手动化合物优化



1. 在 Tune Method Editor 中，关闭提取离子色谱图 (XIC) 窗格。

2. 单击 Scan type 字段中的 Product Ion (MS2)。

3. 单击 Compound 选项卡，然后键入之前记录的优化值。

4. 在 MS 选项卡的 Product Of 字段中键入 609.4。这是记录在确认化合物的存在中的利血平
质量数确定值。

5. 确保未选中 Center/Width 复选框。

6. 在质量表格中， 键入适当的 Start、Stop 和 Time 数值。请参阅表 F-6。

表 F-6 质量表参数（产物离子扫描）

数值字段

100Start (Da)

650Stop (Da)

2Time (sec)

7. 单击 Edit Ramp。

8. 在 Ramp Parameter Settings 对话框中，选择 Collision Energy，然后键入所需的 Start、
Stop 和 Step 数值。

注释： 现存数值是很好的起始点。使用 Edit Ramp 功能可将这些数值更改为更有效的数
值。

9. 单击 OK。

10. 选择 MCA 复选框。

11. 单击 Start。

12. 右键单击右下方的 XIC（提取离子色谱图）窗格，然后单击 Open File。

13. 选择强度最大的产物离子，并将产物离子 m/z 数值记录至第一个小数点，比如 195.1。

我们建议每一种化合物进行两个到三个产物离子优化。其他的离子对可用于确认或在发现干
扰物的情况下，避免重新进行化合物优化。

注释： 确保选择进行优化的最高峰不代表前体离子的普遍丢失，如水或二氧化碳。还需确
保产物离子的质量不要过低，否则在列中进行分析时可能会对流动相的真实样本或簇合物
中的离子对产生干扰。

14. 对余下的化合物重复此程序。

优化每个产物离子的碰撞池出口电压

1. 在 Tune Method Editor 中，关闭提取离子色谱图 (XIC) 窗格。
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2. 打开先前保存的方法。

3. 在质量表中，验证化合物 Q1 和 Q3 m/z 的值。

4. 单击 Compound 选项卡，然后键入先前记录的优化的去簇电压和碰撞能量值。

5. 单击 Edit Ramp。

6. 选择 Ramp Parameter Settings 对话框中的 Collision Cell Exit Potential (CXP)。

7. 键入所需的 Start、Stop 和 Step 的数值。

提示！ 现存数值是很好的起始点。使用 Edit Ramp 功能可将这些数值更改为更有效的数
值。

8. 单击 OK。

9. 单击 Start。

10. 右键单击右下方的 XIC（提取离子色谱图）窗格，然后单击 Open File。

11. 记录目标离子的最佳值。

给出最佳信号的数值是最佳值。

12. 在质量表中，右键单击，然后选择刚优化的参数。

如此便向表中添加一列。

13. 如果要监测其他产物离子，重复上述操作。

14. 将最佳值添加到相应的行。

15. 保存方法。

16. 为以前优化的任何其他化合物重复该程序。

手动优化离子源和气体参数

离子源和气体设置必须正确设置，以防止质谱仪受到污染，并确保已将目标化合物以最佳方式
放置到离子气相中。

注释： 最佳离子源和气体设置与溶剂成分和流速有关。

当液相色谱条件明显改变时，必须调整离子源和气体设置。

要优化离子源和气体参数，基于相关化合物设置注射泵并将配有三通的管线与液相色谱设备连
接起来。可手动或通过软件对 LC 泵进行控制。

另一种手动优化离子源和气体设置的方法是使用自动进样器手动注入相关化合物，同时手动更
改手动调谐中的参数，以便确定最佳设置。
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准备离子源

1. 将水平千分尺设置为 5。

2. 在离子源上针对流速设置垂直千分尺。

使用 表 F-7中的参数。

表 F-7 Turbo VTM离子源垂直参数

初始垂直参数流速

101 µL/min 至 20 µL/min

520 µL/min 至 250 µL/min

2250 µL/min 至 500 µL/min

0500 + µL/min

根据如何运行优化，可能需要校正液相色谱泵硬件配置文件。

请参阅离子源优化。

优化离子源参数

优化离子源参数，以获得相关化合物的最佳信噪比。Curtain GasTM 供应装置要在不损失灵敏
度的前提下优化到最大值。请参阅离子源优化。

使用下列程序来优化 Curtain GasTM 流量参数。Curtain GasTM 流量参数的主要功能是防止离
子光学系统受到污染。在不损失灵敏度的前提下，Curtain GasTM 流量参数应始终保持尽可能
高的设置。该数值取决于质谱仪和离子源的类型。

不要将参数设置为低于起始值。

1. 在导航栏 Tune and Calibrate 项下，双击 Manual Tuning。

2. 单击 File > Open。

3. 在 Files 列表中，单击用于优化化合物参数的采集方法，然后单击 OK。

该方法在 Tune Method Editor 中打开。

4. 单击 Source/Gas 选项卡。

5. 使用离子源和气体流量向导，设置所有的离子源和气体参数，以使它们适合于流速。

6. 将运行时间设置为足够长，以便可对多个参数进行调整。15 分钟是推荐的起始时间。

7. 单击 Start。

数据显示在 Tune Method Editor 下方的窗格中。

8. 注意所关注峰的信号。

9. 在 Curtain Gas (CUR) 字段，将数值增加五。
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10. 继续增加 Curtain Gas (CUR) 数值，直到发现不损失灵敏度的最高值。

对于大多数 Source/Gas 参数，如果两个值得出相同的结果，则使用较高值。

11. 对其他 Source/Gas 参数重复这个程序。

在优化这些参数时，寻找给出最高信噪比的值。

高级参数

以下参数应仅由经验丰富的操作者进行优化。

优化 AF2

AF2 参数控制 MS3 扫描中第二种前体离子的碎裂。所用的激发能量取决于化合物以及所需的碎
裂量。

1. 对于阳离子和阴离子模式，均将 AF2 从 0.07 V 斜升至 0.3 V，步进值为 0.01 V。

允许范围为 0 V 至 1 V。

2. 选择可提供最佳碎裂量的 AF2 值。

关于碰撞能量散布 (CES)

QTRAP®质谱仪的独特之处在于可以执行 AutoFrag 实验。可以用来自三种不同的碰撞能量的离
子来填充线性离子阱以获得复合谱图，这可免除对碰撞能量进行优化。

在增强型产物离子（EPI）和 MS3 实验的化合物条件性参数下方，碰撞能量散布 (CES) 字段允
许用户指定本实验中将要应用的碰撞能量的差异。例如，如果使用了碰撞能量值 30 和碰撞能
量散布值 15，则使用碰撞能量 15、30 和 45。
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注释： 下表中并非所有符号都可用于每种仪器。

描述符号

澳大利亚合规标志。表示产品符合澳大利亚通讯与媒体管理局 (ACMA) 的
EMC 要求。

交流电

安培（电流）A

欧洲共同体授权代表

生物危害

CE 符合性标志

cCSAus 标志。显示加拿大和美国的电气安全认证标志。

目录编号

注意

注释： 在 SCIEX Diagnostics 文档中，此符号表示人身伤害危险。

中国有害物质限制使用警示标签。电子信息产品含有一定量的有毒或有害
物质。中间数字是环境友好使用期 (EFUP) 日期，表示产品可正常运行的
日历年数。EFUP 期满后，必须立即回收该产品。循环箭头表示产品可回
收。标签或产品上的日期代码表示生产日期。

中国有害物质限制使用徽标。设备中所含有毒有害物质或元素未超过最高
浓度值，该设备是一种可回收利用的环境友好型产品。
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描述符号

请查阅使用说明。

北美 TUV Rheinland 的 cTUVus 标志。

数据矩阵符号，可使用条形码读取器扫描此符号以获得唯一设备标识符
(UDI)。

环境危害

Ethernet（以太网）连接

爆炸危险

火灾危险

易燃化学危害

易碎

保险丝

赫兹Hz

高电压。触电危险
如果必须拆下主盖，请联系 SCIEX 代表，以免触电。

高温表面危险
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描述符号

体外诊断设备

电离辐射危害

保持干燥。

请勿淋雨。

相对湿度不得超过 99%。

保持直立。

激光辐射危害

起重危险

制造商

活动部件危害

夹手

压缩气体危险

保护接地导线

刺伤危险

刺伤危险
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描述符号

活性化学危害

序列号

有毒化学危害

在 66 kPa 至 103 kPa 压力范围内运输和储存系统。

在 75 kPa 至 101 kPa 压力范围内运输和储存系统。

系统运输和保存的适宜相对湿度范围为 10% 至 90% 之间。

在 -30 °C 至 +45 °C 温度范围内运输和储存系统。

在 –30 °C 至 +60 °C 温度范围内运输和储存系统。

USB 2.0 连接

USB 3.0 连接

紫外线辐射危险

伏安（功率）VA

伏特（电压）V

WEEE。请勿将设备当作未分类城市废物来处置。环境危害
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描述符号

瓦特W

yyyy-mm-dd
生产日期
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注释： 如果任何用于识别组件的标签脱落，请联系一名现场服务工程师。

翻译（如适用）标签

EN61326—1、EN61326—2-6、A 类、1 组、
ISM-IVD 设备

EN61326—1, EN61326—2-6, CLASS A, GROUP
1, ISM-IVD EQUIPMENT

碰撞指示器

敏感产品警告

注释： 如果指示器倾翻，则说明此容器曾遭
丢弃或者不当处理。在提单上注明，然后检
查是否损坏。任何碰撞损坏的索赔都需要记
录。

IMPACT INDICATOR

SENSITIVE PRODUCT WARNING

重要！

接受货物之前在运单上记录任何可见的箱体损
毁，包括倾翻的“碰撞指示器”或“倾斜指示
器”，并立即通知当地的 AB SCIEX 客户支持
工程师。

不得打开板条箱。联系当地的客户支持工程师
进行拆箱和安装。

IMPORTANT!

RECORD ANY VISIBLE CRATE DAMAGE INCLUDING
TRIPPED “IMPACT INDICATOR” OR “TILT
INDICATOR” ON THE WAYBILL BEFORE
ACCEPTING SHIPMENT AND NOTIFY YOUR LOCAL
AB SCIEX CUSTOMER SUPPORT ENGINEER
IMMEDIATELY.

DO NOT UNCRATE. CONTACT YOUR LOCAL
CUSTOMER SUPPORT ENGINEER FOR UNCRATING
AND INSTALLATION.

安全提升此设备需要至少六人。

注释： 请查阅使用说明。

MINIMUM OF SIX PERSONS REQUIRED TO SAFELY
LIFT THIS EQUIPMENT

倾斜指示器

注释： 指示容器是否倾斜过或经不当处理。
写在提单上，并检查是否有损坏。任何倾斜
要求都需要记录。

TIP & TELL
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翻译（如适用）标签

倾斜指示器

注释： 指示容器是否倾斜过或经不当处理。
写在提单上，并检查是否有损坏。任何倾斜
要求都需要记录。

TiltWatch PLUS

ShockWatch

警告：在未首先确保瓶盖稳固的情况下，请勿
操作。

注释： 本警告附带在离子源排废瓶上。

WARNING: DO NOT OPERATE WITHOUT FIRST
ENSURING BOTTLE CAP IS SECURED.

警告：本设备内没有用户可维修的部件。维修
工作应由具有资质的人员完成。

注释： 请查阅使用说明。

WARNING: NO USER SERVICEABLE PARTS
INSIDE. REFER SERVICING TO QUALIFIED
PERSONNEL.
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